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Welcome 1o

Photoshop
for Beginners

Photoshop is undoubtedly the industry standard in photo and graphics editing, as
more and more people are utilising its image-transforming capabilities with each
new version. Whether you use Photoshop CC, Photoshop CS or Photoshop Elements,
the array of buttons and icons on the interface might be daunting if you're not
familiar with the software, but - like most things - it's simple once you've mastered
the basics. From straightforward photo-editing skills to colour corrections, filters
and selections, this new edition of Photoshop for Beginners will guide you through
all the techniques you need. We even provide online resources such as tutorial files,
brushes, textures and video guides to start you on your Photoshop journey. You'll be
creating artistic masterpieces in no time!
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Basic corrections Layers Colour in Photoshop
o~ Use Levels to alter colour & tone
44 Get the best from 64 Understand the Layers palette P . e
Auto commands v

66 Organise Layers Doge and Burn your photos

46  Quick Editmode 68 Navigate the Layer menu
48 Improve composition 70  Learn to control layer opacity
in photos

Perfect your blend

52 Master the Transform tool
54 Utilise the Recompose tool
56 Use the Gradient tool

58 Discover Camera Raw

60 Use the Bucket tool

Alter colour
and tone

Discover
Camera Raw
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I Ultimate guide

Editing photos

Tweak your images to perfection

s the name suggests, one of the main uses of Photoshop is photo editing. In a world

where we are always snapping our friends, families, pets and surroundings, we all have

plenty of images to get creative with in Photoshop. Whether you rely on your iPhone or
other smartphone to capture a moment, or prefer to have a compact camera or digital SLR with
you at all times, Photoshop can tweak your images to perfection. It makes no difference what
the subject matter is or what device you used to capture the shot, there is always a way to make
improvements with a little help from Photoshop.

For landscape lovers, your first task will be to learn how to straighten your pictures in order
to achieve the perfect horizon. A wonky photo is an obvious sign of an amateur shot, so it's a
gocd technigue to master from the start. You will call upon items such as the Crop tool and
the Transform tool to achieve a poker-straight shot — Photoshop C56 and CC have a dedicated
Straighten option built into the Crop tool. Photoshop also enables you to use rulers and guides to
help you line up your images perfectly.

Landscapes will often benefit from a colour and contrast boost before you print them off, which
s an easy task using one of the many image-adjustment features. You will find Levels and Curves
will become frequent friends to help boost your photos and give them extra pop. As your skills
progress, you can introduce adjustment layers, which allow you to make alterations to specific
areas of your photo as opposed to the whole scene.

Photoshop is an essential ally when it comes to fixing your portraits, and once you've mastered
a few simple retouching skills, you'll be hounded by family and friends asking for their teeth
whitened, wrinkles smoothed and double chins removed. All these tasks are easy to achieve in
Photoshop, mainly due to features such as the Clone toal, which can hide blemishes and wrinkles.

You can employ Masks to help smooth the skin, while keeping the eyes and lips perfectly sharp.
You can also get creative with your image editing by altering the colour of eyes and hair to give
your friends an entirely different look. These skills are easily achievable with a little practice.

There are plenty of other fantastic ways to improve your images in Photoshop. By using the
Dodge and Burn tools you can lighten and darken areas of your shot, which is ideal if you find your
image is slightly over or under exposed. You can also enhance the colour of the scene by adding a
Photo Filter, ideal for boosting the warm tones of a sunset for example.

No matter what you choose to do to your shot in Photoshop, there is one task that is vital before
you hit that print button. That is to learn how to sharpen your images. Every photographer should
master this quick and easy editing skill to ensure their photos are full of punch when you hang
them on the wall. With this skill under your belt, your photos will really shine.

Experimeant with selective
colour and black and white
Wwhien -}:ji'r_ir'lg
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5 PHOTO-EDITING FIXES

02 Straighten the horizon
A wonky horizon is a common photographic
error that can be easily fixed in Photoshop.
Pre-C56, open up your image and select the
Crop tool. Now draw a rectangle over your
image and head to one of the top corners. A
curved arrow will appear, which enables you
to move your image to straighten it up. In
CS6 and CC, there is a dedicated Straighten
button, which lets you draw a line where the
horizon should lie and you Photoshop will
straighten and crop for you.

4 Add a phot filter

There are plenty of photo filters that imitate
the effect of the filters used in photography.
These are perfect for changing the
atmosphere of a picture. Here we have added
a Warming filter to a cool blue shot to add
warmth and a feeling of sunset tones. Use the
sliders to intensify or reduce the effect.

01 Fix the exposure

You'll often find your photographs appear
too dark or too light. This can be fixed in
Photoshop using a number of methods.
First of all you can head to the Image menu
in the top toolbar and select Adjustments.
Here you will find an Exposure slider, which
you can use to lighten or darken a shot.
Alternatively, use the Dodge and Burn tools
to lighten and darken specific areas of an
image for a more localised correction.

AFTER

03 Convert to
black and white

It's really easy to change a picture to black

and white to add a fantastic documentary feel
to your images. Simply open your photo in
Photoshop and go to Image>Adjustments and
select either Black and White or Hue/5aturation.
The latter option provides more tonal control.
Add a Curves adjustment to boost the contrast.

05 Selective colour
your shots

Selective colouring is a technigue used to
accentuate a particular part of your shot. Go to
Image>Adjustments>Selective Color to adjust a
specific colour without affecting other hues in
the image. You can turn the rest black and white,
keeping your chosen colours vivid.

Photashop for Beginners 11



Ultimate guide

hoto manipulation is quite different from image editing, as it
involves taking a photo and transforming it into something new
rather than simply tweaking the original composition.

You will have undoubtedly heard a lot about layers in Photoshop, but may
not be aware of what they actually do. In their most basic sense, they enable
you to build up a sandwich of images and effects. Each layer of the sandwich
interacts with the other fillings until you have a whole new sandwich, or
image. For example, you may start with a portrait photo and then add a new
background onto a new layer. You can add some text on a different layer
and then an illustration on another. Before you know it, all these layers have
added up to create a brand-new image full of details.

You'll find that the Selection tools are useful for photo manipulation, as
they enable you to cut out parts of your image. You can then use these
cutouts in other designs, move them about the page, or simply discard
them. By getting to know some of the Selection tools (the Pen tool and
Lasso tool being two of the most called upon), you'll soon see your creative
opportunities opening up.

You will be able to select the outline of a person and add them to a
completely new background in a few simple steps. Add in a few more new
skills, such as lighting effects, and you will be able to make your person and
background look as if they had always been together.

12 Photoshop for Beginners

By exploring the Filter menu, you will be able to transform your photos
in exciting new ways. Completely change the weather by adding a rain
effect, or turn a dull sky into a bright backdrop. By using layers, you can form
composites, which are images made up of |ots of different parts. This is a
great technique if you want to create new and interesting landscapes, sci-fi
scenes or fairytale glades. These are made by combining different images
and textures that result in a whole new world.

For an abstract touch, how about creating scenes within scenes? You can
literally make a storm in a teacup by adding a raging sea to a regular-looking
cup of tea for a fantastic visual play on waords.

Another great photo manipulation technique is to create wonderful
tricks for the eye. You can call upon the Liquify tool to bend and shape your
photographs into Dali-esque creations that drip across the screen, which was
massively improved in Photoshop C56 to make it faster and easier to use,
Alternatively, you can use Lens Blur and masks to transform a shot of a city
scene into a miniature toy town,

The anly limit is your imagination when it comes to photo manipulation,
Photoshop provides all the tools you need to make your ideas come to life on
screen. The tricky bit is deciding which is the best method to use. Often there
are multiple ways of doing the same thing using various tool combinations —
you just have to figure out your preferred way of working.
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. o background and add dramatic effects such as weather
01 Get creative e — .

conditions. By exploring the extensive Filter Gallery, you
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with a EIHQIE shot o - can produce convincing rain effects. Adding Blur can give
By using a multitude of L | the impression of driving rain or soften the effect for a
repeated layers and the Crop | Lo ' light shower. This can entirely alter the atmosphere of an

image and, in this instance, add mood and drama. Snow
and ice effects are also easily achievable in Photoshop.
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03 Lighting effects

Play tricks on the eye by introducing creative
text effects to your images. Add completely new
signatures to walls and buildings by applying

a careful and considered use of the Lighting
effects filter. This will take some practice, but the
results are very convincing and can transform a
regular, bland image into something extremely
engaging. Blurring the outline can create a fall-
off of light onto the surrounding areas to help
your image look even more realistic.

04 Get creative with textures

A simple way of manipulating images is by introducing
new textures and backgrounds to the shot. Textures
can be added by using the Texturizer filter, or you can
head online and source hundreds of free textures,
which can be imported into Photoshop. Whether you
are looking for paper textures, stone textures or even
animal textures, you will find an overwhelming supply
with a quick internet search.

05 Change the seasons
Photoshop is such a powerful tool that you

can quite literally control the seasons at the
touch of a button. By using a combination of
Photoshop brushes, filters and blending modes
you can produce distinguishable changesto a
single image. Use
gradients to alter
the sky colour, and
the opacity sliders
to determine the
strength of the
effect on your
photograph. You
will be amazed by
the power that's at
your fingertips.

W s Preset Manager

Preset Type: | Patberns
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Digital art

Create visual masterpieces

onsider Photoshop an artist’s treasure trove of tools, paints and .
media. Even if your artistic skills are limited to stick men, Photoshop can o
provide all the features to help you realise your inner Van Gogh.

Unlike traditional drawing and painting, Photoshop makes it as easy as - e
tracing over an image. You can literally sketch or paint over any photograph to Are
create a stunning masterpiece. By using layer masks, you can create a host of
drawing and painting styles.

On the drawing side of things, you will discover there are far more options
than a simple pencil sketch. Open your eyes to the world of chalk and charcoal
drawing, sketching in watercolour, and pen and ink effects. By carefully
selecting the right type of brush and combining it with the right kind of filter,
you can create realistic artwork of which you can be proud. Photoshop C55
and C56 both introduced new brush types which are even more like their real-
life counterparts, making it easier than ever to get realistic results.

You can choose from a wide range of paper types too. Work on canvas,
rough paper, smooth paper, chalkboard, rag paper, and so on — any surface is
possible. Some can be simulated using Photoshop's default textures and others
can be downlcaded as texture libraries online and imported into Photoshop.

If traditional painting styles are more your thing, then get ready to delve into
the endless supply of brushes, paint swatches and blending modes, Photoshop
provides a wealth of painting tocls, and if you use a graphics tablet, these
can be further extended by setting the Pen Pressure settings to emulate the
pressure of a paintbrush. You can create light, feathery paint strokes or strong,
bold strokes depending on the style you want to achieve. You can also create
custom brushes depending on the style you have chosen, and there are
plenty of free brushes you can use from the internet too.

You aren't limited to painting with brushes either. In fact, the Filter
menu is capable of producing plenty of painting effects of its own.

Experiment with Dry Brush and Pointillize filters to create a rough textured
effect which, when layered over a start photo, can create something rather
beautiful. The new Oil Paint filter introduced in C56 is also a powerful way 1o
turn photos into paintings with little effort.

Digital painting in Photoshop is one of the most satisfying activities.
Granted, it takes time and patience, but you'll find that the results can be truly
awe-inspiring and well worth the effort.
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01 Vector art

Vector art is a modern trend and popular with many
digital artists for its clean, bold impact. The effect is
achieved predominantly by using the Pen tool, which
enables you to cut out specific parties of your image.
The tool is very precise and lets you trace around
both curved and straight edges. After a little practice,
this tool becomes second nature and will open up a
wealth of creative opportunities to you.

02 Print effects

Any real-world artistic effect can be reproduced
in Photoshop. The Shape tools can create
colourful characters. You can then call upon
Blending modes to experiment with the intensity
of your colours and the way each layer interacts
with one another. There are many Blending
modes to choose from, so discover which works
pest in each creative situation.

03 Get creative
with brushes

You can create a Van Gogh masterpiece thanks to
the extensive range of brushes and brush options.
You can alter your brush shape, intensity, width
and pressure to help recreate works like this. You
also have an endless supply of colour swatches so
you can find the right shade of paint you're looking
for. Add in a canvas texture and you're ready to
start painting your incredible work of art.

Utilise the extensive range
of brushes and textures

Usg
phot

04 Retro effects

Photoshop CS6 introduced many new Airbrush
options, which you can customise to vary

the intensity and the area of spray. There

are presets for common brush setups too. A
graphics tablet and pen can alter the pressure
settings so you can press hard for a saturated
spray or press softly for a light smattering — just
as if you were using a real-life airbrush.

05 Learn to shade

The key to successful digital art relies

on the same principles as traditional
methods, which is building up the
shading and toning gradually. This
particularly applies to areas such as the
hair and skin, which normally feature a
wide range of tones instead of one base
colour. By introducing a number of similar
shades, you will easily add depth and
realism to any images that look lacklustre
and one-dimensional,

Photoshop for Beginners 15
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IMPORTANT TOOLS

Discover the tools Photoshop comes
armed with and learn how to make
them work for you

w Color slide |

o

T

Agfa Ultra Colg

QUICK EDITS

3 ? Uncover easy shortcuts for
improving efficiency

16 Photoshop for Beginners



Dx0 FilmPack 4

’ Histogram

INTERFACE
EXPLAINED O®

Find your way around the
Photoshop interface before
you get started

Calor '. Black & Whrte

Effects Serings

Film rendering

Film Cross processed - Ko..

Intensity W 20
Color protection W D
Film grain

Film Cross processed - Ko..
Intensiny " 100

Size 24x36

Fllter
Taning
Creative vignetting

Creative blur vignerting

Texturs

» Light leak

Framee

P i
T

N

uji Superia HL™ 1600 uji Superia Reala’ Fuji Superia™ 200
Fugt Sup HG™ 1600 Fuj [ Fujil Sup .20

Photoshop for Beginners 17




IGetting started

18 Photoshop for Beginners



Get to know the
Photoshop
family

Whether you have a subscription to the Creative Cloud,
an old version of Photoshop's Creative Suite, or Photoshop
Elements, we explain what each one has to offer

4 PHOTOSHOP
Photoshop C56 no
longer exists as a
standalone product,
but many digital artists
_  still have the Standard
or Extended version.

}-€ ELEMENTS

Perfect for the beginner,

5 Photoshop Elements

2018 has a more
approachable interface
that's full of quick effects
and one-click answers.

4PHOTOSHOP CC
Upgrading requires a
monthly subscription that
caters for different users.
CC offers Cloud storage
and the ability to get new
features when released.
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PhOtOShOp CS THE BEST OF

PHOTOSHOPCS6

Take advantage of the most
Photoshop has become a staple for many, it not all, recent tools and filters that

digital artists. We pick out the best bits from the have changed the way we
expert program edit our images

07 The face
Photoshop CS6's
interface has a number

4 No longer available to purchase as a standalone product

hotoshop gives you the room to create tools to imitate real media effects. What's more,
artwork and edit photos with complete  in Photoshop €56, there's a whole bunch of

control over layers, adjustments, tools and filters that make applying effects e
filters and much more. Daunting at first, much easier than before, __; i FL'r:;;F-;.:;.- [. _
Photoshop is surprisingly easy to get to grips We reveal some of the best features in Ddel[:_ s ;:LZH.”::']””,IH
with. Photographers will find an array of tools Photoshop €56, so you can familiarise yourself éat‘fjua-'r'r“-r*n?f e.r:-r'l - 1';::{;
for editing photos and if you are an artist froma  with them if you already have the Standard or P"m;“:':_ «Ii-a--k: “rwt"ﬁ" Rk
traditional background, Photoshop has exciting Extended version and are about to start using it. : — [J_L il "

ayers palette filtering
Aok Pctusbos £55 . : option for finding the

Bk | coam. | T b W B i g ity [ i ) Caras e | e

right layer quickly.

02 Content-
Aware tools
Content-Aware is
embedded in the Patch
and Content-Aware Move

tools. Prior to these, it

would have been down
Lo some heavy cloning
and use of copy-and-
paste to remove objects
from your images that
YOU No longer wanted,
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03 Non-
destructive
cropping

With Photoshop CS6
came an improved Crop
tool. This crops images
without losing those
parts of the image for
goad, Using the Move
taol, the image can pe
shifted around to fit with
the composition,

EXPERT
TIP

The big difference
between the Standard
and Extended versions is the
3D feature. This is kept in Extended.

In Photoshop CC, 3D is all part
H ow o LD Is of the price as Adobe has
, done away with the
PHOTOSHOP? two separate

versions.

A brief history of the program that's 04 powerful
become part of our everyday language _ f:':‘f"ij _—

as that been ‘Photoshopped'? Likely a Creative Suite, video editing and 3D taols paved - R filters include Oil Paint for
H phrase many of us have heard before. the way for more varied and three-dimensional : converting a pnoto 1o a

In fact, the verb ‘Photoshop’ comes artwork, In Photoshop CC, there have been painting, and Adaptive
with an entry in the English Collins dictionary. major improvements to how we connect and Wide Angle. There are
Starting with the release of version one way work with friends and co-workers, Photoshop also three Blur filters, Iris,
back in 1990, the program has evolved to bring has become an integral part of our lives, Field and Tilt-Shift, to
bigger and better features. and the chances are every image that looks help add depth of field

Version three introduced layers to transform too good to be true, has been processed in and toy-town effects,

the way compositions were created and with Photoshop beforehand.
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A closer look at Photoshop

Here are some of the creative and powerful features of CS6

([ ane Adobe Photoshop C56
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Tools collection

Tools include the Pen tool for
making vector art, the Mixer Brush
tool for painting, and the Healing
Brushes with Content-Aware for
portrait retouching perfection.
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Mercury Graphics Engine
Woarking hard behind the scenes is Photoshop's
Mercury Graphics Engine, speeding up filters
including Liguify and Lighting Effects.
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Adaptable interface

Photoshop's interface is
completely customisable,
meaning palettes can be placed

% where you want them to appear

| every time you open the program.

Layers

Layers give you the control
needed to editimages in anyway
imaginable. From adjustments to

help boost exposure to new layers 8

for retouching faces.
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POWERTOTHEPLUG-IN Plug-ins of all varieties help you edit with ease

Third-party plug-ins are available for all sorts embellishments to give greater impact to
of reasons, whether that's for providing those a project. Rather than seeing plug-ins as
extra photo effects or for adding simple an alternative to Photoshop, they actually

07 Photo effects 02 Painterly styles
Plug-ins such as FilmPack by DxQO Labs or Silver AKVIS is a company that makes a variety of plug-
Efex Pro from Google’s Nik Caollection apply ins, including ArtWork for painterly effects. Alien
instant photo effects to any image. If you're really  Skin's Snap Art plug-in aims to convert normal
short on time then the range of pre-made effects  photos to a range of painted styles such as

will be exactly where to look first. watercolour, pencil and sketch effects.

complement and expand the toolsets and

features that are already available in the supplied

version of the software,

03 Essential edits

your images.

Detail by Topaz Labs improves the contrast

and micro-detail between each pixel. Portrait
Professional by Anthropics offers a complete
workshap for retouching and shaping the faces in
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Elements

4 Cost: £86.56/569.99US

EXPERT
TIP

The beginner’s choice that makes image editing accessible sk Eatngs In

Elements are a way to

f you're new to image editing then opting Unlike Photoshop CC, Elements is entirely the‘:"?i': E}Tagsfz :h'll!ﬁi:rf'rl:?g;g?in
I for Elements is a great way to ease yourself standalone, so there's no need for a monthly the hgst anasintha “': 5, ?

in slowly. Elements has been designed to help subscription. What's more, you can upgrade from so you can spend less
beginners create artwork and edit photos with any previous version of Elements to get the latest time searching fora
minimal hassle. tools and features. photo to take in

the Editor.

Key features in Organizer Search by content

Tag images according

to what's on them with
Organizer's Keywords and
Rating function. Using

Elements Organizer helps keep images tagged and stacked

ot the Search bar at the top,
; e - images can be located
. Albums i rolders By i m.nrequiddy‘_
= My Albuam = W Tag
ha * Geneal
= Cagoon; |
masm | srcee-$ 26226 jog
Categorise and — - _ . L
organise wr - IEERRRENG > GV S b St JiE g B | st
The Organizer can launch [ #*% ad R = - 3 ' | Qan: 1075 2015 1134 ~
as a standalone program, — i
separate to Elerments 2018, T Share y_’ﬂlll' IdEﬂS
and is used to categorise . The Organizer's Share link
your pictures before you 2 lets you show others your
take them into Elements images and ideas, Connect
ready to edit. with Facebook, Flickr and
: : ; : Twitter or load them onto
- ! dep s ' =l ,‘;p‘ it e .__’ . el ka8 e N O WUTHE‘VE‘E account.
Photo fi]{ES R ' 4 ‘: s — N | % : ‘
The Organizer lets you R 1 ' = — View images
pranmHmpeedis o = 'l’— Images are displayed
images before headin . <% -:‘\
uve?fu the Editor. 4 el A RS e, - . ) Ti*-"':!_l._j as thumbnails inside
These include cropping, . ! y . s § _ thje Drganlzgr’s central
colour adjustments and e i = Tk 5 . o R - :ﬁggﬁ:’:ﬁ;'g‘gﬁ;ﬁ?ﬁ;ﬂ
red eye reduction. — B Tl samterE W B TR i 8L ’ ' B2 ~ i BE b :
\ o T a, ' Rl » ot number of images in this

window can be altered.

BT =00 %% [l ey - o 7T

Inuigst oy Kayword finkn

T GROUPED

SHOTS MAP YOURIMAGES

L
(=

S FEOUFSHOES Just got back off holiday? __ =

Mg hame 151

Pin your images to a map!

You can sort the shots that you've

mported into Elements 2018 by In the Organizer, images can be pinned 1o
people, place or even event. Elements the location where they taken using the
can recognise whether shots belong Maps feature. By clicking on Add Places, you
together; it has the capability to group can drop your images onto a specific place
similar faces for you to edit together, in the world. This is just another way to sort
and shots that are taken within a similar images so you know where to find them
time frame are recognised as being when you need them.

from the same F.'I-|-E-'JCI?‘ or event.
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The Elements Editor

Edit and perfect images using the Quick, Guided and Expert modes

Instantly apply
artistic frames

Expert tools : . .
Elements includes the Magic Wand - : \ Embellish your images with
and Quick Selection tools for making Gfﬂphlfﬂl elements pre set ﬂ ames an d e.ffe{:t S
selections around subjects, with the help The Graphics contains preset deigns B

of Refine Edge in version 2018. [ o= | forforming a new backdrop, or texture SE—

effects forimages.

Three modes

The Editor is a where all the tools
and adjustments are kept. This

in turn is split into three sections:
Quick, Guided and Expert.

01 Choose a preset

| oad up Elements and head straight to the
Quick interface. Click the Effects option. Select
one of the ten presets available. Light Leak was

used here.,

Gec. 13AMIIOL S

: o . Simple yet effective : d:i
Image-fixing tools Though there may be fewer . —
I_il Tools such as the Straighten and options, layers styles and ; * 3
™ Recompose will quickly fix images in need adjustments compared to S
of some rearranging. These are some Photoshop, Elements provides
examples of helpful additions to Elements much of the same in a more
over the past couple of versions. compact and simpler way.

GUIDED EFFECTS

Special effects are effortless
with easy to follow steps

The Guided interface is what makes Elements so
efficient. Images can be given effects such as a
soft focus, high key or Lomo image styles. Guided
effects have been added with each new version
and now include Motion Blur effects and Resize
Your Photo. Following on-screen instructions, you
can transform an image in seconds.

02 Texturise

Select the Texture button next to Effects to |k
the presets. Click on the Blue Grid preset to
YOUF IMmage

the effect.

QUICKEDITS

Fix images in the Quick
mode with simple tools

Quick mode has a bundle of image
agjustments designed 1o restore lighting,
colour and detail, and all the layering is taken
care for you. Apply Smart Looks to your
photos; these retro filters judge the lighting
and colour and apply effects accordingly.

T

03 Frame to finish
Apply one of the preset Frames inside Quick

'@ the image an artistic flourish, We

frarmme with a fun and funky finish that

eally stands out.
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Creative
Cloud

4 Cost: £19.97/519.99US per month (single app)
£49.94/549.99US per month (all apps)

Get new features and tools as
soon as they come out with
Photoshop CC

T he Creative Cloud has changed the way we use and

update Photoshop for good. Photoshop CC is based on

a monthly subscription with access to content, storage
and features that you don't get with Photoshop C5 versions.
Since Photoshop €56 is no longer available to purchase as a
standalone product with a one-off price tag, Photoshop CC s
the way forward. Here are some great features that come with
signing up to the Creative Cloud.

BENEFITS OF PHOTOSHOP CC

Subscribing to the Creative Cloud comes
with its advantages

07 Cloud storage

For artists looking to edit, connect and
share artwork, the Creative Cloud is a
good place to start. Signing up to the
Single App or Complete packages gets
you 20GE of cloud storage so you'll have
plenty of space to back up your images.

02 Instant updates | Behance

Updates are sent to you as and when Browse through the

: : : ; community of artists §
theyre made available. This means you'l | forinspiration,orto R
never be left out of the latest features B make a contact.
to be released from Adobe. Where
previously you had to buy a new version
of Photoshop to get the latest features,
your Photoshop will notify you with
updates to install,

SUBSCRIBING
TOTHECLOUD

How much does it cost?

Subscribing is not as difficult, or as expensive,
as it may seem. What's important to realise

is that you don't have to pay for the entire
Creative Cloud services; you can just pay for
Photoshap CC. Opting for Photoshop CC will
set you back £1997/51999US per month for

03 The Behance connection
As part of the Creative Cloud membership,
yOu are given your own customisable
Behance portfolio to publish and

share artwork with other like-minded
people. This is especially useful if you're a
freelance artist who's reliant on gaining
exposure and looking for the next big
design job. It's directly accessible from
inside Photoshop CC and could prove key
for getting noticed for what you do.

Creative Cloud price for new customers which is
£4994/5499915,

There's also a stripped back Photography plan,
which just offers Photoshop and Lightroom
without e uch as the Behance ProSite. This
s only £9,. 9aLJs,

“k www.adobe.com/
CreativeCloud as you can find some great
discounts on purchases and upgrades. Offers are
always changing, so keep your eyes peeled.
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Photoshop CC

All-in-one Photoshop gives you full creative control with whatever you need to create

e

op Ct Sync your presets
Bt Al geaacts R P e B Using the Sync options in Photoshop CC, you

e e e e can share your favourite tool settings with other
artists, and access them on any PC.

Photo editing

i
3D ":"hj ects For photographers, the
Photoshop CC includes the 3D Camera Raw Filter can now RSt
features only previously available be used on any layer -
in Extended versions. Using the perfect for RAW processing ® -
dedicated 3D palette, extrusions inside Photoshop with this .
and meshes can be adapted in software's powerful features. T

and around your layers.

Adcie Applaatinn Marager
L Acrobat X1 Fre

' After Effects C56
. Augdnlon CC
H Brisge OC

. Dreamweaver CF

. Edge Animabte CC

E Exchanga Manal (fher T3 Appl

Better filters

Filters have been much
improved in CC. Smart Objects
can be used with Liquify so we
can make non-destructive edits,
and the Shake Reduction filter
helps to reduce blurriness.,

Desktop app

Head to https://
creativecloud.com to
log in to your account
and download the
Creative Cloud app
for your desktop. This
is where up-to-date

apps are downloaded.

i. Extendsrrigl Toollial £C

4 Exrsnukon Manager CC

H Firewarks C50

E Flash Buslder Premiusm

. Flazh Professioas OO

Useful apps

There are a variety of
useful apps available,
5u::h as Adobe Color

REASONS TO GET CREATIVE

Multiple programs and constant updates
are two main distinguishing features of

EXPERT
TIP

Inside the Image
Size menu, use the
Preserve Details (Enlargement)

07 Create in multiple programs 02 Always be up to date “":;?5:: ",‘f: 'ﬁ:g;;g;"‘:fj:;’;"
If you opt for the full Creative Cloud Whether you're a retouch artist, painter, or just great Ees,ﬁts when EFr:larging
subscription you will have access to all Adobe enjoy photo manipulation, Photoshop CC has a photo, and keeps
programs, including lllustrator, Muse and mare, all the tools you'll need. With Content-Aware the distortion

This means you can work across multiple editing and the Refine Edge at hand, you can very low.
applications to suit the artwork you're creating. create compositions to an industry standard.




Getting started

First steps in Photoshop

First time in Photoshop? Get up to speed with the

basics in our essential guide

he first time you open Photoshop it can seem a bewildering mess

of icons, menus and palettes. 'We have already introduced you to the

flavours of Photoshop: Photoshop C5, Photoshop CC and Photoshop
Elements. It is generally thought that Photoshop is for professicnals and that
Elerments is purely for beginners. The interface of Elements is a bit more
intuitive than Photoshop, and features such as the Quick Edit mode mean that
it's incredibly easy to make your first edit. But Elements still has a lot of the
same tools as Photoshop so don't dismiss it as 'Photoshop Lite’,

Between the two versions it might be that the tools are named or located
slightly differently, but there's generally a work-around to give Elements users
the same wealth of editing options as CS and CC users. Here, where there is
a difference between Photoshop and Elements features, we've included the
Elements technigue. If you don't see an alternative way, assume it's the same,

[« » (i3 = W) (@ Library 84
v pEVICES & Applications L3 Address .k Plug-Ins
£l iisk &l Desktop 2 Applcation Support

&= simon sielion &l Documents

2 Macintosh HD

- SHARED

¥ FLALCES

nh‘lh'l;lp

i Daownloads

i Maovies
MultBrush.lig
& Music

L MyCreation Projects
Cirrant Work
T v
& Public

ofy Applications

& Documents

F SEARCH FOR
¥ MEDLA
,n Music
S Photos
' Moy

L restore
B siteGrinderData
& sites

Tempoics.adon

01 Open afile

To load an image, go to File>Open and then use
the window browser to navigate to the file you

I
I
T
i
E

F

B Assistants
B Audio

L Autosave infarmation -

B Caches

3 calendars

[ ColePickers
& Colors

[ ColorSync

&8 Compasitions
[ Cookies

B Documentation
3 Favorites

£ FortColfections
& ronts

L3 iMovie

L Input Methods
L Intemmer Plug-ins
Bl iTumes

want. Once found, simply click Open.

04 File formats

Adobe has supplied a lot of different file formats for
you to save your image in and we'll be looking at
this in more detail throughout this book.
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There are three core skills that you need when you first start using
Photoshop. You need to be able to load a file, open a new file and save a
file. These three tasks all require extra knowledge, such as understanding
resolution and file formats.

The other essential ability that you need is to get access to all of the toaols, If
you think the Photoshop interface is confusing as it is, it would cause your brain
to explode if all of the tools were on display at once! To avoid this, a lot of tools
are grouped together and hidden behind a major tool.

One ather thing that is worth mentioning is shortcuts. We always give the
menu commands for performing tasks as it's a good way to get used to where
things are and how things are organised. But once you get more comfortable
with moving around the interface, you can start using your keyboard to carry
out the most common commands.

LA @ Copey Hirfnn
_ Adpa Chanisils Spest Cinbin's

Liyatis

Lins Penaf Tmup ‘iowki ng DY

B4 Emibeed Color Profile: sACH BORT9EE-7 1

02 Create afile

To open a new file, go to File>New and enter a
name, a size and a resolution. Click OK to create it.
In Elements, go to File=New>=Blank File,

05 Selecting tools

Adobe has bundled similar tools together. If you
see a small arrow in the bottom-right corner of a
tool, there are other tools hidden behind.

03 save afile

Saving is also a straightforward affair. Go to
File=Save As, You can rename the file if you want
and, mare importantly, set the file format.

...........

Extensions

iD
Artions S
Adjustments
Brush
Brush Presets
Channels
Character
Character Styles
Clone Source

» Colos F&
| Histogram
¥ History

Infa F&

Layer Comps
¥ Layers F7

Measurement Loa

06 Options

Tools and commands are found in a series of
palettes. You can set which palettes are seen using
the Window menu.




L
QUICK PHOTOSHOP TIPS

Quick save

The first time that you save a new file,
use the Save As command as we have
described, so that you can set the file
name and format. Then, if you continue
working on the image, you can just use
File=5ave instead, which saves your
progress to the same file. It can be easier
to get used to the keyboard shortcut,
which is the Apple/Crnd key if you're
using a Mac, or the Ctrl key if you're using
a PC, plus the 'S key at the same time.

M.

Open...

Browse i Bridge.,
Erewrie 1A Mini Beitlge
Opven s Swart Objett...
Dipan Aezent

Close
Cloye All
Close and Go e Bridgs...

New,.,

Open...

Browise in Bridge...
Browse in Minf Bridge,,.
Open as Sman Object..,
Open Hecent

Close

Close All

CRose and Go 1o Bridge...
Save

Save Ax.,
Checl |

Save far Web,
Rewvert

=fts ‘l:

’h" il m

Fiie infia.
File sizes Common file types
When you are JPEG is the most common file
Mame: My first Fie L — creating a new i R format. It is used because it
B it v i (_Cwd ) file from scratch, offers smaller file sizes but it
U5, Paper L (e Prese ) you can use the e e e — sometimes compromises on
BIIITTCTT, =) covroen Preset menu ' quality. When you choose to
s L. to see different save in JPEG, you are given a
Sl & Devioes e pre-defined sizes. slider to set the quality. PSD is
i M T International Paper miSuve a Photoshop document and
ackry 510212 Caranium JAC = offers you A4 and LA is needed if you are saving a
S 1,760 A5, for example, for Rooihes 20 multi-layered document. TIFF
B | quick setup of new -, - produces larger but good
g RS13842 1P 0033 pg = documents to the ey 3 quality files. Use this when you
Pine A S ; .;.} . . P Targm ; E I
RSO704_Warm colaurs om Lucarn towsr(lljog  — = right dimensions. e : need the optimum quality,

RESOlutiOI‘I Get it right the first time

What is resolution?

Start with 72ppi

Photoshop measures pixels in inches (or ppi).
Our screens work in 72ppi, so if you are doing

All images are made up of square pixels. These
pixels control how detailed an image is — put
simply: the more pixels, the better the image.

something that will never be printed, 72ppi is fine.

Go 300ppi for quality

If you need quality or you want to print an image,
work in 300ppi. The extra pixels mean that an
image has more information.
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I Getting started

ALTER SIZE AND RESOLUTION

Resize your
Images

Discover the tools and tricks that enable you
to control the size of your shots

Edit an image with the Image Size dialog box

For anything related to an image's size and resolution, the Image Size
dialog should be your first port of call. Photoshop users can find this
under the Image menu, while Elements users will have ta navigate to
Image=Resize.

Once open, you can check the size of your image and then move to
editing the resolution and/or dimensions. There are various dropdown
menus that can make things seem confusing, but we'll explain what they

all do below.
hen it comes to resizing images, the most important task is Dﬂ‘cume"!t Si?E | = Pi‘xﬁ" :
understanding how images are constructed. Open up an image, You can use this to view the physical size Dimensions

and resolution of yourimage. You can
alter the units of measurement from the

This area reveals the

zoom all the way in and you'll see that all the detail is constructed
number of pixels, along

fanj small squares call;d p|:~:~?|5. Photoshop handles thezg pixels Ciﬂ a plx?l— dropdown menu on the right. shawidthan it aahbet
per-inch basis (ppi). This is as it sounds - the number of pixels contained in e TG
an inch. The rule is simple: the more pixels there are, the more detailed the i
image will be. When we talk about the pixels in an image, we are referring to ——
its resolution. A resolution of 300ppi is a general goal, as it's high enough for B Lisin s it Miace 5 ok |
most uses and is certainly fine for printing. i C tral
When resizing images you have to be aware of resolution, because this will [t R e e S i, | . I'EI!H
dictate your end result. Going smaller is no problem whatsoever, however width: [2767 | ] | pixels O~ s Help | Erglpg_rtm_“5
once you start to go larger, you will start to see some quality issues. This is Height: [2565 "] | pixels  ~ kg: ~ fhte Ergggglat:s of
because pixels have to be generated and added to the image in order to e Dot S your image. If you edit
make it larger. width: 503~ | cm = the width, for example,
Most resizing is done within the Image Size dialog. From here you can alter T - .l ] ' the height will follow suit.
an image’s physical size as well as its resolution. However, the Save For Web S 55— | sttt ]
function is a useful tool for trimming images down. Here we're going to look
at both of these, explaining how they work, in addition to showing a good EZ?EI:T:;GMM 1

< Resample image: |

way of enlarging images.

 Mearest Meighbos (presense hard edges) I
Bilirear

Bicubic (hest for smooth gradients)

Bicubic Smoother (best for enlargement)

Bicubic Sharper fbest for reduction

= & Resample Image
Choose this option to
alter the resolution of
your image. Once altered,
the size of the image will
also change.

“Most resizing is done within the
Image Size dialog. From here you
can alter an image’s physical size
as well as its resolution”

Resample options

When resampling you can use this
menu to access options for achieving
the best results.

@ Learn more about

Cangal
= Prnil Dhifidasaid. &6, 0M [was &6.00) = *

Widre (3764 | | pinnis = ] Hew
i
Hgighs: 4038 | plusls =

— Doowmert Sine

Widi 45.333 | i - ]
i
Haighs: B8 444 | incies -

Resnlution: |72 | | piwelsiines =

| Seal= Soykey
Consirain Proporans

Consirain aspect ratio |
Rirubir freid Far amasth gradientid

Constrain your elements
It you want to alter the size of your image, chances
are you will want to keep the propartions. You can

do this by ensuring the Constrain Proportions Dox

L] L]
Physical size
Open up the Image Size dialog. Prafessionals will
use pixels to measure an image but the rest of us

can get by with the physical dimensions. Look at

e T [T SN rol Eepreri e Rt fe ID Ll U /SR S T S T Ly
madge 4 i its PNYsICAl 5i£e, YOU Can Increase the

resolution, but to keep the quality you have to

the Document Size area and use the ;'iI":'i'.'i'."i'“"-.-"-.-'l"

menu next to Width to select the unit you want to

work in, Here we've picked Inches.
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is checked. If it isn't activated, check the Resample

Image box, select Canstrain Proportions and then

deselect Resample Image.

make do with a physically smaller image. Here we
nave a large 7Z2ppi image. We need 300ppi for

printing, so type this into the Resolution box,
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Once you' I._m_!-r- d the Resample Image box
wou'll be :'E'l'l!;'= to get to th 'r':|"-|'l'||"-:u|‘| nen I'.n:'-Iu'::'w

=
t, which holds :'ii':!'-u'-:‘l resampling option:

are going to be reducing the size, so pick "'r'-

Bicubic Sharper option, as it automatically applies
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Cancel
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| Scale Shyles
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[ R sa-mnbe ineage

Bicubic Sharper (best for reduction]

Make the change

You can aiter the number of pixels or the physica

Ao s il P i e
L5 [_u -!n'-1 alin Froporti

| :-E =1 :'” 11 -\.._.:.'III p == ‘I!'.r"'. |'|_:'.|__--- I‘I = :__.-_:'. LID)

L. a PR i b W by PR o | o [ .
In the Pixal Dimensions area. Hit OK to confirm, or
Opt/Al-click on the Cancel button to reset,
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Save an image for the web Easy options

: : ; : This dropdown menu gives
Quickly reduce an image’s size with the Save for Web command you a choice of preset edits
based on image guality.

The Save for Web dialogue used to be essential in the early days of the web, when a large image would bring You can also manually

a modem to its knees. While the connections are much improved now, it's still good practice to shave file sizes enter a quality value in the
down when posting images online or sharing via email. The Save for Web command makes light work of this. Quality area.
: - : — _ Save for Web (25%) — e .
Sxve ar irmdge 10 Include ina pirge g
D Q S e Up——
2| = . . o«
ized Matte . "
| e - 8. Alter the pixel size
| | If you want to alter the
- number of pixels along the
image Size . width or height of an image,
TR enter a value here,
whdeh: 2590 pxels
Hesghe 3BT2 piuels
Mew Sire s o
wigth: 2502 pu
i g
Prrcent 100 %
Acimation -
B g oo Sore : Zoomin and
r i " H‘ refine detail
. = To properly assess the
quality of the edited
image, use this area to
click and zoom in or
enter a Zoom value,
I
', Before and after
I You can instantly see the
| results of any edit in the main
1 : - window, including the new
o ;. file size and loading time
R — : underneath the image. Click
LT = - e T i e = the arrow to pick different
(Proview.) @@ 1% RN ( Cascel ) (Do | Download options.

REd uce the file Size Of an image Make a photo that’s lean, mean and ready for the web

: » ' - - _ Sare o Web (66,79
- -~ -~
m v ! . Fusee | PECHe ) .
r - ' i =
WiaigTl —
B Leam move about: Image o Quialioy: &0 "':-'
Monimun be s 8
=Pl Dieminsions: 5.90M fwas 28.7M) TR OpETERTTT Rakbe i
widsh: [1175 | | piwets - = [ Emibed Coinr Probie
eight: [T755] | pintls =
— Do Limmiaevl S iage Kige
Wadth: [41.44 | | em Brayisat diea
ighe [EL8—] [em e 1733 o
Resolution: [72_ ] | pluals/inch Wb
Wom LIPS g
:iﬂl Lrebed 1 gt .I..:l's.l. p:].
A Coresrain Frogorons
[ Resampie mage: _ Perosss | L9G X
Bicubic Sharper ibest for recuciion i P enet] m i
S | L] G [ L b .- - it
. _ (o) w i3l —— A s
07 Prepare your work 02 Adjust the view 03 Reduce the size
The Save for Web command isn't meant to shrink You will now see two versions of your image, Go Use the dropdown menu on the right panel to set
huge images, so if yours is a mammaoth, use the down to the bottom-left and use the plus (+) icon the quality. The higher the quality, the larger the file
Image Size dialog to reduce either the resolution or ~ to zoom in on an area. Click and drag on theimage  size, so keep an eye on the numbers underneath
the physical size. to move to a specific point. the preview and pick the size you want.
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Enlarge animage
Keep quality when you go bigger

Ideally you should never force an image to go
beyvond its bounds, but there are times when
this is unaveidable, This is especially true when it
comes to old photos that have been scanned in.

You won't get the perfect result, but there is a way

o get pretty close,

New size

When you resample any image, you will see

the new size as well as the old one. Because we
have increased the size and resolution, our pixel
dimensions (and file size) have also increased.

Resolution

When you are scanning images, always do
so at 600ppi so you have lots of options for
altering the physical size. If the image is to be
printed, you will need 300ppi as a minimum.

Smooth edges

There are various edits that can help fix any problems
from the enlarging process, but the first one is the
Bicubic Smoother resampling option.
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07 Good scanning practice
A trip 10 the Image Size menu reveals that this was
scanned at 180ppi and is physically small. As a rule,
you should scan images in at 600ppi to get decent
sized results by lowering the resolution,

04 Sharpen the edges

To counteract smogthing the edges, you now
need to sharpen them. Go to Filter>5tylize>Dirtuse
and pick the Anisotropic option. Zoom in close to
an edge to see the results and, if happy, click OK.
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02 Take things larger

A professional printer would demand the image
be 300ppi. With Image 5Size open and Resample
Image checked, pick the Bicubic Smoother option
and enter 300 in the Resolution area.
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05 Use the Unsharp Mask

It's time to go to Enhance>Unsharp Mask (or Filter>
Sharpen=Unsharp Mask if in Photoshop). Generally
a high Amount, small Radius and small to zero

[hreshold tends to wark well,
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03 Smooth problems

A downside of forcing an image to be a higher
resolution is that areas can pecome blocky. The
Bicubic Smoonther option helps this, but you can go
1o Filter> Noise>Despeckle 10 smooth edges.

~ = |

06 Final Touches

T finish we can add noise, as this makes the image
seem maore uniform. Go to Filter=Noise>Add Noise
and enter a small amount. Go to View=Print Size to

see what the image will look like when printed.
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I Getting started

ﬂ [ New... 3EN

Open... ®=0 : !
Browse in Bridge... XEO s Ql Create PDF

Browse in Mini Bridge... | = Save " S e v g | ’
Open as Smart Object... :

To make a PDF, go to File

Hit File=Save, or use the
Open Recent > T | L at the top menu bar and
- 5 shortcut Cmd/Ctri+5, to e select Print. Instead of
Close EW save your work as you o : selecting a printer, choose
Close All TEW go. Photoshop C56 and (7) PDF = | Show Details Cancel  [“JPrint | Adobe PDF and hit print,

CC automatically saves
recovery information in
case you lose your edits.

Close and Co to Bridge... Open POF in Preview

Lave as PostScript..

Add PDF to iTunas
Mail PDF
Save POF to Web Recelpts Folder

Edit Menu

Place...

Print Settings
Import > Name and Save Print directly from Photoshop by choosing
Export From the dialog box choose your printer from the Print Settings menu.
Save As PDF, click the print Your image will print in its original size, but
Automate > button, and then name your check out the preview to see how big the
Scripts > file and choose Save. image will appear on the page.

File Info...

Print... Photashan Print Sattings l

Primt ir Setup

printer SR AT

Coples: I‘. Print i.'r:“lng:....

Layoust: ﬂl_‘]

| ®

Print One Copy

Save As

Use File=5ave As to give
your image a name for the
first time, or to create a new
type of file from the one
that you're working on.,

¥ Colo * Management
emember to enable the printer’s color
hanagement in the print settings dialog box.

Diocur gnt Profile; Adobe RGE [199E)

T 'Ehl:lr’ﬂ..nd[ing: Printer Manages Colors
Printer Profile: ARRIFLEX D-20 Daylight Log (by Adobe) :
Send 16-bt Data

Mormal Printing £

Rendering Intent: | Relative Colorimetric

Zlack Pelpt Compansarion

¥ Description

¥ Position and Size
Poasition

Top Left

Match Pring Cobors Camut Warning Show Paper White

Cancel | Dione | Print

Save, export and share your photos

Get your images ready for the web or a printed masterpiece

he process used to save an image changes depending on what that their everyday editing. One faormat to take note of is the Phaotoshop file, or PSD
I image is going to be used for. Size really does matter when you're for short. This is a layered file that saves all adjustments made when you edit
printing out a photograph or a piece of artwark, as you want to include your image. It's always a good idea to save a layered copy of any image that
as much image information as possible, This helps the image come out bright you're working on, as going back to make changes to the photo later on will be
and clear when on a large canvas, but also means saving work as large, high- much easier.

resolution files.

On the ather hand, when saving an image for the internet you will want to HS iZE' rea | I y d oes matte r'W h en

do away with any information that isn't necessary so that it will load up quickly

on a page. Emailing images to friends and family also becomes easier when yOU Jrr«L—"_"_' p 1 ntl N g out a p h Otl:)g I'd p h

you work with smaller file sizes. Photoshop gives you the option to save in 23

. ]
different file formats, but luckily mast users will just need a handful of these for ord p lece Of d rtWO I”k
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Save photos for uploading online GIF fles
The GIF file format is
Take your photos out of Photoshop and on to the web Image Size s Eﬂpularfﬂrthe :
web because it is small,
he smaller an image is, the better it behaves when displayed Image size tells you It's best suited for
online. Photoshop's Save For Web feature guides you through the how big yourimage graphics and is rarely
process of trimming your image of all unnecessary information. is in pixels. The larger used to save photos.
these values are, the

This makes it a pleasure to upload to web galleries or to share with friends
and on a blog. The menu is dauntingly large, but here are a few simple
settings to get your image ready for the web.

0086

more time it will take to
load up once it's online.

I Original | Optmized |2-uUp d-Up 000

L£| , quainy: 30 Oz }+F Quality

qu | Bur: |0 x Lowering the quality
e O e Vo 3 of your image

_. ‘ | @ Embed Color Profile means getting rid
= of unnecessary

information. The file
size will become much

| o Convert to sRGH o smaller too and will load
. | Preview; | Monitor Color o up quicker.
Metadata: |@ind 'l.':mi'ii_t‘li_l_l_'!l'l}_ ___-
| - -
|~ Color Table 3 PI"E“EEW
. ! . The preview screen
shows what your image
| ‘ will look like after saving
, it. Use the plus and
| minus buttons to zoom
| in and out and check the
' final image quality.
8l (39 Back out
- Image size : If you change your mind
W. 2B4B .r.'ru ]I Percent: | 100 . % while saving your ir‘nage,
| ——— o waing] || Mei4zon _ jo = Gy | SeRv hit Cancel and this will
e | Animation take you back to your
73 sec @ 56.6 Kbps == . = —— | | Loaping Option: | Once original image.
I 1:5_; _:'I" R-- G- &= | Alpha: ==  Hex: == index; — _' 1 of 1 | “ 1 > | 1| e
! ] it_'-:} } Bave.. __i Ea,n_:E_l = Dﬂl‘le_ = 5

Save fOI' WEb Prepare your images with Photoshop’s Save for Web feature
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07 Load up menu

Once you've made the final adjustments to your
image and you're ready to save, click File in the top
menu bar and find the Save for Web option. This

02 Select file type

From the box menu, change the file format from
the default GIF to the JPEG format. From the
Compression Quality option below choose Small.

03 Name and Save

At the top of the Save As menu, type the name
you would like to give your photo. Choose a
location on your computer where you would like
to save your file to, such as the Desktop, and then

will take you into a completely different menu for
setting up your image.

| eave all other settings as they are. Hit Save once
these are all set in place,

hit Save. This image is now set up and ready for
uploading online.
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02 Check DPI

Check that your image has a Pixels/Inch setting
of 300 in the Resolution Document Size box. If

its value is below this number then feel free to
change it to 300, but note that this will make your
image size a ot smaller,

Printing artwork

Prepare your image for print

chieving outstanding results when
printing artwork requires a little bit of
know-how.

Printers look at individual pixels in an image,
which means that with more detail and a higher
number of pixels, the printout will look better,

If your image has a small resolution, with
little detail, then it's quite possible you might be
disappointed with the final print. First decide
whether you're going to print the image yourself
or whether you're going to use a service. If you're
using a service then don't worry about setting
up the image's size. Just follow on from step five,
where we discuss a file format for printers,

Image Size
— Pixel Dimensions: 34.9M E !“
Width: (2848 | [ Pimels 3| :I S
ance
Height: | 4288 | [Pixels 2]

— Document Size:

Width: | 24.11 | Centimeters Y
—_— (0
Height: | 36.31 . | Centimeters : | :|
Resolution: | 300 | | Pixelsfinch s
¥ scale Styles
# Constrain Proportions
fﬂhsmpﬂ: Image:

03 stick to original size

If you plan on printing smaller than the original
image size, you won't need 1o agjust the size
options in Photoshop., Simply specify the print size
in your printer's settings when you come to that
important final stage.
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05 Choose TIFF

When you're happy with your image, head over to
Fle=Save As from the top menu. Then chogse TIFF
from the Format options. This is an uncompressed
format which means it will keep your image’s size
large for printing.
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At the top of the Save As dialogue box, name
your file and select a location on your computer.
Press the Save function to complete the process
of formatting your image, which should now be
ready for printing.
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Halghe: | 1631 | Coret ity

Resolution: | 30 | Pisiedsjinch
o Semie Srvies

# Conemain Progomions

o Brnmerple Image
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07 Image Size

From the top menu select Image>lmage Size. This
will show you how large your image is. Printing any
larger than this size will reduce the quality.

Inw“
— Pixel ﬂimu?.iinns: 54..1M bwas 34.9M) - [ oK
Width: (31543 | Pixsls = | :
' | It | Cance
Height: 5335 | | Pixels 2|
' |  Auto.

Document Size;

Width: !I:l Centimeters :
. Y a
Height: |45.17 | | Centimeters : ]u |
Resolution: | 300 | | Pixels/Inch :
¥ Seale Styles
™ Constrain Proportions
I_H Resample Image:
| Bicubic Automatic A

04 Printing bigger

It is possible to print an image larger by entering
a new value in the Height and Width columns.
Unfortunately, the printout will lose quality, so
this is not recommended, but there is room for
enlargement up 1o a point.

B 'mageForPrint td o
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07 Working with the file

Your photo can now be printed and, as it's high
resolution and uncompressed, it is very large in
size, If you're moving the file to another computer
then use a device such as a memory stick, because
it's not ideal to email an image at this size.



Save layered
artworkor a
flattened version

Keep your options open by
saving a master copy

hotoshop works with layers, allowing you

to edit and adjust images at any stage.

When you save an image as a JPEG, the file
is flattened and the layers are lost.

It's a good idea to keep both a layered and a
flattened version of the image on your computer,
That way, if you want to make changes it's as
simple as opening your master, layered copy and
making the adjustments.

01 Make an adjustment
With your image open in Photoshop, add an
Adjustment on a new layer, such as the Brightness/
Contrast Adjustment (Layer>New Adjustment
Layer>Brightness/Contrast), This could be to
improve the lighting in your image if slightly under
or overexposed.

Phatoshop
Large Documaent Format
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02 Save flattened file

Save your image as a flattened file by choosing
File=5ave As and selecting JPEG as the file format.
Name your file, choose the JPEG guality you need
and then save it [he High and Maximum options
will increase the size of the file significantly.

Color:

Flattened images

JPEG is the file type most
commonly used with
photographic images, as it
supports CMYK, RGB and
Grayscale colour modes. This
will, however, remove all
layers and flatten the image.
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Save with layers

Quality File size preview
JPEG files can Select the quality using
be compressed the slider, depending
selectively, which on whether you want to

means that you

can choose the
final file size of your
flattened image.

output a small or large file.
Keep an eye on your image
behind this menu to see
how the changes will look.

Layered files will be saved
at their original guality,

50 you can always go
back and use the Save

As option to store your
image at a different size
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03 Keep a master copy

Choose File>5ave As to save a layered copy of your

image. Choose Photoshop under Format and then
give your image a name, The file extension for this
format is PSD - Photoshop Document - and it can
e opened within all versions of Photoshop.

using the JPEG options.
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04 Update old files

[o adjust an image, open the layered file to make
the changes. >ave your file as before and then

choose Replace when prompted. This will update
your previously saved image. Save the changes to

vour layered file and then you're safe to close it,
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Learnto copy omﬁmgLs
and paste '

Discover the basis of composites by taking
elements from one picture and adding
them to another
The words cut and paste describe two very simple

actions. You cut out (or copy) an object in one

photo into an internal memoery buffer called the
clipboard and then paste it again into a different position
or photo. However, it's the processes that leads up to the
cut and what you do after the paste where all the work and
complexity comes in, and with Photoshop it can be very
complex indeed.

But before you cut something out of a photo, you have
to select it first, either by using one of the selection tools:
the Marquee tool, Lasso, Polygonal Lasso, Magnetic Lasso,
Quick Selection, Pen tool, Magic Wand or the Quick Mask
mode, After you paste an object it can need cleaning up or
adjusting, so at this stage even more tools like masks and the
Transform options come into play.

“From the most basic pasting
to complicated, layered

collages, copy and paste are
Photoshop fundamentals” ENHANCED

HGW tﬁ COpy Select one area to move to another

By bl ey i G e - - wewe ves @ B B
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07 Get the right background 02 Magic Wand settings 03 Refine and copy
'he mast commaon example of cut and paste is Select the |l".-'li|-h gic Wand tool and set the Tolerance Hold down the Shift key and click on any
to take someone from one photo and paste them in the top Options bar to 30 s0 it picks up all of unselected areas. Go to Select>Inverse to select
nta a more scenic one. This is made much easier if the white. Put ticks into the Anti-alias box for a soft the figure r’I hen Select>Modify:=Contract and
the person is stood against a plain background to edge and Contiguous so only the t.-r:l..'.-“f.!l-.,hl ais enter a value of 1px. Finally, use either Edit>Copy or
tart with. Start by loading the subject photo. selected. Now click on the white area. press the shortcut combination Cerl/Cmd+C,
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PaSte a SU bjECt How to retrieve your copied selection

07 Tackle the pasting 02 Position carefully 03 Rescale

Close your subject image and don't save it. Load If you click on the subject and hold the mouse [he model is so close we've now lost part of the
the scenic picture and go to Edit>Paste or press down, you can drag it around the screen. In this subject. Click and hold the corner gadaget of the

Ctrl/Crmd+V. She has appeared but is floating case her head should be no further than halfway Transtorm box then move the mouse lett and

n rmidair. Select the Move tool and tick Show up the screen, so we move her down to a more down. Click on the Aspect Lock button petween

Transform Controls. realistic position., W and H then apply.

Clean up your copied IMage integrate the elements

07 Refine the edges 02 Color balance 03 Brightness reduction

[0 Clean up the pasted cbject, make sure you are fo match colours between the two images, Go to Image>Adjustments>Curves. Create two

on its layer and click the New Layer Mask icon in work on the subject layer and go to Image> control points by clicking on the curve, One

the Lavers palette. Select the Brush tool with a Adjustments>Color Balance. Move the sliders should darken the shadow areas and the other the

o

black Foreground colour. Start to brush over any to adjust the tone. In our case, we removed the highlights. You could also add grain or use the Lens

untidy areas carefully, yellow hue Correction filter,
o -.‘I: -::_...T :...:.:_._ .I_l_-_'_ ‘:_:"”: ':' ._"-' B - W e meems B 0ot (=]
MISMATCHED RESOLUTIONS [ — =
If picture A is a low-resolutionimage  like Alien Skin's Blow Up 3 or 4 Bt e
and picture B high resolution, when onOne's Perfect Resize 7 rather than BAras
s L4 e

you copy the object from picture Photoshop's tools. The second is that
A and paste it into B it will appear you could find pictures that are the
to be too small. If you use the same kind of resolution. However,
Transform tool to make it bigger, the  if picture A is of a higher resolution

quality will suffer as a result. There than picture B, the problem is easily T ——

L .:J—;I.--l':l it o B N S

are only two things solutions to this solved. Mow that the object being
fairly commaon problem. The first pasted appears too large, simply use
is to increase the size of picture A the Transform tools to scale it down
using specialised plug-in software to the right size!
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New features
Discover all the new features of

Adobe Elements 18 in full, as well . % . .
as the purchasing options, at http:/
www.adobe.com/uk/products/

photoshop-elements/

does it mean?

S oo ERE ELEMENTS - Elements

comes in three different strands:
Organizer, Photoshop Elements
and Premiere Elements. Premiere
Flernents takes the best features of
the Premiere brand, which is used
to edit video content. Premiere
Elements is available with
Photoshop Elements for

£130.36/599995,

SOURCE FILE AVAILABLE

ements 2018

Discover Photoshop El

What's new in the 2018 update to the program?

dobe first released Photoshop Elements for beginners and users The Guided Edit mode within the program has become particularly popular
in a hurry or on a budget; it contained many of Photoshop's best in recent years, offering step-by-step walkthroughs for all kinds of projects,
features, but at a fraction of the price. and 2018 sees a fair few new ones. You can now create watercolour digital
Since those early days of Elements, the software has become more powerful paintings, incredible double expasures, and even replace backgrounds with
than some early versions of Photoshop, but still retains its core principles ease and speed. Elsewhere, use the Auto Selection option for an even smarter
of being simple to use, fun for all kinds of users and a budget alternative to workflow,
Photoshep. Elements 2018 is no different: it's packed with all the features and Elernents is a brilliant option for creatives, and there's plenty in the new
tools that make it great, and it includes an array of new ones to make it easier version for us to get our teeth stuck into. Let's look at what's new, and how you
and more intuitive than ever. can use it in your work,
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ChQCk OUt the Updates Take a look at the latest tools and features added to Elements
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07 Auto Selection

A brand-new selection tool, Auto Selection is even
guicker and more intuitive than anything Elements
has ever had. To use it, simply make a selection
somewhere in your image and the program will
automatically judge the edges that you're creating.

1 it P ™ by e - i G E oo
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04 Organizer

The Organizer section of Elernents has also seen tweaks in this edition. Photos
are now organised automatically, there's an Auto Curate feature added, and
slideshows have seen a significant update, in that they select the best images
themselves now.
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06 Shape Overlay

'he Shape Overlay option is another Guided Edit that boasts quality as well
as efficiency. It places a specific shape overlay over an image and you get to
decide on the effect inside and outside the shape.

02 Double Exposure

With a wealth of new Guided Edits, Elements has
added even more editing possibilities for users in
a hurry. The Double Exposure option is of genuine
quality as well as being quick to apply, and even
offers you stock options to add over your images.

03 Open Closed Eyes

It's likely there will be elements of some photos
you don't want to keep. The new Open Closed
Eyes feature enables you to take the eyes of one
image and substitute it over another, meaning that
you needn't settle for an imperfect image again.
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05 Replace Background

While replacing backgrounds is one of the most time-consuming and
pernickety things you can do in Elements, the new Replace Background edit
can significantly cut time. Simply use the selection tools and import an image,
or choose a preset background.

07 Watercolour

Creating cool digital art from default options within tool settings can be tricky.
However, the Watercolour feature in Elements 2018 creates beautiful effects
fram your images and can make art from even the most ordinary of pictures.
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Getting started

Photoshop
shortcuts

Dramatically speed up your workflow
with these handy shortcuts

nce you've got to grips with the basic Photoshop tools and
features, it's a great idea to start practising some of the

shortcuts. Whether you are editing, retouching, creating or
more, you can save loads of time by learning shortcuts. Over these two
pages we've compiled an essential shortcut guide, which we've splitinto
sections based on the type of tasks you perform. Make sure you have this
cut-out-and-keep guide close to your computer and use it whenever
you have a Photoshop project on the go. We're certain you will know
these shortcuts off-by-heart in no time! We have given both Mac and PC
commands, so Cmd/Ctrl means the Apple or Command key on a Mac,
and ControlonaPC,

Handy shortcuts for

everyday tools

t'L Crop Toaol CFDDTDDt'l__
I77 Perspective Crop Tool Perspective Crop Tool: C
Slice Tool Slice Tool: C

o
- Slice Select Tool

Slice Select Tool:

Eyedropper Tool: |
3D Material Eyedropper Tool: |
Color Sampler Tool: |

4 Eyedropper Too

[

i o 3D Material Eyedropper Tool
o Color Sampler Too

mrm Ruler Tool

Ruler Tool: |
Bl Note Tool
e Note Tool: |
1= 3 Count Tool
: Count Tool: |

Eraser Tool: E
Background Eraser Tool: E
Magic Eraser Tool: E

s ¥ Eraser Tool

[

e =] -
“B¥ Background Eraser Tool

= Magic Eraser Tool

Rectangle Tool: U
Rounded Rectangle Tool: L

m [7] Rectangle Tool

[ Rounded Rectangle Tool

¢ Ellipse Tool E”|F}5'E' Tool: U
: ay
{ Folygon Tool PG'FQDW fool: U
| Line Tool: U

Line Tool
Custom Shape Tool: L

™ Custom Shape Tool

2 \H Hand Tool M Hand Tool: H
‘#_‘; TR eeoEl Rotate View Tool: R
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Zoom Tool: 7

Select and Selection tools

1+ Rectangular Marguee Tool
7™ Elliptical Marguee Toaol

=== Single Row Marguee Tool

o

Single Column Marquee Tool

s () Lasso Tool

= Polygonal Lasso Tool

L= Magnetic Lasso Tool

Rectangular

Marguee Tool: M

Elliptical Marquee Tool: M
Single Row Marquee Tool: V]
Single Column Marquee Tool: M

W Lasso Tool:|
W Polygonal Lasso Tool: L

j MagneticLasso Tool: L

= 7 Quick Selection Tool W OV[eTSICTailels Mool

-'I'- Magic Wand Tool

Magic Wand Tool: W

Toggle Standard/Quick Mask modes: O

Cycle Path/Direct Selection

tools: Shift+A

Toggle Slice/Slice Select tools: Shift+K

Cycle Lasso tools: Shitt+L

Toggle Rectangular/Elliptical Marquee: Shift+M
Toggle Pen/Freeform Pen tools: Shift+P

Select All: Cmd/Ctrl+A

Select All Layers: Cmd+Opt+A/Ctri4+Alt+A

Deselect: Cmd/Ctrl+D
Feather: Cmd+Opt+D/Ctri4
Inverse: Crmd/Ctrl+Shiftt+|

Reselect: Cmd/Ctrl+Shift+D

.l':ll'T 1] | :I

Painting tools

s / Brush Tool
-

* Pencil Tool

¥

E;,r‘ Color Replacement Tool

!r‘_,.-’ Mixer Brush Tool

Brush Tool: B

Pencil Tool: B
Color Replacement

Tool:B
Mixer Brush Tool: B

Decrease/Increase Brush Size: [/
Decrease/Increase Brush Hardness: {/]

Previous Brush:,
Next Brush:.
First Brush: <
Last Brush: = B
Brush tool: B

Pencil tool: B
Gradient tool: G
Paint Bucket tool: G
Sponge tool: O

;,.-*" History Brush Tool Y

;.r, Art History Brush Tool Y

History Brush Tool: Y

Art History Brush Tool: B
Tool Opacity 10%-100%: 1-0
Flow/Airbrush Opacity 10%-

1009%: Shift+ 1-0



Image-editing tools

Type tools

Spot Healing Brush Tool: | & Spot Healing Brush Tool
Healing Brush Tool: | & Healing Brush Tool
Patch Tool: ) g Patch Tool
Content-Aware Move Tool: | ¢ Content-Aware Move Tool
Red Eye Tool: ) to Red Eye Tool

Clone Stamp Tool: S
Pattern Stamp Tool: 5

1

rFattern Stamp ool 5

Dodge Tool: O @_Dodge Tool O
Burn Tool: O A BunTool O

Sponge Tool: O &2 Sponge Tool O

Toggle Clone/Pattern Stamp: Shift+5

Auto Color: Cmd/Ctrl+Shift+B

Auto Contrast: Cmd+Opt+Shift+L /Ctri+Alt+Shift+]
Auto Levels: Crmd/Ctrl4Shift+l

Canwvas Size: Cma+Opt+C/Cri+Alt+C

Color Balance: Crnd/Ctrl+B
Color Balance (last settings):
Curves (last settings): CmdH
Curves: Crnd/Ctrl+M
Desaturate: Cmd/Ctrl+Shift+U

Hue/Saturation: Cmd/Ctrl+U

Hue/Saturation (last settings): Cmd+Opt+U/Ctrl+Alt+U
Image size: Cmd+Opt+1/CtriH-Alt+|

Invert: Cmdad/Ctri+

Levels: Cmd/Ctrl+L

Levels (last settings): Crnd+Opt+L/Ctri+Alt+L

md+Opt+M/Ctri+Alt+M

C
Opt+M/Corl+Alt+M

Foreground/Background colours -
Default colours: D

Switch colours: X

Edit in Quick Mask Mode: O

More tools to (!)Iay

with in CS6/C

= [ Cradient Teol Gradient Tool: G -
&, Paint Bucket Tool & PaintBucket Tool: G
74, 3D Material Drop Toal G 3D Material Drop Tool: G

w P Tod d PenTool: P
49" Freeform Pen Tool Freeform Pen Tool: P
" Add Anchor Point Tool Add Anchaor Point Tool: P
Delete Anchor Point Tool: F
Convert Point Tool: P

__ﬁer Delete Anchor Point Toaol

Comvert Polnt Too

Clone Stamp Tool 51

= T Horizental Type Tool B Horizontal Type Tool: T
|'T" Vertical Type Tool Vertical Type Tool: T
**7* Horizontal Type Mask Tool Horizontal T';-,J' e

= Mask Toal: |

Vertical Type Mask Tool: T

| “5F* Vertical Type Mask Tool

e R e e Path Selection Tool: A
Direct Selection Tool: A

% Magic Wand Tool W

Align Left: Cmd/Ctri+Shift+l

Align Right; Cmd/Ctrl+Shift+R

Bold (toggle): Cmd/Ctri+Shift+B

Centre text: Crnd/Ctrl+Shift+C

Decrease/Increase Type Size by 10pt:

Cmd+4Opt+ Shift+<, /Ctri4+Alt+5hift+<, >
Hyphenation (toggle): Crd+Cpt+Shift+H/
Ctri+Al+Shift+H

ltalics (toggle): Crmd/Ctrl+Shift+

Justify Paragraph (Force last line): Cmd/Ctrl+Shift+F
Justify Paragraph (Left align last line): Cmd/Ctri+Shift+)
Underlining (toggle); Crmd/Ctri+Shift+U

Uppercase (toggle). Cmd/Ctri+Shift+K

Bring Forward: Cmd/Ctrl+]

Bring to Front: Cmad/Ctri+5Shift+]

Create/Release Clipping Mask (toggle): Cmd+Opt+G/
Ciri+-AIH-G

Group Layers: Cmd/Ctrl+G

Layer Opacity 10%-100%: 1-0

Layer Via Copy: Cmd+ Opt+J)/Ctri+Alt+]

Layer Via Copy (with dialog): Cmd/Ctrl+Shift+l

Merge Layers: Cmd/Ctrl+E Merge Visible: Crd/Ctrl+Shift+E
New Layer: Cmd/Ctrl+Shift+N

New Layer (no dialog): Cmd+Opt+Shift+N/Ctri+Alt+Shift+N
Next Layer: Opt/Alt+]

Previous Layer: Opt/Alt+]

Select Previous Layer: Opt/Alt4+5Shift+]

Select Next Layer: Opt/Alt+Shift+]

Send Backward: Cmd/Ctrl+|

Send to Back: Cmd/Ctrl+Shift+]

Stamp Down: Crd+Opt+E/Ctrl+Alt+E

Stamp Visible: Crnd+Opt+Shift+E/Ctrl+Alt+Shift+E
Select Bottom Layer: Opt/Alt+,

Select Top Layer: Opt/Alt+
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IBasic corrections

Open -~ Quick
VIEW x 1068543_26845300.jpg @ 50% (Layer O, RGCB/E) *
Ve
Q &
SELECT
"+ 1
baad
g AUTO
5
LEVELS
R ANGCE You can improve your
- L shots using a selection
of auto commands
¢ &
@ &

Preset: Custom

Channel: ' RCB :} ~ Cancel >
MODIFY et
n @ Input Levels: —r
S _Options...
& T=1"
S «
i .I.II||||| oo
% ' & h""""".'“ W Preview
0 1.47 239

Output Levels:

Doc: 12.9M/15.3M 8

L a0%

Recompose :
g L -J% [ crROPYOUR
. : —:) :
£ : w:[1935cm | 5= u:[16:68 cm WAY TO BETTER

PHOTOGRAPHS

Trim away the excess on your
images for greater impact

& 7 DO C ) .

Photo Bin Tool Options- Undo Redo Rotate Layout Organizer

L) —E, - - -_— = - L ) e —— _— - L= 1 e -—y e P b ] - . P e - — - . . L e e — - — - i L =y T - | - . -y -— - L__ ] __J [ ] - L
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Create ~ Share ~
9l @, @ La m -
' No: Opacity; | 100% | ~

{11
—

Preset: | Default [ S O |

Channel: | RCB - Cancel

= - -
F simGoth
*
_; | Auto
Ciptions...
W Preview
]
Input:
£ F A Show Clipping

|:] Curve Display Options

Show Amount of. (=) Light (0-255) =
Pigraent/ink %

ol

Show: ™ Channel Overlays ¥ Baseline
4 Histogram ™ Intersection Line

RECOMPOSE

Get greater control over how
your image looks

Effects Graphics Favorites Mare
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Basic corrections

Get the best from Auto commands

Work with Auto commands in Elements to speed up edits and apply instant fixes

hen Photoshop Elements version 12 was released, users wanting designed to contral contrast, tone and colour using clever algorithms to find
wgwift editing solutions rejoiced in the fact that the number of the right settings that Photoshop deems best for the job.

Auto commands increased, including the new Auto Smart Tone. Although Photoshop does have auto options, Elements has more to choose
This not only fixes lighting, colour and tone, but also has an intelligent memory  from, such as Auto Levels and Sharpness, which go a long way to reducing the
for recalling the last used settings. This enables them to be adapted and time taken to edit a big batch of images.

applied to new images.

These handy little fixes don't stop there, though. Do a bit of exploring and “YOU W| | I ﬁ nd Ma ny qU|Ck one-

you will find many more quick one-click edits located inside the Adjustment

. . . . I
(Photoshop) and Enhancement (Photoshop Elements) menus. They've been Cl |Ck E‘dltS |n5|de the mE‘ﬂ US

'“‘. =P . k,
- T

® Auto Smart Fix HEM
Auto Levels O¥L
Auto Contrast XL
Auto Color Correction ¥B
Auto Sharpen
Auto Red Eye Fix ¥R

et R L e -HI
~h ‘l.
—

In Elements

The range of Auto fixes in
Elements provides just the

. : e : . right edit for improving
- b o, - O e | different aspects of your
| '. ' Xy Phried L image - such as colour.

Auto Tone o 14OL ==
Auto Contrast LY O3XL E
Auto Color {138 =

In Photoshop
The three options in
Photoshop will help you
edit multiple images
quickly, applying
enhancements to tone,
colour and contrast.
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AUtO ﬁ)(es in PhOtOShOp Elements Make the most out of these handy one-click edits

.

B . — . = 3 . *_l'-’_ o

07 Auto Smart Tone 02 Auto Smart Fix

Introduced in Elements 12, dragging a target over the image towards an edge he Auto Smart Fix option in Elements is a very effective way to quickly
or corner changes the overall balance of exposure and contrast. Four previews improve an image. The command takes into account all manner of different
adorn this menu, helping you to reach the best end result. aspects, such as lighting, contrast, colour and sharpness.

03 Auto Sharpen 04 Auto Levels

Make your image appear sharper and crisper with this instant fix. Sharpness This one deals with lighting and makes midtones, highlights and shadows
isn't always visible from a distance, but zoom into your image before using this mare lively. Using these quick fixes will go a long way 1o reducing the amount
one, and then apply it to notice the difference. of time spernit in editing.

Instant fix for tone, colour and contrast make quick fixes with Auto commands

07 Auto Tone 02 Auto Color 03 Better exposures

[his Auto option works best on dull images that [his command fixes problems in the colour and 'he Auto Contrast command detects the brightest
lack vibrancy. The changes can be quite big in contrast areas — a handy one for removing orange or  and darkest parts of an image and adjusts the
some cases, and not so big in others. Dlue tints that images can sometimes acquire, dynamic range to improve the overall lighting.

Photoshop for Beginners 45



Basic corrections

Quick Edit mode

Make simple touch-ups and add filters with
a click, using the revamped Quick Edit mode

odern society can be an incredibly busy place, especially for any
budding photographer. These days, you are far more likely to take
photographs on the go with your smartphone than you are to make
time for a day out with the digital camera, and more and more people upload
pictures straight to social-media accounts, rather than importing them onto
their computer.

But it isn't just the process of taking images which has shifted over recent
years. The modern photo-editing process is having to play catch-up to our
own hectic schedules, and the Quick Edit mode of Photoshop Elements
certainly has a role to play in all of that. For quite a while now, it has been the

Expert tip

EDITING FURTHER - Cuick Ediits are
designed to make adj

rminimal effort, however, they are by no

means the end of the editing process,

You are able 1o flick between the

:"]IH_[—":'I:—:'"'I|_ modes in

go-to place to make simple tweaks to your pictures without being a massive
drain on your time. With Elements 15 however, it is even more intuitive and
capable of creating wonderful and unigue pieces of art.

Open your picture, head to the Quick Edit section of Elements and you
will natice the new Smart Looks feature added to this latest version of the
image editor. It's a product of the Instagram generation in that it generates five
unigue filters based on a bank of hundreds, and transforms your shots instantly.
It's a great fix, it offers creative and colourful alternatives for your pictures, and
the best thing is that it's a speedy answer to anyone who wants (or needs) to
edit in a rush,

eLive Guided  Expert

Choose either the recommended
Smart Look that Elements supplies

Photo Bin
Remember to leave the Photo Bin at
the bottom of Elements open if you
want to quickly flick between each of
your open documents.

¥ S C D\

1 ‘Tool Options”  Undo Reda Retate Owganizer
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Create ~ Share ~
Smart Looks 29
to you from the start, or one from a EF;L s -

shortlist of four.

=
| [[

E

%

NN

| -
—

Other filters

You can choose other filters on the =
right-hand sice of Elements, such as

Tint, Toy Camera settings or Black &
White filters.

ames |



Use Smart
Looks filters

Choose from five pre-picked,
perfect filters

When Elements 14 came on to the scene, it
became easier than ever to create distinctive
effects in the Quick Edit mode.

Smart Looks is a bank of hundreds of
filters. When you open up a photo in Quick
Edit, you'll be shown five possible filters,
chosen from this bank especially as filters
that will suit your picture. Here, you can have
more individuality with photos, as well as
edit with speed.

BOUEK
BREE

07 Fix up slightly 02 Apply a look 03 Edit further

Start off by making tiny tweaks to your picture Click an Smart Looks. Elements will present a If yvou want to make any further tweaks to this filter,
as you see fit. This could involve improving the filter that it recommends most from its extensive click on the Expert tab at the top of Elements. You
lighting, exposure or colour, or just applying a collection, along with four others, based on what Smart Look is applied as a layer with a mask; this
Smart Fix 1o your picture, You may not need to will complement this picture in particular. Choose means you can mask out the changes in some
make huge changes, as Smart Looks does this too. your look by clicking on it places, or reduce the Opacity to lessen the effect.

Fi)(ing With filters Smart Looks can be used for all sorts of edits

Night-time shots Black & whites Bleached photos

As well as adding colour and tone to pictures, you Increase the contrast in your black-and-white Fven washed-out photos can benefit from

can fix any underexposure in your pictures with pictures with Smart Looks, but also add a touch Smart Looks, which can completely transform

the Smart Looks. Any night-time shot produces a of colour, such as a sepia tone, or just a tint of red overexposed shots. Smart Looks takes this low
series of Smart Looks that can brighten up your or yellow. This can give a classic retro feel, and contrast into account when producing filters to use
picture, as well as add colour. brighten up monochrome, for your picture.
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Basic corrections

SOURCE FILES AVAILABLE

Space
Think about how an image

falls in the grid and how much
m rove dead space s in the final
image. Space isn't necessarily a
bad thing when used correctly.
com pOSitiOh
in photos

Fix the basics of your photos with
these three simple projects What
he rules of composition in photography are does it mean?

often overlooked. |".,J.1a!—|-}|r Dh'l]tCl'graD}"IE rs RULE OF THIRDS - The rule of thirds is
; a commaon term and states that an
image Is most pleasing when Its subjects
and it's not particularly vital to give your picture the or regions are composed alang
perfect crop or vignette if it looks great as it is. Imaginary lines that divide the image
X into both horizontal and vertical thirds.
Lse Photoshop's guides 1o align the
any picture, and they're some of the subtlest tweaks subject with an intersecting
that you could possibly make to a project. Cropping point to select the

R : s . : best view:
and straightening your pictures is a given, but Elements N
and Photoshop make it easier than ever to be 100 per cent
accurate. Whether you're a photographer who has taken the

simply shoot on instinct rather than angles,

There are certain rules, though, that can improve

perfect snap, or you've created a composition with hundreds
of layers, using one of these simple composition-fixers as a
finishing touch can be a great way to end your work. Ultimately,
these are the kinds of fixes that correct the structure of your
pictures, shift the focus to the right part of the image, and give
your shots the correct perspective and visual balance,

These aren't the most creative projects that you'll ever
master, but they're some of the most important. There's more
to a picture than what's in it: it's about how you frame it, too.

ORIGINAL

' TECHNIQUE 1
Rule of thirds

Learn to correct any
picture with a crop using
the precision of thirds

Cropping your images is very
important when it comes to
controlling the focus. Make sure you

get into the habit of seeing your

pictures through a viewer's eye, and

notice what your attention is drawn

to. Photoshop and Elerments can make C IO \ drop-dowr
YOur Cropping even more accurate ' POpL

with its Rule of Thirds option. this just keeps your crop neater.
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Off-centre
Don’t automatically place
subjects in the middle of
the frame - an off-centre
arrangement works well,

Rule of thirds

This splits your preview into Grid
nine squares. Keep the focus on
the intersecting points for the
ultimum impact.

The Grid option splits your
picture into multiple squares.
The Grid is particularly useful
. when it comes to busier pictures
of cities or crowds.

Rule of Thirds
Grid "
% Diagonal

"4 Triangle

35 Golden Ratio
¥} Golden Spiral

Auto Show Overlay
v Always Show Overlay
02 Set Rule of Thirds 03 Crop Never Show Overlay

[o the right of the Straighten icon, you'll see an Using the corner handles, resize your crop area to

icon with a grid on it. Click this to see the Rule fit over your subject. Ensure that the main subject Cl’({_‘ e O Er]a'f

of Thirds option. Click on this, along with Always fits over the intersection of the Crop preview grid, Cucle Drientation
Show Overlay, and you're ready to crop. and simply hit Enter/Return to apply. .o
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I Basic corrections

 TECHNIQUE 2

How to add
avignette

Use simple layer
techniques in Elements to
create darkened edges

A vignette is often seen as a
creative technigue. It's an effect
that can add drama or style to
Wour pictures, and it's possible to
create in the Camera Raw section
of Photoshop.

But if you're simply locking to
create a centre of attention in
your picture, a vignette is perfect
for adding focus and dulling the
edges. Use your cropping skills to
give your picture a neater finish,

07 Duplicate your layer

This effect works best on pictures that have a
strong subject that isn't as prominent from the
backaground as you would like it to be. Open your
image and begin by duplicating your layer by
pressing Cmd/Ctrl+J,

[T — G - -

ORIGINAL

02 Darken the layer

Hit Cma/Ctrl+-L in order to access the Levels,

Move the middle stopper to the right and the

white stopper of the output levels into the centre
in order to darken the image. This is the basis of
YOuUr vignette,

Darker edges

Vignettes make your image look
cinematic but they're also good
for focusing in on the main
subject of your picture,

03 Add a gradient mask

Press the mask icon on your darkened layer. Go to

the Gradient tool, select a white to black gradient
and then click OK. The gradient will give a perfect
finish on the mask to bring the subject back into
the picture.

e il T — S TRER 3
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B _BS Wes ms EpEs e age bewm ma S Bs b s s e e e e s e e s — e s em my

-
04 Mask 05 Crop 06 Lower opacity

Using the Gradient tool, hold down Shift and drag
from the centre of your subject to the edge of
your picture to create a perfect vignette, You may
have to do this a couple of times to get the right
amount of darkness from the edges.
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Grab the Crop tool and resize the box to take the
centre of your subject into account. This is going
1o frame the picture and the vignette helps; you
can now see exactly what needs to be cropped
out, as it's darker than the rest of the shot,

You can inject a little more subtlety into your
vignette by lowering the Opacity slightly down
to 85%. You might want to go for a stylish, fully
opague vignette, but even the lightest ones can
still enhance your pictures hugely.



Awonky horizon canruinan
- otherwise stunning shot, but
Straighten
»
horizons

it's easy to fix.
Use the Straighten
tool in Elements to
correct those annoying
crooked skylines

It can often be hard to tell if a

picture is straight or not, whether
it's a framed painting on a wall, or
just a photograph you're editing in
Photoshop or Elements.

Unlike the other two technigues
here, this is a praject that you can
undertake before you start editing,
rather than after. Straightening shots
is a great habit to get into, and makes
you a better picture editor.

il |
CoLoe

« phiags BT g B 1 ARG

oy 9 - W W

Phoos Bin -Tool Ogtions Unde Rede  Romie  lavowt [wganize

07 Select the Straighten tool 02 Prime the tool

Go to the left-hand menu of Elements, where you'll find the spirit-level icon 'he bottom menu has options for the Straighten tool. Click Remove

for the Straighten tool. You can straighten by rotating or transforming your Background to prevent needing to crop afterwards. If you're straightening a
image, but this is the easiest way 1o swiftly level off a wonky horizon composition, hit Rotate All Layers to apply your straightening to everything

G W aecy  oween  [JECTE [T iy

N - S H T T e i =

03 Straighten 04 Crop to finish

low it's a case of simply dragging your cursor from left to right across your -inally, grab the Crop toal again and use the Rule of Thirds grid to re-frame
Now it's a case of simply dragging your cursor from left to right across yo Finally, grab the Crop toal again and use the Rule of Thirds grid to re-frame
horizon to straighten your picture. Elements will automatically crop your shiot the shot, This is only an optional final step, but sometimes it's a necessary one,

with this line as parallel to the top and bottom edges of your picture. as straightening your picture can affect the original compaosition.
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Basic corrections

Master the
Transform tool

Rotate, skew, warp or flip your images
in Photoshop with the amazing
transformation tools

host of useful tools that will literally transform the way you use

Photoshop. The Transform tools allow you to alter the entire shape of
an object, group, vector, smart object, path or selection. - but they cando a
lot more than this too.

Showing you how to use these tools is our objective, so the first thing to
learn when using any of them is that a bounding box will appear around the
object. On each of the corners sits a square, and hovering your mouse over
one brings up the rotate icon but to shift the itern's shape you will need to
click onto and move these squares,

In this two-page guide we will cover which tools suit your needs best and
suggest how to use them effectively. All of the essentials will be explained
here and we will present some clever uses of the tools that you may not have
even considered before, Before you know it, you will have learnt the subtleties
of each variation enough to know when each one is appropriate to be used.

You might have noticed ancther transform option under the Edit menu,
called Free Transform. Using this means you can use more than one of the
transform options at one time, saving you from having to hit Enter and
select another option if needs be. Once you have learnt how to use all of the
options, this tool will be (almaost) all you need. So let's start working our way
through the menu and see what you can do with these great options.

H iding under Edit=Transform you will find a menu with a whole

"Alter the entire shape of an object,

group, vector, smart object, path
or selection”

Rotate

A slightly wonky angle is easy to
correct with the Rotate tool in
Photashop. Double-click on your
background layer to make it editable,
Make sure rulers are showing
(Cmd/Ctri+-R) and drag a line from
the top ruler so you know where
your horizon line should sit. Go

to Edit>Transform>Rotate and a
bounding box will appear with four
corner squares. Hover aver one square
and you will see a rotate icon appear
Now move the image round until it's
lined up with the guide line. Hit Enter
when you're happy and then select
the Crop tool. Get rid of any excess
chequered background and hit Enter.
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FREE TRANSFORM TOOL

This tool allows you to amalgamate many of the transform features. Use it
to rotate, scale and add perspective all in one neat package.

Flip direction

To begin, drag the cutout

car image into our street
image so we can create

a convincing scene. Go

to Edit>Transform>Flip
Horizontal so the caris facing
the right way. Go back to Edit
and select Free Transform.

Scale the car
We need to resize the
car so, holding down
Shift, increase the size
of the car slightly to sit
more naturally within
the image. When
you're happy with the
size, do not hit Enter
yet because we are
now going to alter

its perspective,

Add perspective

To add perspective, hold down
Crmd/Ctrl+Alt+Shift or Cmd/
Ctri-Option+Shift and drag the top
left comer downwards. The bottom
left comer will lift up, creating a
vanishing point. Then hit Enter.

Work to scale
When you need to combine several images into one, the chances are you
will need to resize elements within a canvas. To do this we will use the
Scale tool. Open up the two images and drag and drop one onto the other
(with some images you will need to cut it out first and get rid of its original
background). Go to
Edit>Transform>Scale
and a bounding box will
appear again. We want to
scale and keep the image
proportions correct, so
hold down 5hift and drag
one of the top carner
squares inwards. The
whale image will resize
evenly. Hit OK when
done with your perfectly
proportioned image.




Edit
Undo Select Canvas
T ETY | W aTT
Step Backward
Free Transform
If you want to make general
transformations to an object

Cut
Copy just press Cmd/Ctrl+T to activate
¢ Me the Free Transform tool. Using

Paste keyboard shortcuts like this

Faste Zpec saves precious time.,

Clear

e b Scaleitup
al Replace Use the Scale tool to increase or

decrease the size of elements

Fill... 5 within the image. Make sure

Stroke .. that objects are in proportion to
one another though.

Contert-Aware Scale “C{¥C

Free Transform uT - Rotate
Select Rotate from the Transform

Transtorm
. Alian

menu or use the Free Transform tool.

Scale When the bounding box appears,
Define Brush Preset :l?:::& .'I hover over a corner to make the
Define Pattern... Distort Rotate symbol appear and move. Hit
e i e Perspective Enter to finish the transformation.
Wa'p

aeih [ — To flip or not to flip
Adabe PDF Presets... Rotate 9(* CW HE'T:'E“"bET youcan flip i[T"ﬂ'EIE-‘-
Presets »  Rolate 9(F CCW horizontally or vertically in the

Transform menu so you don't need
images to be facing the right way
before using them.

Remaote Connections...

Flit Horizental
Color Settings... {r¥EK Fligt Vertical
Assign Profile... ]
Convert to Profile...

— Perspective

Keyboard Shortcuts... Use the Perspective

Menus... transform option to make
adjustments to your subject
so they sit within the image

a bit better. Using this tool
makes items seem less
plonked in place.

' Finish it off
Make the scene look natural when
compositing images together.
Use the Levels tool to even out
colour tones and blend bits in. For
example, use the Smudge tool to
add the effect of grass.

Warp

Go to Edit>Transform>Warp
and a bounding box with

a mesh will appear an your
image. Move any of the control
pointers on the mesh to move
parts of your image. Start

with the corner painters then
rmove any internal pointers if
needed. Directional lines will
appear on the corner squares
when moved. Move these and
lengthen or shorten them to

Get some
perspective
Sometimes adding

a vanishing paint to
an image makes for

a maore convincing
effect. Even a small
amount of
perspective can make
a big difference. Make
sure your layer is
editable (double-click
on the Background

layer before starting) and go to Edit>TransformzPerspective. The usual alter image areas. This tool will
bounding box with four squares will appear. Move one of the top corner baoxes require some practice but you
downwards and the bottorm cormer on the same side will move upwards. This can fix camera lens flaws with
works if you move a tap corner side to side too. Remember to crop away any it as well as adding pages to a
excess background afterwards. book corvincingly, for example.
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SOURCE FILE AVAILABLE GET A CLEANER FINISH
ofe Tidying up the results
The Recompose tool does a good job in getting us started with resizing the image
without shrinking or distorting the main subject, But results aren‘t always perfect.
To clean up the image, use the Clone Stamp tool in Elements with a soft brush tip.

Gradually blend away patchy areas for a much cleaner finish,
Reduce the distance between objects using

Photoshop Elements’ Recompose tool
T his is a tool that really doesn't get the attention it deserves. Its

purpose is to bring subjects closer together without changing

their actual size or shape in any way. This is done by recognising
areas in an image of similar pixels, such as a blue sky or the rough surface of
tarmac, for example, and shrinking them down. The main subjects, which are
often composed of more variation and irregular shapes, are unaffected so
they will remain exactly as they are as the composition is altered.

The Recompose tool has been around in Elements for a few versions now,
however, it has gone somewhat under the radar. The tool can be found at
the very bottomn of the Tools panel, so if you are using Elements 15, look
within the Maodify section in order to find it (its icon has a cog symbol over
a square),

This is quite a powerful tool in terms of what it can do for an image, but
the quality of the results can vary greatly - it is all down to the image and
type of compaosition that you are dealing with. Following these steps will get
you started with the Recompose tool on your own images.

“The purpose of the Recompose
tool is to bring subjects closer
together without changing their
actual size or shape in any way”

R b T R e e R

07 Duplicate background 02 As if by magic! 03 Resize to fit

To be able to compare how the tool changes the Press W to go to the Recompose tool and eight Move one of the corner boxes inwards 1o adapt the
subjects, duplicate the Background layer of the boxes will appear around the image. Drag both height and width of the entire image. This means
image by pressing Cmd/Ctrl+J). Hide the original side boxes to the centre. Resize the image while that the image can be resized to fit a new frame.
Background layer so only the top one is visible, keeping the size and shape of the main objects. [he people and objects have stayed the same size!
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07 Keep the main subjects

Before recomposing your image, tell Elements 1o
keep or remove parts of the image. Paint green
over the objects you want to keep using the Mark

for Protection brush in the Options panel,

il

I

02 Mark as red

se the Mark for Removal brush to paint red

over the parts of the subjects to get rid of in the
recomposing process. | nis works on parts ot the

image between the main objects being moved

=

J
&

RIGINAL =

Keep or dEIete ObjeCtS Remove or protect certain parts of the image

b W
.-.._ F ".

i eam il
e s S A F B
e L LM -ﬂ'—’:‘-":_-f: ‘-'1'."_ %

oo P

03 Recompose pixels

Mow wher

| yOu resize the image by dragging the
transformation points around the edges, Elements
Is able to read which areas to get rid of to improve

the final result.

Photoshop for Beginners 55



Basic corrections

ENHANCED

56 Photoshop for Beginners



The Gradient tool

Find out how to use this simple, yet essential, tool to create colour effects

The Gradient tool is found in both Photoshop and Photoshop and interesting gradients. Some may also use transparency, so the colours will
Elements. In Elements it has its own slot on the Toolbar, but in gradually fade away into nothing at the end of the gradient.
Photashop, you will find it hiding alongside the Paint Bucket tool. If you have a specific effect in mind, you can create a custom gradient using
A gradient is essentially a blend of different colours that seamlessly transition  the Gradient Editor (just double-click on the gradient colour swatch or hit Edit).
from one to the other. They come in various shapes, but the most common You will see a coloured bar, which is the gradient, with little arrows and squares
is a linear gradient, where the colours are in consecutive lines next to one underneath. The arrows determine where a colour in the gradient stops and
another. Photoshop has a load of preset gradients built in consisting of popular  where the next one starts. The squares show you what colour is being used in
colour combinations. There are also gradients that use the Foreground and the gradient. Experiment with the different balloon images in the supplied files
Background celours, so you can change the colours of these to create new and have fun with different gradients!

“Photoshop has preset gradients built in,
which are popular colour combinations”

MORE WITH GRADIENTS

Make new
backgrounds
Create a new layer. Set
Foreground colour to a
sky blue and Background
colour to white. Apply
a Foreground-to-
Background gradient to
your empty layer.
Enhance
Duplicate the photo
layer and set Foreground
colour to black. Apply a
Foreground-to-Transparent
gradient to your image so
the sky turns black. Set it to
Overlay blend mode and
adjust the Opacity to suit.
[« - bacieg | 11 =
::“.H;ﬁ..
-
B
5 .
=
01 Select the balloon 02 Add the gradient 03 Layer options
Duplicate the Background layer (Layer=Duplicate) Select the Gradient tool from the toolbar (press G). We need to let some of the original balloon show
and make a selection of the balloon. Use whatever In the Tool Options panel, untick Reverse, but tick through. Set the blend mode of the layer with the
method you prefer. We used the Magic Wand to Transparency and Dither. Pick the Linear Gradient gradient on to Overlay, Then, adjust the opacity of
select the sky, and then went to Select> icon and select a coloured gradient from the the layer until you are happy with the result. We
Inverse to select the balloon. Add a mask by presets. With your balloon selected, draw a line also added a new background fo this image (see
clicking the mask icon in the Layers panel. across the balloon to apply the gradient. below for more on this),
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) Richer effects
Quickly enhance colour
and detail by editing

images in Camera Raw.
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SOURCE FILE AVAILABLE

Use Camera Rawin
Photoshop Elements

Discover what this powerful image editor can
do for your images
Phctnshﬂp’s Camera Raw editor has been around for quite some time

DSLR in RAW format. Carmera Raw meanit that image detail and its raw’ settings
were available to edit, as opposed to working on a compressed JPEG file,

With Camera Raw in Elements, we can apply many of the same edits to a
JPEG image as we could have done with a RAW photo. Read on to find out
more about taking a dull image to the next level,

“The Camera Raw editor gives an
array of adjustment sliders”

now, but was only introduced into the Elements interface in version

11. This means it's now available to users straight from the File menu,
and gives you an incredible array of adjustment sliders to take control over the
lighting, colour, sharpness and noise in an image,

What's most useful about Camera Raw is that you can apply instant fixes
from a range of sliders. This removes the need to skip back and forth from one
filter to the next or load multiple adjustment layers. The Camera Raw function
was originally designed for photographers looking to edit images taken by a

FIX IMAGES IN CAMERA RAW Light

distribution
Crop down This histogram
Camera Raw includes shows you which
a Crop tool for colours fall into the
snipping off the brightest regions
edges of your images of yourimage and
in order to improve the spread of
compasition. Locate light across the
the tool from the top- visible spectrum.
left of the screen.
RAW edits
Although images
like JPEGs are not
strictly RAW files, Instant results
we can still take When you make a
advantage of the change to your image,
powerful tools updates are seen
and cliders in e instantly. Use the Preview
Camera Raw. e e 5 1o e o iy box to switch changes
on or off.

Open in Camera Raw i

Len 1
-_ e TBl
[ " .

Wi (R

orate exposure a

nd colour, and fix noise easily

()

- aq
d
&

-

04 Reduce noise

Click on the Detail tab. Under
Sharpening, set Amount to 56, Radius
to 1.3 and Detail to 25. This will help
to improve the focus. Set Luminance
to 44 and Luminance Detail to 50 for
sOme serious noise reduction.

03 Control colour

To rescue some colour and make the
subject more vibrant, slide up the
Clarity to +49. You should notice a big
improvement but noise could occur,
Also set the Vibrance slider to +48
and Saturation to +8.

02 Adjust details

For this image, we need to adjust

the colour and lighting. Set Exposure
to -0.30 and Highlights to -11. This
reduces the faded look of the image.
Finish this step by setting Shadows to
+8. Whites +22 and Blacks to -45.

071 Open animage

To open an image inta Camera Raw,
go to the File menu in Elements and
click on Open in Camera Raw (or
press Cmd/CtrH+-Opt/Al+O). Choose
an image from your computer and
hit Open.
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SOURCE FILE AVAILABLE

Edit with the
Paint Bucket tool

Learn how to fill with a solid colour or pattern, using this simple tool

hotoshop Elements is more than just a photo-editing program. There
are all kinds of artistic style options, and the Paint Bucket is just one tool
that can help apply paint to your artwork as a solid colour or pattern.

The Paint Bucket relies on the simple premise of covering any pixel or group
of pixels with a colour, but it can be used for much more sophisticated projects
than just painting spaces. Changing the blend mode or Tolerance, or using the
Contiguous checkbox can enable you to create all kinds of incredible effects
in your pictures; and though it's primarily a tool for digital art, the Paint Bucket
can become a handy companion for when you're editing images.

60 Photoshop for Beginners

TOUCH UP
WITH A BRUSH

The Paint Bucket isn't going to
cover every pixel, so touch up any
odd spots with the Brush tool.

ORIGINAL

It's important to remember a few things while using the Paint Bucket,
though. First, if you insert a new layer and check the All Layers checkbox, you
can apply your paint aver your picture non-destructively, meaning that you
can edit this colour or even delete it altogether if you like. There's the option
to apply your paint with a different blend mode, and you can even add
new patterns to Elements tog; this tool may be one of the most simple that
Elements provides, but that doesn't mean it's not a powerful option.

To discover what the tool has to offer, check out our quick guide of how to
use the Paint Bucket, and our suggestions of where to use it in your projects.




CIiCk the bl.leEt Apply a painted effect to specific pixels in your pictures

HS
N\ N

b =)
P e
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01 Set colour or pattern

The great thing about the Paint Bucket is that you can choose to either colour
in a solid colour or a specific pattern; there are plenty of patterns already in
Elerments to experiment with, too. Choose your option and set the Tolerance: a
lower number paints pixels of a mare similar colour,

= e— iy o B -5 P | ¢ e

- ﬂl‘-.‘::’." o

02 Fill your colour

Simply click on a pixel in the space that you want to fill with colour. Zoom in by
hitting Cmd/Ctrl and the + key to get even closer to your image. Create a new
layer first if you wish to experiment with the blend mode.

02 Try more advanced options
The options don't end with Tolerance though; set the blend mode that you
want to paint with and check the Contiguous box to paint over any pixel of

that colour, regardless of where it happens to be in the picture,

B B Bl e i 5 s S - e i i

wa s ﬂ-}']!::q ":- —

04 Paint into selected areas

You can choose to use selection tools to get more accurate before you paint.
The Quick Selection tool is the easiest to use, and it is sufficient enough to grab
a few pixels before you fill in with your selected colour or pattern.

Edit your photos

The Paint Bucket tool enables you to alter the
colour of any hue in your picture, which is
especially useful for editing your photos with
brighter hues. Alt/Opt+click on a shade, tweak

it in the swatches, set blend mode to Color and
uncheck the Contiguous box to paint it over all of
those particular shades in the picture; get a little
more precise with the Selection Brush.

Create Cutout effects

The Cutout filter is perfect for creating basic low-
paly or minimal edits, but the Paint Bucket can
create more detailed pictures of just a few colours.
Find an image with an object that you wish to turn
just one colour, and on a new layer, use the Paint
Bucket to fill over the shape. Then, do the same
with the background on a layer below your object
to create the cutout effect.

Recolour elements

Combining both the Paint Bucket’s ability to
change colours in pictures, and the precision it can
have over objects to make them stand out against
their backgrounds, why not highlight objects in
your pictures with the Paint Bucket? Simply set

the blend mode to Color, create a new layer and
choose a bright or vibrant shade in your image.
Check Contiguous.
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Layers

Understand the Layers palette

Get to grips with this essential palette and learn how layers are arranged

ere's a palette that no Photoshop user should be without. Learning the most adaptable aspect of Photoshop, and something we all should use.

how layers are arranged inside this palette, and how to move them There are different levels of using layers, from the basics to the impressive. Read

around, will open up many possible effects and ultimately improve on through our guide to the Layers palette and find out how to do the bare
your artwork. Layers come in many guises and can attach themselves to a essentials like adding new layers, organising them, blending them together
composition in different ways. From blending together your photographs with and deleting them too. Whether you want to use just one layer or many, there
seamless precision to using layer styles and adjustment in your work, they are are no limitations to how useful they can be in your edits.

FVI Select  Filte View Window Help

- > | | p LS
Enlarge your view Duplicate Group... Merge Down ENHANCED

The palette can be enlarged Delete > The Merge Down option turns
by dragging the bottom- two layers into one, with a

right corner if you've built shortcut of Cmd/Ctrl+E. This can
up a stack of layers. Group Properties... help keep your palette tidy.

New Fill Layer B -
New ﬂﬂjustmeQF Layer 3 FUAN New layers
Ayer Lontent Lons : : New layers can be added
either with the second-
Layer Mask b to-last icon in the palette

SRR or by clicking on the
Vector MaSk X - 4 R \ New Layer option in the

fly-out menu,

.'E

Smart Objects I

i

Rasterize 3

t
|

| et Light * | Opacy: [6ox | - |
Group Layers a8 G toc: (1 o B &  Fe[aoex] |
Ungroup Layers O+ #G ® | 3 8 e
Hide Layers

e B8 Photo Filer 1
Arrange 4 ' ® E Frame shape
Alig Ere election ® !Hw

& Efects
& Baee! & Emboss

Lock All Layers in Group... 'n" " ! Bk

E?ﬁﬂﬂmﬂﬁ

Merge Group s E
Merge Visible OX¥E
Flatten Image

'ORIGINAL
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Layers in PhOtOShOp What to expect when using layers in Photoshop

Layer

=111 TR TNaoy

Blend modes

If you have more than one layer, select
one of these blend modes to change the
way they interact. From Multiply to Screen,
and Soft Light to Luminosity, they create
slightly different effects.

Opacity

The opacity, or transparency, of each layer

is adjustable and shown as a percentage.
This lowers the visibility of the contents of a
layer to help blend everything together. 0%
Opacity completely hides the layer, whereas
100% shows it all.

Layer effect

Layer effects, also called styles, appear just
below a layer with their own eye symbaols.
Bevel and Emboss, for example, is added
by double-clicking on a layer. There are
many styles available, opening up awhole
different side to photo editing.

Layer stacks

Mew layers in an image are always added to
the top of the stack. Drag layers around to
reorder them and to change the appearance
of the image. To unlock layers, simply
double-click them.

Work in PhOtOShOp Elements How the palette works in Elements

Layer masks

Layer masks are shown either as solid black,
solid white or a mix of both. Black parts of

a mask show whatever’s underneath, while
white keeps the current layer visible.

Empty pixels

Layers showing the chequer board pattern

are mostly empty layers. There may be a small
object on it somewhere, such as a photo corner.
Cmd/Ctrl-click over this thumbnail to convert it
to a selection to reveal its location.

Switch layers on and off

Use the eye symbaols next to each layer to
turn them either on or off. Running your
cursor across multiple eyes is a good way to
turn more than one off quickly.

Deleting layers

If, for any reason, you no longer need to keep
one or more layers, drag them onto the trash-
can icon to remove them. If you change your
mind, simply press Cmd/CtrH-Z to undo and
bring them back.

Duplicate Layer...
Delete Layer

Niplate Hiddarn

MNew Group...
Mew Group from Layers..,

k A

Convert to Smart Object
Blending Options..,

Create Clipping Mask "G

Merge Down
Merge Visible
Flatten Image

Animation Options
Panel Options...

Close
Close Tab Group

Shape layers

Sometimes layers have small
symbols over the thumbnail,
indicating that they're a different
type. For example, a shape layer has
a small square icon to show this,

Hue/Saturation 1

: rﬂ Phott Cormer Black 01
Al ‘ Layer 1

Hack CRroLna

ar

Adjustment layers

Every adjustment layer automatically comes

with a mask, which appears just before the
layer's name, These types of layers affect

everything beneath them and can be altered

with a blend mode and opacity options to
change their appearance.

Rename layers

To help show what's on each
new layer as you work, double-
click its name to change what it's
called. Labelling layers as they're
added keeps a busy Layers
palette more organised and a
workflow smoaoth.

Hit F11

If the Layers palette
isn’t visible, hit F11
or go to the Window
menu toopen it.
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I Layers

Organise layers

Photoshop wouldn't be Photoshop without layers

ayers form the basis for all
editing, either from scratch or
with a photo to start you off.
Every layer contains new information
that changes the way your image
looks. Adding a new layer is
easy enough, but keeping them
organised is usually more difficult.

We take you through the various
ways in which you can arrange a
busy Layers palette. It could be a
matter of merging or grouping a
bunch of layers, so that you have a
better sense of where everything is
located inside the palette.

These technigues should help you
become a more efficient Photoshop
artist. Understanding the basics of
using layers, and ordering them
in the palette, is essential before
jumping straight in the deep end. Try
creating your own photo collage by
following the steps opposite,

“Layers form
the basis for
all editing”

i@ﬁtl‘@"iﬁg Iay@m Explore the different ways in which layers can be handled
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Merge layers Maklng duplicates

Aultiple layers in an image can be merged together for easier editing. This YO ever want t© make a direct copy of one laye ..I”h]”'L"."._.I'I!I!]'~.[«:I'.|'.',
reduces the number of layers in your palette, and there are no limits on press Crnd/Cirl+), or drag a |r];_.' r anto the Create a New Layer button in the
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Create a Group
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01 Create a new
document

In Photoshop, go to File> New.
the Preset drop-down list select

International Paper, and then A4 for
the Size. Give your file a name at the
top of the Open dialog box, such as

Photo Collage. Hit OK,

- e

H [ = e

02 Place images

Go to Image>lmage Rotation=50
CW. To open images one by one,
head to File>Place and pick your
first image. Hit Place and rotate
down Shift and
using the corner points. Hit Enter to

confirm its position.

From

and resize holding

Keep a closer eye on your layers in a photo collage
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03 Group up

When all of your photoagraphs
have been placed, click on the first
Image in the Layers palette ang
the last while holding Shift. Choose
Layer=Group Layers. The layers
should hide away inside a new
Group folder.

04 Reorder layers

o change the order in which the
layers overlap, click and drag a layer
up or down the palette (Cmd/Ctrl
and [/1). The current active layer is
always highlighted blue, so you
know at any stage which one you're
WOTKIing on,
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Moving layers
The Move tool (V) set to
Auto-Select: Layers at

the top of Photoshop will
instantly recognise the
image’s layer clicked on in
YOUr Canvas,

0| ||| S Trasisrm ol T O |

TT UniSted - Lpid @ T1.7% [Layer 4, BGI/E -

Groups

Group folders can contain
multiple photos, which will
keep your palette looking tidy.
Click on the drop-down arrow
next to the folder's icon to hide
or show the contents,

-k mml | w oo BB

Bl (BLTE o, W .

Rename layers

To rename a layer, double-
click on its name inside the
palette, Doing this regularly
will help you recognise what's
on a layer, especially if its
content is small,

Layer styles

Layer styles show up with the

letters fx on the layer. The Stroke

and Drop Shadow styles were
added to these images (from

Layer=Layer Style) to add an extra

dynamic to the design.

=
- =2

Locked layers

To lock a layer into position,
click on the third button in the
Layers palette under Lock. The
wooden background in this
image has been secured into
place under the images.
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I Layers

Navigate the Layer menu

|dentify the essential functions the layer menu has to offer

“New

W

- Delete

Layer menu
If your image has layers, Layer Style -,
you'll want to be familiar Smart Filte

with this menu,

New Fill Layer

Layer Mask
Vector Mask

Smart Objects

Group Layers
Je—— — | -"""_I'"-

Hide Layers

Merge Down
Merge Visible
Flatten Image

Matting

his is the control centre for all things layered.
From a layer mask to Smart Objects and adjustment
layers to groups, there is a long and extensive list of
handy options available to you.

Getting to know this menu will make your general
Photoshop experience much easier, There are helpful
options for applying photo edits, controlling the
placement of layers, adding masks and merging layers
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| ‘ Photoshop File Edit Image REVIE Select Filter View Window Help

Duplicate Layer...

‘Layer Properties...

New Adjustment Layer b

2l ; r
Ladyel ontent ¢ 1

Create Clipping Mask

New Layer Based Slice

T |
"

>

Start a new
> MNew layers are added
here and duplicates

can be made.

Styleitup
Layer Styles can be

accessed through this
menu to apply effects
to a layer's contents.

b o s m

together all in the same place. In this feature we look

at the most important options in the Layer menu,
comparing it with what Elements has to offer in this
department. The two versions have a similar array of
options - but Elements is minus a few of the more
advanced offerings that Photoshop CS users can revel
in. The best place to start is at the top - so what are you
waiting for?

Rasterize

Layers containing type

or custom shapes are
unrasterised, but this
means they're not editable
with most tools. The
Rasterize option turns these
layers into editable ones.

Layer menu
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New layers

Head into Mew at the top of the
Layer menu and you have the
option to perform a number of
different tasks. Either add a layer o
add a new group to contain layers
in. Also, use Layer Via Copy 1o place
the current selection onto a layer of
TS OwWn.
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Smart Objects

Convert a layer to a Smart Object

to edit its contents in a separate
document. They're especially usefu
if you have a part of your image
with lots of detail, making it editable
on its own. When Smart Objects
have been edited, save the changes
and your image will be updated,
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WHAT'S IN ELEMENTS * *

How the Layer menu looks

Enhance [FETTIE Select _Filter  View Window Help

New [
Duplicate Layer...
Delete Layer

New Adjustment Layer
Elements has fewer adjustment
layers than full Photoshop, but all

Print Size

etnameisonk prd @ 0% {Sackground cos

s £ R 4 Rename Layer... the vital ones are there, enabling

in Photoshop Elements 4 Layer Style X i PR it SYIeE i

. can be edited later on,
Duplicate and delete New Fill Layer > |

The Duplicate and Delete Layer commands New Adjustment Layer &

arein EEteTefnts. Ttlt*zess will remove the layers pr I Vi Layer Mask

;?mp S mr; El DETN AFEEICY g Just like Photoshop, the layer mask

irect copy in the palette for you to use. options are the same in Elements.

d Layi You'll add new masks to either show

Rename Layer ‘ or hide parts of a layer. They can also

Use Rename Layer to stay organised Layer Mask > be removed using this option

when editing multiple elements. Create Clipping Mask %G in the Layer menu.
When a new layer is added you can
give it a name in the pop-up box. -

o u. Create Clipping Mask
Simplify Layers Merge Down HE You can add a Clipping Mask
There's no Rasterize option in Elements, as :T';E' Tmh" OXRE through the Layer menu. This will
the Simplify Layer command does the same S | place one layer into the contents of
job at turning vector layers into normal ‘ - A =JT£'L._' another, making it appear inside it.

Clipping masks can be released just
as quickly as they can be added.

- i . T

working ones. This means you'll be able to
use the Eraser tool, among others, to edit it.

.

Which options to look out for...

e mw: Fiim Wiew Wedos Help

:_.'_ Bora "
-y = i N
L Frooein..
Ly e L] [
N B
a8 L - e [T gl LAH
B AL LT LT L]
- e
e B L IH-—.— L
e gk -
Cinate Chppheg ilash  THE
Bt s | e

Fegrw paer Taaps Cdae

i- atuall | d it i,

Duplicate Layer

You can take the entire contents

of a layer and place them onto

a new one using the Duplicate
Layer option. A new dialogue box
will pop up where you can set

the Destination for the duplicate,
whether that's a new document or
the one you've got open.

Group layers

To help organise your Layers palette,
select more than one layer and click
on Group Layers. This will arrange all
of the selected layers into one folder
S0 You can hide or show its contents
and navigate to them easily. Use
Ungroup Layers ta remave the
folder and release the layers.
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Layer styles

The list of layer styles holds effects
such as Drop Shadow and Inner
Shadowy, Bevel and Emboss, and
Gradient Overlay too. These anly
change the layer you're working on
and can be edited at any stage. A
new layer style is attached in the

Layers palette.
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Arrange layers

The menu has options to move
layers around and rearrange them
in the palette, Under Arrange you
can use the Bring Forward and Send
Backward commands to go one by
cne up or down the Layers palette,
Invaluable when youTe using blena
mode effects.
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Createnew
adjustment layers

[his 1s where the editing tools are
kept. Adjustments — when applied

as new layers — can be re-edited

as many times as you need.
Adjustments include Levels, Curves,
Hue/Saturation and Photo Filter, for
endless edits.

Merge layers

Merge Down and Merge Visible

at the bottom of the Layer menu
will compress muitiple layers into
one. This not only keeps your Layers
palette looking tidy, it also means
you can edit the contents of both
layers at once, rather than having to
repeat the process multiple times.

LAYERS
Marral o] Omacite [ o
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Layer masking

This provides a different route for
adding and removing a layer mask.
A Hide (black) or Reveal (white) layer
mask can be applied through here,
and if you have a selection you can
use the additional options 1o apply
a mask to that too. The best advice
is 10 experiment with the toal.

Flatten Image

To merge all layers into one single
one, select the Flatten Image option.
The result is a locked Background
ayer that cannot be edited. Be sure
to save a layered version of your
image before flattening, just in case
you change your mind and need to
make edits later on.
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I Layers

o N ..
— Cosopesi Black o

* RS23754_streets-0064-Editpsd @ 25% (You

Learnto control Eiésiisid
layer opacity o

underneath. You can turn visibility on

Discover how to control the transparency f';;‘e‘:’;:;‘;gntgi o g
of layers and added layer effects with the double-clicking the text.

Opacity and Fill controls

ositioned at the top of the Layers palette, next to the blending

mode dropdown menu, the Opacity box that contains a percentage _ N Opichy. 100% 8

figure. You can alter this value by clicking the triangle to the right and . @  fie 100x 5
using the slider or, alternatively, you can click inside the figure box and enter a '
new number manually. But just what does Opacity do?

A layer’s overall opacity determines to what degree it obscures or reveals BN ¢ T Background
the layer beneath it. A layer with 19 Opacity appears nearly transparent, )
whereas one with 100% Opacity appears completely opague. If you think of
these layers as sheets of acetate, you're essentially fading any work that you've
applied onto that acetate as you drop the opadity.

There are a number of great uses for this. It can be helpful for temporarily
lining up areas you've added to the image. Bring in eyes from another
image, for example, and you've got to guess where they go unless you drop
Opacity to something like 509%. Then you can easily see the detail behind
and reposition with the Move tool before pushing Opacity back up to 100%.
It can also be used to reduce the strength of an adjustment layer without
having to go back into its settings. Just below the Opacity bar you'll notice
a slider called Fill. This does the same thing as Opacity until you add a layer
style such as Drop Shadow using the fx button at the base of the Layers
palette. Dropping the Fill value reduces the opacity of pixels as per usual
but doesn't touch the layer style — a great way of controlling one without P it
touching the other. SR ey, : e =k

- =78 B

“A layer’s opacity determines to R P“
what degree it obscures or reveals et T GORER
the layer beneath it” S

Young at haart

11-
S
R iy Doc: 46.0M /46,00

, - _,...-"l-. .
L]
01 Add text layer 02 Write on 03 Drop Shadow
Here's an image we've turned into an antigue- Choose a suitable font (eq Cooper), colour and font [0 add a shadow effect to the text to help it stand
looking photo, to which we want to add some size from the Options bar, click where you want the  out, hit Enter then click the fx menu in the Layers
realistic text. Press T' to call up the Text tool. text and type. Simply click and drag to repaosition. palette and select Drop Shadow.
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The Opacity control

The Opacity slider adjusts the
opacity of the whole layer,
including any added layer

styles, such as Drop Shadow in
the case of our image.

F Urop Shadow

Backaround

The Fill control

. r—— : | ¥ The Fill slider controls opacity
| in the image too, however it
only drops opacity of any pixel-
based information on the layer,
ignoring any added layer styles.

Adding layer styles
You can apply a layer style by
clicking the fx button at the base
of the Layers palette. An fx icon
appears next to your layer to
indicate a style has been added.

=

Opacing: 205 + Opacity: 1008 -

e

L)

= B Filk o =
.1 - . T
| Young at heart Xy 5 . > | T | Youngathean
3 Effects : L3 Bffects

) Dwop Shadow . % Dwop Shadow

-l
""‘E: fackground

oAl

04 Shadow settings 05 Opacity slider 06 Fill slider

In the Drop Shadow dialogue, Angle is fine but we Next we need to fade the text to make it look [ime to try something different. With Opacity at

need to alter Distance to 20px. We use 15px Size to realistic. Dropping Opacity to 20% doesn't look 100%, we drop Fill to 0%, removing the text and

blur it a little and lower the Opacity to 509%. great, mainly because of Drop Shadow settings. just leaving the shadow. This does the trick nicely!
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Layers

hen people are new to Photoshop,
W‘chey often tend to head to the Toolbar

first. The Healing Brush, Dodge, Burn
and Lasso tools can certainly help you make
powerful adjustrments to your images, but to
unlock the full potential of Photoshop you need
to take a closer look at the Layers palette and
the options it holds. It is in this palette that you
will find the power ta stack several elements and
adjustments on top of each other, which can later
be combined into one final image, In order to tell
Photoshop how we want these individual layers to
interact with the others, we can use blend modes
and create exciting effects in no time,

A quick and easy way to IIT‘lpI’OUe overall image contrast

Soft Light is one of the most
useful blend modes for so many
different effects and outcomes.
It adds great contrast without
being as drastic as some of its
neighbours, such as Overlay or
Hard Light. One of the best uses
for the blend mode is to ensure
that your black and white shots
don’t look too flat.

Deeper shadows

When you use the Soft Light
blend mode you will notice that
the shadow areas become slightly
deeper and richer.

Sk B E i
i EY
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07 Duplicate the background

The first step is always to make a duplicate of the
Background layer (for safety) by dragging it to the
Create a New Layer button at the very bottom of

the Layers palette.
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|mpr0ve mOHOChrome ShOtS Blend for a qunck and easy way to add impact

Perfect your blend

Understand the blend modes in Photoshop

Multiply
A useful blend mode
that enables you

to make the image
significantly darker.

The Blend Mode menu i

The Blend Mode menu contains 27
different blend modes, some with
very dramatic effects, some with
effects that are very subtle, and
some producing effects that only
work when some other aspect of
the layer has been adjusted.
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02 Select Soft Light

you should select Soft Light
nu at the top of the Layers palette
ntly see a big difference in your
it a lot more impact.

fram the Bler
5 "'Ir[ s 0} |
image, giving

Soft Light

Another handy
blend mode for
adding contrast to
your images.

Screen

Screen is the exact
opposite of Multiply
and lightens the
image up with ease.

Two layers

Blend modes can
only be applied
when there are at

& |east two layers, so
== you have to drag

e your background
layer to the Create

a New Layer button
next to the trashcan
at the base of the
Layers palette.

Brighter highlights Crispness
Simultaneously, the highlight When you use Soft Light
areas get brighter when using the image looks crisper
Soft Light. It's this combination and sharper, appearing
of deeper shadows and brighter to have gained clarity
highlights that creates the high- and definition.
contrast appearance.
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03 Opacity

The Opacity slider enables you 1o reduce the effect
of the blend mode if it looks slightly too strong for
the image. Lowering the opacity can carrect this
quickly and easily.



BLEND MODES AT A GLANCE A quick look at what each blend mode can do

i -1 . '
Difference

Same mode,

different effect

It's always worth
remembering that while

this guide is handy as a

quick reference, the result

is completely dependent

on each individual image.
Inevitable factors such as the
colour and opacity of the layer
beneath can massively alter
the effect each mode has.
When it comes to trying blend
modes, the best advice is
always to experiment!
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02 Create a selection

Now, using the Rectangular Marquee tool (M)
located at the top of the Tool Panel, start to drag a
selection somewhere around the perimeter of your
chosen image.

-

‘ ENHANCED

all
Dwimlict K]

&l Layers KA
o Deselect Layers

Find Layers. LK r
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Load Selectian,..
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03 Invert the selection

Press Crnd/Crrl+Shift+ an your keyboard to invert
the selection - this ensures that it's the perimeter
of the image, rather than the centre that is
selected. You can also do this via Select>inverse,

Use Multiply for a
subtle vignette

This mode can darken your images

Multiply is perfect for overexposed shots and works
best when applied selectively to specific areas. One of
the best applications for Multiply is for creating a subtle
vignette around the corners of your shots.

01 Create a new layer

Again, begin by duplicating your Background layer.
Drag the Background down onto the Create a New
Layer button at the bottom of the palette.

Al CE
Deselect =0 ! &

Feather: i p R=ii- ahian]

[Raxbground cop

All Layers
Desplect Layess
Fingd Laveis

Cobar Ramgs,

Girow
Smilar

Transform Selection

Edif i Quick Mask Mode

Load Sedection..,
Save Selection_.

04 Refine the selection

Go to Select>Refine Edge. This will bring up a
dialogue box that enables you to feather the
selection so that the transition to the darker edges
from the lighter central area is smooth and subtle,

05 Adjust the Feather amount

Choose an appropriate value for the Feather. For
high-resolution images, you should opt for a pixel
value of around 204,
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06 Multiply mode

Mow select Multiply from the blend mode drop-
down on the Layers palette. This will darken the
whole image at this stage, but don't worry.

07 Add a layer mask

Now head to the bottom of the Layers palette and
click the Add Layer Mask button, which is the third
icon from the left.



ENHANCED

Unchanged
skin tone

We have left the model's
skin and the rest of the
image unchanged.

(8]

1 Begin the adjustment

pefore, you must begin by duplicating your
Background layer. This enatles you 1o begin
the process of applying very selective, localised

adjustments to the image.
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03 Behind the mask
Be sure to hold gown Opt/Alt on your keyboard
task at the bottom of the
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02 Select Screen

Lse the drop-down menu to select the Screen
blend mode. You'll notice the whole image will
ook far brighter and overexpaosed, but you'll soon

P T el Fine
:-hl i .jh-!:j-\"' 1} l""\ll"' ALY ':r_ TI.\, i_'_.

=T F
.rr_‘_,a
g

o

04 Brushstrokes

Press B on your keyboard to select the Brush tool

)
Set your Foreground colour to white at the bottom

of the loolbar. Paint over the eyes, ensuring that

the layer mask is highlighted in the Layers palette.

Use the Screen
blend mode for a
brighter view

Use this mode for beauty retouches

When you apply the Screen blend mode to a layer, the
whole image gets much brighter. Much like the Multiply
blend mode, this works far better when applied as a
local adjustment rather than to the entire image. Once
again, you can use layer masks to refine which areas of
the image are adjusted.

fl-'l—-_—.-_._
L

ir

/l ORIGINAL }

Bright eyes
Lsing the Screen blend mode

and a layer mask enables you to
brighten the model's eyes.
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05 Opacity matters

There's a fairly high chance that this effect

Wil De
i 1

too extreme, s go to the Upacity slider at the top
of the Layers palette and simply drag it to the left
ayer,

o reduce the effect of your Screen
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COLOR RANGE

Get complete control over
colours and watch as your
image transforms from
boring to vibrant in seconds
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Colour & tone

Colourin
Photoshop

Offset colour casts and enhance
atmosphere in your artwork

Ccaluur is an inevitable part of
photo editing and, as a result,
seeps into all parts of Photoshop
in some form or another,

Controlling it is usually done with the
Color Balance adjustment, which is best
for offsetting colour casts, but it can also
be used for changing colour to more
abstract hues for artistic effects.

The Color Balance adjustment is only a
small part of Photoshop. The best thing
about using Color Balance is it's non-
destructive. Here we show you how to
intensify the yellow and green hues in this
image of an insect in flowers.

You'll also find two swatches,
Foreground and Background, at the base
of the Toclbar for picking out colour and
using with tools and adjustments.

“The best thing about
using Color Balance is
it's non-destructive”
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Adjust colour

Color Balance as an adjustment layer
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07 Load adjustment (2 Set tone 02 Alter colour

To load the agjustment go to Layer>New For basic alterations, set the Tone option in the Tweak the other two sliders depending on how far
Adjustment Layer and select Color Balance. In the Color Balance adjustrment to Midtones. Start with off your colours in your image. As an adjustment
name dialogue box, hit OK and there should now the Cyan/Red slider. Slide it left to cool down the layer, the colours can be re-edited later on by

be a Color Balance 1 layer in your Layers palette. image, or push it right to warm it up. double-clicking on the layer's thumbnail.
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COLOR BALANCE ADJUSTMENT

The Color Balance adjustment presents

a set of sliders that work by adding and
subtracting quantities of colour. This is
helpful when the tone of an image isn't
quite right, such as when there's too much

— Color Balance

orange in an image that was taken indoors. C | ' '

Here's what the adjustment looks like and olor Levels: |-50 J l+ 40 ‘ -20¢

how it can be used. S C |

: Cvan T — C ance )

Colour sliders Y Red

There are six colours -

inside the adjustment. Mage nta e — CGreen g Preview

They work in pairs, and

when one colour is Yellow c:“ Blue

reduced the opposing

one is increased.

— Tone Balance —

Tone Balance l

The Tone Balance D Shadows e Midtones O Hig h"ghtfr

section of the ; .

adjustment is split into E PFESEWE Luminos 'W

Shadows, Midtones

and Highlights. This

aﬁfgcigg:;x& Adjustment location Color Levels -

image can be tweaked The Color Balance adjustment can be If you know the exact h

to perfection. found inside Image>Adjustments, as well amount of colour to adjust Add a swatc
as Layer>New Adjustment Layer. The latter in your image, enter the When you've found a colour you
option comes with a mask on its own layer. values under Color Levels. like, click the Add to Swatches

FOREGROUND & BACKGROUND SWATCHES

The Color Picker menu is where colour
for your Foreground and Background
swatches are set in place. From saturation
to brightness, it's all done here,

Change saturation

The strength, or saturation, of colour

is adjusted by sliding the picker left or
right. The far right contains the colour in
its strongest form, whereas the far-left
side contains less.

New and current
The current colour is shown
just underneath the new
colour being chosen, so you
can see just how they differ.

Choosing brightness
The brightness of a colour is
changed when the picker is moved
up and down the colour chart, with
complete black at the bottom and
the brightest tone at the top.

Hue

The hue of the colour is selected
by sliding the arrows up and
down the vertical spectrum.

| Only Web Colors

button to send the colour to the
Swatches palette. This palette is
found inside the Window menu.

S —
( Cancel )
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( Color Libraries—)
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Use the Hue/Saturation
adjustment to increase the colour

of the image a little and make it
pop further,

colour and tone

ometimes the difference between a good image and a great image

is in the colour and tone of a picture. If the colour and contrast really

pops, it can make your image stand out; it not, you mignt find your
subjects disappearing into the background.

Thankfully, altering the tone and colour is a straightforward edit that takes

a matter of minutes. Adjustment layers are the perfect place to make such
changes to your pictures non-destructively, and they're really easy to apply. In
Elements, by going to the Fill Layer icon - that little half-blue, half~white circle
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Use Levels to alter

e
" " 1%

Duplicate your layer, set to Overlay and
go to Filter>0ther=High Pass; choose
4px to sharpen a little.

in the Layers panel, just next to the Mask icon - you can tind a whole array of
adjustment options for injecting more colour and tone,

The advantages of editing non-destructively are numerous. By applying
Levels straight to your layer, you can't edit the sliders later, should you wish to
change anything. By using fill layers, you can not only tweak the stoppers in
your edit, but duplicate the adjustment to other pictures should you need to.

Levels are a key tool for tweaking colour and lighting, but the best thing is
that they require little work, but make a massive difference.




AdeSt the L@V@'S Tweak the tone and colour of your image by using the Levels
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Start off by going to the Fill Layer icon in the Layers panel. Choose Levels 02 Tweak the Red channel
from the drop-down menu and the Levels adjustment will be made non- 'he Red channel is the most important one in the Levels palette as it controls
destructively, meaning that you can edit it without affecting the origina the warmth of your picture. Choose Red from the Channel drop-down menu

picture, Slide the stoppers as shown in the screenshot above, and adjust the stoppers aleng the histogram as seen in the screenshot
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04 Finish with the Blue channel
03 Change the Green channel Finally, tweak the stoppers on the Blue channel to complete the picture,
'he Green channel should be adjusted so that it takes the pink out of the eqit, Simply adjust the middle one to fix the tone and the colour of the overall look;
but doesn't wash the image in green; use the stoppers as we have above, vou should be able to do this easily as the first two colour channels are the
g ; 8 ) )

sliding the middle one to the left, but about half as far as you did with the Red. difficult ones to get right.

Ta kE It fu I‘th@i’ Alternate adjustments for editing tone and colour

Brightness/Contrast Gradient Map Photo Filter

This adjustment is one of the simplest tweaks The Gradient Map is great for injecting a little I'he Photo Filter adds nothing mare than a quick

vou can apply. The Brightness slider s pertect for “olour into your work, Find it via the Fill Layer icon, overall tint 1o your picture. Though you can set it as
adjusting pictures that are too bright or too dark, and click on the gradient to edit the individual any colour, it's best used for aqading either warmth
and the Contrast slider can help create a stronger shades at different points along the gradient. Set to or coolness to your picture. Use the Density slider

contrast between darks and lights, Soft Light to apply subtly. to contral intensity.
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Colour & tone

Increase the saturation of the
yellow in your final picture by
opening the Hue/Saturation

palette (Cmd/Ctrl+U).

Duplicate your final layer, set to
Screen and go to Filter>Blur>
Gaussian Blur. Select 4px for a
subtle soft focus.

Experiment wit
selective colour

elective colour is a deceptively simple but extremely powerful taxis, or the pillar-box red of a famed English phone box, You might want to
technique for you to use in your photos. Stripping your shots bare of edit the shade even further, using Levels or Hue/Saturation tog; leaving just
everything but one shade sounds like an exercise to remnove the fun from  one colour left in your photo means that brigntness is often pDetter
your pictures, but in some cases it only accentuates excitement and makes for [here are plenty of technigues for mastering selective colour. It's a style
a more interesting picture, It can be used to brilliant effect to draw focus on an that you might want to use for all the colours of a specific object, or maybe
particular part of any image. you'd like to use this particular tutorial to practise skills for similar edits of your
You can use this technigque for any kind of picture, but it works best with own; this technique works on the same principle of simply highlighting certain
images that have a particularly iconic colour involved, such as these New York colours or even just blurring the background.
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Desaturate and CO|OI.II' Select, touch up and perfect the colours in pictures

07 Make a basic selection

Start by grabbing whichever Lasso tool you work best with, and make &
rough outline around the outside of the object or objects you wish to isclate
the colour of. We're going to leave nothing but yellow in this particular

icture. Ctrlfright-click and hit Layer Via Copy.

02 Refine your selection

Grab the Magic Wand

set the Tolerance to 25 and uncheck the
Contiguous option. Click on New along the bottom, and click over all the
shades of yellow until yvou've selected all of the yellow in the picture. When
done, hit the Mask icon.

{3 Touch up the colour

Duplicate the background layer and desaturate the colour by hitting Cmd/
Crl+Shift+U. On the mask layer, select a brush and using black and white,
touch up the edges of the colour in your picture to further refine the selection.

04 Adjust

Merge everything into one layer by hitting Crd/Ctrl+-Opt/Alt Shift+E. Bring
up the Levels palette by hitting Cma/Ctrl+L, and use the stoppers to increase
the contrast of the picture for a more cinematic shot.

Alternative mEthOdS How else can you achieve selective colour in Elements?

Replace Color

The Replace Color tool does exactly what it says
on the tin. You can use the eyedroppers to select
specific pixels in your picture, and alter the hue,
saturation and lightness of them with the bottom
three sliders. Turn the saturation down to -100,
and select all of the colour in the picture that isn't
your main hue, in order to create selective colour.

Brushes

It's really easy to apply selective colour with
brushes if you want to leave a few colours, as
opposed to one particular hue. On a new layer,
brush either black or white onto your picture, and
change the blend mode to Color. Opt/Alt+ click

tne layer s visibility eye icon to see that layer alone,
the layer's visibility eye icon to see that layer alone

and touch up accordingly,

] — |
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Smart Brush

If you're looking for the quickest possible fix, the
Smart Brush is able to create selective-colour
effects with just a few clicks. Select the tool and
choose the Reverse=Black and White option.
Simply select all of the colour that you wish to
keep and Elements will turn the background of the
image to monachrome.
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4 ¢ h' - :,. DR AR LR APS y : 4 4 g is a little intense, reduce the
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opacity of your layer.

BIGGER TOUCHES
With the Dodge/Burn Tool at
20% opacity, and with a big size,
touch gently for a more overall —

; . : - -
lightening or darkening. - o

<

e

What
does it mean?

NEUTRAL GREY LAYER - This is
the midpoint between black and
white. The Overlay layer will Screen
its lighter pixels and Multiply its
darker ones, so neutral grey appears
invisible, until you start dodging
and burning to darken and
lighten the layer, This is non-
destructive dodging
and burning.

b

Dodge and burn
your photos

Add lightness and darkness to your images
using this pair of tools

ontrast is key to good photography. The lights and darks in a picture latter does the opposite. They're two tools that together can
‘ don't just add interest to it; they can make your picture look deeper and control the contrast of your work, and even add a little more saturation
more dynamic. Contrast enhances shape and contour and without it to it; they're staples of photo editing, and something that every Elements user
your phota is often left limp and lifeless. should be aware of,
But while there are plenty of automated ways to add contrast to your work, Let's dive into how to use Dodge and Burn to control the contrast in a
one of the most reliable ways to do it is manually, Sure, there are ways todo it photo. While they're simple enough tools to get the hang of, there are certainly
with brushes, but that’s why the Dodge and Burn tools were invented. tricks that need to be remembered when it comes to using them in order to
Dodge and Burn are a pair of toals that are rarely separated, yet exist on get optimum results. Contrast is vitally important in your pictures after all, so
their own. The former is used to lighten the exposure of your shots, while the it's equally important to become an expert on how to apply it.

84 Photoshop for Beginners



DOdge and bl.l m Creatively add contrast to your photos with brush-style tools
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07 Create a neutral grey layer

Dodge and Burn can be applied straight to your layer, but we're going to add
it to a new layer to edit non-destructively. Create a new layer and fill it with
#808080 — neutral grey — and set to Overlay. This should make the |ayer pretty
much invisible in your project.
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{3 Dodge the image

With the darkness added, use the Dadge Tool to touch over the lighter
patches of the picture, such as the brighter stripes on the cat, the areas that are
hit by the light and the nose. Use a small brush to get all of the areas that need
maore precision.
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02 Use Burn

Select the Burn Tool and on the neutral grey layer, brush over the darker areas
of the image; in this particular photo, we're touching over the darker stripes on
the cat, as well as the shaded areas and around the eyes,

(4 Erase parts

The easiest way to undo parts of your dodging and burning, still non-
destructively, is to create a new layer and Alt/Opt-click to clip 1o the dodge and
burm layer, With a neutral grey brush, lightly brush over any part you wish 1o
revert to the original image.

Addll‘lg COI"ItI‘aSt Other ways to give brightness and darkness to your image

L A, . G

Gradient Map Levels
Perhaps the easiest way 10 add contrast 1o an
image, a Gradient Map adjustment can add black
and white to whichever parts of your image you
wish, simply by sliding the colours along the
stoppers. Set the adjustment to Soft Light or

Overlay to apply the effect green and blue channels.

One of the most obvious ways to change the
contrast is to tweak the stoppers on the Levels
adjustment to improve the light and dark in the
image. By using the Channel drop-down menu,
you can use the same stoppers to alter the red,

Shes [mei_ca=
Overlay
If you're locking for a quick cinematic finish, there's
a really simple trick you can use. Duplicate your
background image (Cmd/Ctrl+J), Desaturate

the layer (Cmd/CtrlShift+U) and set to Overlay.
Duplicate this Overlay layer a number of times for a
more intense effect.

R §
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Adobe Photoshop €56 Darken

Multiphy
Color Burn Sl
Limgar Burn

Darker Colar

Mavigator

Lighrern
Screen

Color Dodge
Limear Diodge {(Add)
Lighter Color

Overlay
Soft L:ghf
Hardisght

Vivid Light

LineagLight
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Subtract
Divide
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Saturation
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Amount: | 72 %

Radius: | 1.4 pixels

Threshold: _[J | levels
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loning is one of the most time-consuming, patience-testing tricks
that you can master in Photoshop, but like most things that require
skill and effort, the results can be absolutely stunning.

Cloning is often used as a very useful touch-up tool for photographs,

as it brushes over an image, using the original as a basis. It relies an the

Opt/Alt key; press on whatever area of the image you want to be your guide,

and then brush away over the image, replacing an area with another part

of the photo.
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Remove any unwanted
areas easily by using just
the basic settings.
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It can be used to heal blemishes or even just face-swap. It's simple enough
to learn, but there can be hours spent touching up vour photos once you've
mastered how to use the stamp.

Sure, it might take so much precision that you wonder halfway through:
would it be quicker to just set this sheep free from the field, and photograph it
again without the fence in the way? However, in the end, there are few things
more satisfying in Photoshop than completing a masterful clone. Read on and
learn some technigues and ideas to turn you into a cloning pro.



CIeanIy dél@te ObStI'UCtiOI'IS Erase fencing and more by cloning it out

i T

U1 Familiarise yourself with settings )2 Begin cloning

Along the bottom are the basic settings for the Clone Stamp. You can change Press Opt/Alt+click to select the patch you want to duplicate. Then simply
the Brush, Size and Hardness, and there’s an option to align or clone in a new brush over your chosen area. It really is that simple, but remember to choose
place every time. Choose 50% Opacity and a soft brush. This will allow you to an area of a similar tone and colour, 50 you don't create a jarring between the
touch up and be more accurate. clone and the destination.

= --‘u. = ;:ﬂ_: o
e ] fp— I,r--n--
{2 Clone strands (4 Watch for duplication
When cloning strands like hair or grass, make sure you clone them specifically To make your cloning look believable, make sure you don't leave obwviously
rather than cloning around them. Never clone up ta the edge of subjects or cloned parts of the image alongside where they've been cloned. If you've
strands, because then you create soft and unbelievable edges - clone real cloned a patch, clone over the original spot, atherwise the effect becomes
edges instead. really obvious.

Clone whole forests Swap fur texture .= Novelty effects

Trees can be hard to select, but why let that stop You can clone between S Rather than duplicating a photo, set a mask and
youl creating a forest? Simply clone one tree all pictures, Simply set the Opt/Alt option on one brush through the mask. Then clone with a big
over the picture by adding a new layer for each picture and then clone it onto your destination. soft brush and you can create quick yet effective
one. Then you can touch up using the Refine | ower your opacity and you can create incredible novelty features, just like the Bohemian Rhapsoady-
Edge toal, effects, just like this fur swap. style image we have done here!
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SOURCE FILE AVAILABLE

Sharpen your photos

We show you how to fix camera blur using the Unsharp Mask filter

you will have your fair share of images that aren't as sharp as you'd

like. Luckily, Photoshop and Photoshop Elements have a whole host of
tools to help you to correct this flaw. You can use the Sharpen filters (see the
Filters section of this book) or you could use the Sharpen tool to selectively
sharpen certain areas of an image for effect, however there is a quick and easy
method, which is what we are going to be looking at in this mini tutorial.

Whether you have Photoshop or Photoshop Elements you have at hand

a nifty way of dealing with blurring problems in the shape of the Unsharp
Mask filter. It seems strange that something called ‘'unsharp’ actually does the
opposite, but that's just one of Adobe's little quirks! It's easy to access the tocl
by going to either the Filter menu or the Enhance menu, depending on which
version of Photoshop you are using.

Camera blur is an extremely common problem, and if you are like us,

the tool

Click the Enhance or the
Filter menu, depending
on which version of
Photoshop you are using,
then select the Unsharp
mask option from the
drop-down list.

Dialogue box
This is the Unsharp
Mask box that pops
up, which has all of the
tools that you need to
sharpen your image
to perfection using a
selection of sliders.
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1 Open the command

In Photoshop, go to Filters=5harpen=Unsharp
Mask, in Elements go to Enhance>Unsharp Mask.
Make sure the little Preview box is checked.

()2 Set the Amount

This sets how intense the sharpening is
the right to increase the intensity. We have a bit of
work to do here with this image, so move it to 179,

You control the tool using a series of sliders in the dialogue box that comes
up, and the Preview window means you can see exactly what effect the edit
is having. It works by emphasising the object edges in an image, tricking the
eye into thinking that the image is crisper than it is. This transforms soft, blurry
images into crisper renditions of themselves,

We're going to show you guickly and easily how to use the Unsharp Mask for
yourself using a typical image which is blurred. We have provided this image
for you to practise on, but you may want to use your own.

“Transforms soft, blurry images into
crisper renditions”

Preview

Make sure that
Preview is ticked so
that you can see the
changes as you make
them on your photo.
The window in the
dialogue box lets you
zoom in closer to see
what's happening.

Amount

Experiment with the
Amount control to
change how strong
the effect of the filter
is. To keep it realistic
try and use the lowest
value possible for the
effect that you want.

()= The Radius

The higher the setting, the more extreme the
effect. We used 2.8. Threshold calms the edit down
but a setting of 0 was all that was needed here.

move 10
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Retouching

Improve shadows and highlights

Image adjustments are made easy with Dodge and Burn

he Dodge, Burn and Sponge tools are designed to edit exposure Let’s start with the Dodge and Burn tools, which are highly important
I and colour in an image. Being tools, rather than adjustrment layers or when it comes to creating digital art and making subtle but effective photo

filters, they give you a great deal of control and accuracy. They enable edits. The two tools reflect the traditional photographic technigues used to
you to choose the exact position and strength of the effects by painting them enhance lighting, with Dodge brightening areas and Burn darkening them,
onto the image. Adopting a brush as the main way in which you apply the You may have one subject in your image that has been under or overexposed,
treatments 1o your imagery, you use your mouse to add the effect wherever and that's where these two come into play. Lastly, the Sponge tool deals with
you need to, colour, and can be set up to add or remove colour to a subject.

" Shadows
'5\__\,' x | ?‘ |'| %Enmuwm Q"r | [;_"FPmtanms fg
-

| | J

. Bigisbetter A good range
Choose a large Size Use the Range selection
to cover more of in the Options bar to
your image at once, change how each tool
which helps to keep can perform,
changes subtle,

L

Control

With edits made to

a Background Copy
layer, blend modes and
Opacity can be adjusted
to control the effect,

L

i s

PDlemMaQkAS

] @ DodgeTool O
= & G BumTool O
@‘E-p-nnn-t Tool O

The three tools
The three tools are
grouped together with
the same shortcut key
of Q. Ctrl/right-click
over the icon to reveal
all three tools.
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U Burn tool
The Burn tool is used to darken parts of your
image, Select the tool from the Toolbar or by
pressing O on your keyboard. Check that you have
the Burn tool selected - not the Dodge too! - by
clicking and holding over the icon to view all
available options,
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Set the Range option to Midtones. Paint once more
over the background elements to add further
contrast. Try not to paint over one area too many
times, as the effect will get increasingly stronger.
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()2 Range

In the Options bar, there are three Ranges 1o
choose from: Shadows, Midtones and Highlights.
We'll only need the first two for the Burn tool.
Select Shadows and set the Exposure to 40%. Drag
the Background layer onto the Create a New Layer
button to duplicate it.
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05 Dodge settings

Grab the Dodge tool, which is used to brighten up
subjects. in the Options bar, set Range to Midtones
and set Exposure to 409. Paint over foreground
parts of your image to brighten them up.

Make CO'OUI‘S Sll"lg Boost colours with the Sponge tool
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07 Layers palette
Load your image into Photoshap or Elements.
Duplicate the Background layer by dragging it from
the Layers palette onto the Create a New Layer
button. A Background Copy layer will appear.
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() Tool’s Mode

Select the Sponge tool (C) and, in the Options bar,
set Mode to Saturate and Flow to 30%. Tick the
Vibrance box, Select an appropriate brush size for
your image and then set it to 0% Hardness.

OIS Change how the light falls in your images
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Set your brush size to a large, soft tip from within
the Options at the top. Paint with the tool over the
shadows in the background parts of your image. If
the effect is too strong then lower the Opacity of
tool. Use this sparingly over your image until the
shadows darken.
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See how much the lighting has changed by
clicking on the eye symbol of the duplicate layer to
turn it on and off. Alter the blend mode to Overlay
and lower its Opacity to 70% for more contrast.

{2 Paint saturation

Paint with the Sponge tool over the colour in
your image and you'll see the saturation increase,
adding more life. Don't overdo the effect, as noise
will start to gather and degrade the quality.
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Retouching

SOURCE FILE AVAILABLE

Adjust facial features

Retouch a subject’s face using Elements’ new slider-based feature

etouching is something that everyone, from photographers happening in real-time, and it's almost impossible to create one of those
Rtﬂ digital artists, has to consider. It is almost an art in itself, as infamous ‘Photashop fails” with this feature.

transforming a subject’s face with realism and subtlety isn't as easy Retouching is useful for all kinds of projects, but the best thing about
as it looks. ‘Photoshop fails’ are common on the internet, as retouchers the Adjust Facial Features tool is that it delivers quick, realistic results, no
often don't spot the background warping along with their subject. The matter what you want to achieve. If you want to increase your subject’s
Liquify tool is an advanced one, and that's what makes the Adjust Facial smile, it can help, just as if you want to renovate a face. Experiment with
Features tool more convenient. It consists simply of sliders, pinpointed at the sliders to see how they interact, and if you're feeling confident, use the
key areas of the face, which when tweaked, can alter the height, width Liquify tool to take your retouching further. Adjust Facial Features doesn't

and size of the eyes, lips and nose. It's easy to use, you can see your edits just create realistic edits; it can help you to discover the art of retouching.

Recolour the eyes
On a new Color layer, brush
50% opaque colour onto
the irises of your subject to
brighten up the eyes.

What
, does 14 mean?
LIQUIFY - The Liquify o0l s
“a well-known distortion tool, It
‘enables you to warp pbn:eIs, the
benefits of using it are that it can
simultaneously resize elements
in yourimage while filingin
 the blank spaces with other 4
~ pixels. Find it under 4
Fﬂtemﬂismrt.
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Reshape and retouch use siders w alter the look of your subject
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()7 Reshape the lips

Open your start image and go to Enhance>Adjust Facial Features. Here, you
can master the height and width of the lips, you can edit the lips individually
with the sliders, and you can improve the curve of the subject’s actual smile.

el

() Edit the eyes

Next, down the right-hand side of the window, click on the Eyes subheading.
Using similar sliders, you can tweak the height, width and general size of the
eyes; you can also change the distance between the eyes and tilt them.

e T il 1 T

(02 Retouch the nose

Further down the menu, the Nose options include sliders to alter the height
and width. Use these two sliders to subtly tweak the nose; the shape of the
nose will rely on the rest of the face, so feel free to retouch it again at the end.

Other I'EtOUChing Options Go a little further to improv
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Liquify

The Liquify tool can help to reshape parts of your
subject by dragging pixels across the image, We've
used it to touch up the ear here. Watch out for
warping in the voids of where you've just edited.
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{4 Finish with face shaping

Click on the Face subheading. Here, you will find options to tweak the width of
the face along with the forehead height, jawbone and chin height. These edits
should come easily based on the work you've made with the rest of the face.

Resize features

Select, Ctrl/right-click and choose Free Transform,
To resize an eye, hold Shift to keep the aspect ratio
of the selection; resize, grab the Spot Healing brush
(J} and brush over the edges of your selection.

e subjects’ faces
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Resize forehead

Resizing the forehead relies on the same principle
as resizing facial features, except you don't need to
retouch the edges of your selection. Keep resizing
restrained, as big edits will lock toc obvious.
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When you've finished using
the Perspective Crop, use the
ordinary Crop tool to actually
reset the focus of the image.
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Master
Pe pectlve Crop

Tweak the viewpoint of where your photo was taken with this too

ropping a photo is seen as perhaps the most basic adjustment straight rectangle from the uneven shape that you create, and distort

you can make. It's one that's often reserved for the end of the the image to fit across the new size. It takes some experimentation to

editing process, and it's something that can be carried out in a understand how it works, but by using the tool's grid lines, it's actually fairly
matter of seconds. But cropping can be creative too, believe it or not, and easy to tweak. If you've taken a picture of a building from lower down than
just because you're cutting the edges out of your picture, it doesn't mean is ideal - perhaps you were too close to it — then the Perspective Crop is
that you're not realigning the focus of it at the same time, The Perspective perfect. It can also realign the central focus or simply distort the buildings
Crop tool works on much the same principle, only it's a little more creative on a horizon for a fantasy look. Remember that the Perspective Crop tool
than your average crop. By creating a four-sided shape in the photo, you is just one modification that can transform your image, and that by using
can reset the sides of your image. Elements will then create a perfectly Crop and 5traighten, you can achieve the perfect balance to your photo.

96 Photoshop for Beginners



Realign your phOtOS Create the grid, edit it and apply the edit
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U7 Make your first line

Start off the process by selecting the Crop tool (C), and find the Perspective
Crop tool, which is in the bottom panel of Elements, Select this and make
your first line with the tool. This will be the starting point for creating a four-
sided shape.
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{2 Edit your shape

It can be hard to get the right perspective for your image first time. Luckily you
can edit the four points of perspective as much as you like, simply by dragging
therm elsewhere in the image. Zoom in to get closer and make sure that you
follow the perspective of everything in the image before applying.

| ey AR, WTE R

) Create the other lines

Once you've created your first line, repeat this three times to create a four-sided
shape that forms the new sides of the picture. The point of the Perspective
Crop is that it doesn't have to be straight; follow the horizon horizontally, and
any landmarks vertically to make themn straighter in the final image.
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(4 Straighten up

Once you've applied the four sides of perspective to the image, you may
wish 1o edit the final image a little further. Click on the Straighten icon at the
left-hand side of Elements, and by dragging it across the image’s hotizon,
realign the picture.

Addltlonal USES what else can the Perspective Crop be used for?

Centralise vertical distortion

Often it's difficult to take the perfect picture of a
building without getting too far away. It's natural
that your shots will be looking up at it somewhat,
but the Perspective Crop tool can fix that. When
you're creating your four sides, be sure to keep the
horizontal sides straight, and simply tilt the vertical
ones to follow the sides of the building.

Create surreal caricatures

The Perspective Crop tool is useful because the
finished results look subtle and natural, But by
taking the tool to its extremes, you can change
how natural your final image looks; simply
experiment with where you place the four points
of the tool, and you can create surreal images that
don't follow the laws of physics.

View front-on

Just as you can correct vertical distortion, the
Perspective Crop tool can also do a good job
horizontally. This is particularly useful for any scenes
that you've taken from an angle, particularly if
you've taken a photo of a painting that youd like
to view from the angle it was painted at. Keep the
vertical sides straight and alter the horizontal sides.
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Master the Content-

TRANSFORM ON DROP - This
command lets you transform an object
before it's placed, it's good to get in the

habit of keeping this box checked, as
there are often tweaks that you can
make toa subject, even if you don't
wse the resize handles every time
youl use the Content-Aware Fill
Miove toal,

ORIGINAL

Aware Fill Move tool

Use the power of content aware to fill in the blanks on your artwork

hen you're turning a sketch into a digital masterpiece, or
building a composition from existing photos, Photoshop is
fantastic for creating something out of nothing. But it also has
a set of tools that can do the opposite; taking a complete photograph and
magically remaving an object or subject from the picture.
The Content-Aware Fill command is similar to the Clone Stamp; it covers
a patch of your picture with a patch from somewhere else to seamlessly
cover over something. It's most commonly used by Ctrl/right-clicking and
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selecting Fill - it's available on the drop-down option that appears - but
also comes in useful when you're moving objects in your picture.

Content-Aware Fill Move combines the intuition of the Content-Aware
technology with the Move tool. It's great for touching up a portrait, but can
also handle bigger edits, like moving a subject to a completely different
area of an image. It's a versatile tool, and one that's been improved further
with the Transform On Drop checkbox from the CC 2015 update, so let's
explore how to make a quick but ambitious photo fix with it.




]
Move and fill verqe the power of two Photoshop tools into one

07 Make a seiectiun

Start off by selecting what you want to move in your image. Grab the
Polygonal Lasso to select with, as you don't want to be too precise; the
Content-Aware Fill Move tool feathers greatly, so it's important to leave a big

enough area around the subject.

{2 Move your subject

Once you're happy with how you've primed your tool and selected your
subject, drag it to wherever you like in the image. Photoshop helpfully
provides a pink line once you've dragged to the centre of the image; simply

double-click to drop the image.,

Transform on Drop us: cc checkbox for even more possibility

U1 Make a selection

As before, select whatever you want to move in
the picture. We've chosen to use the Rectangular
Marguee this time, but the Polygonal Lasso works
just as well. Check the Transform on Drop box.

(4 Clone to finish

It's rare that you won't be able to notice a moved subject; you can often tell
at its edges, 50 it's important to tidy everything up. Select the Clone Stamp
with an Opacity of 50%, a soft tip and just gently touch up 1o remove any
inconsistency in the image.

)2 Move and transform

Move the object that you ve selected, just as
hefare, and use the corner handles of yvour
selection to resize It. You can skew your selection
too, by holding Cmd/Ctrl and dragging.

U2 Alter Structure and Color
Once selected, grab the Content-Aware Fill Move tool, Across the bar at the

top, you'll see options to adjust Structure and Colar. This will handle detail and
colour inconsistencies; slide to 7 and 8 to cut down the amount of cloning you
have to make.

{J= Clone

Clone around where you've dropped the object
with a 50% opaque, soft brush to hide notic
edges. Here, clone over the now bigger waves to

hide the fact that they've been transformed.
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hotoshop Elements Editor File Edit

IAdjustments

Image Enhance Q¥ICIM Select Filter View Window Help

New » I

Duplicate Layer... Quick

Delete Layer
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x RS34523_Haoliday Photos Export 2 90.jpg @ 100% (RGB/8)

Rename Laver...
Layer Style

New Fill Layer
New Adjustment Layer Levels...
Layer Content Options.. Brightness/Contrast...

lype > Hue/Saturation...
Cradient Map...
Simplify Layer Photo Filter...
s TN Layer Mask > Invent...
Hue/Saturation (oo e Create Clipping Mask %G Threshold...
Posterize...

Arrange

E R vage... I

Hue: +20

Merge Down

Catursl 3 Merge Visible > 3E
= = Flatten Image

+20

Lightress:
ﬂ
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255°/ 285°
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MAKE DRAMATIC
CHANGES

Inject bolder colours and better
contrast, resulting in creative effects,
but without damaging your original
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THE POWER
OF LAYERS

Learn why you need adjustment
layers for non-destructive edits

Preset: | Custom

Channel: @
s

- (A
Input:

A |éi i & & A2 [ Show Clipping

@ Curve Display Options

Show Amount of, ) Light (0-255)

() Pigment/Ink % -

Show: E Channel Overlays E Baseline
W Histogram M Intersection Line
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SOURCE FILES AVAILABLE Multiple adjustments
- = Stack multiple adjustments as a finishing

. touch for your compaositions to focus on
) anything that needs fixing.

does it mean?

“" " FILL LAYER - If adjustment layers are

what we use to adjust our work, fill
layers are used to fill colours, gradients
and patterns on new layers to overlay

our work. They're also found under

the Fill Layer icon, and can be used

for applying more colour effects
on your pictures.

Get to know the
adjustment layers

i
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Master the quick tweaks of Elements and improve your images

ometimes photos don't need a full-scale edit, they just need a and the adjustments are Brightness/Contrast, Gradient Map, Hue/Saturation,

little adjustment. And that's the thinking behind the adjustmenits Invert, Levels, Photo Filter, Posterize and Threshold. Each of thermn focus on

in Photoshop Elements: they are there as a final step to tie your different aspects of photo editing, but they can all be combined to get the
compositions together, but they're also useful for quick tweaks that you might perfect finish for your image.
want to make to your photos, such as a little maore brightness, tone control or a As you become mare confident in Elements and the projects that you take
slight recolouring. on become more ambitious, you'll find that the adjustment layers are still some

Located under the Fill Layer icon - the little half-blue, half-white icon you see  of the most-used tools in your workflow. So let's take a look at them all one by

next to the mask icon — there are eight big adjustments listed alongside three one, explaring exactly what it is they're capable of doing, and when you might
fill layer options. The fill layer options are Gradient Fill, Color Fill and Pattern Fill, find them useful in your work.
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GEt adJUStlng Check out the eight adjustments that can enhance your images
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017 Brightness/Contrast

Brightness and contrast are key factors for altering either bright or dark photos.
The adjustment consists of two sliders; Brightness affects overall exposure, and
Contrast makes a bigger difference between the lights and darks in an image.
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| Colerize
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03 Hue/Saturation

The Hue/Saturation adjustment deals with hue
(the specific shade of colour), saturation (how
vibrant the colour is) and lightness (how bright or
dark the colour is). Use it either to edit the whole
image, or alter specific shades within your images.
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06 Photo Filter

One of the more basic adjustments on offer,
Photo Filter simply adds a touch of warmth,
coolness or just about any tint of colour to your
image. It consists of the one Density slider and a
drop-down menu to choose your shade.
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02 Gradient Map
The Gradient Map adjustme
image, Select colours, align thern along the map, and they w
lights and darks. This is a great adjustment for recolouring, or just altering tone.

04 Invert

nvert flips the colour of the pixels in your image
o the complete opposite of what it looks like;
anything white will become black, for example.

This isn't one of the most useful adjustments, but

t's a cool novelty effect nonetheless

07 Posterize

What looks like a Filter Gallery option, the Posterize
adjustment reduces the number of colours in your
image; it's another adjustment of one slider where
you can define how many levels it has, for a more
cartoony look to your work,

it makes a map of the lights and darks across an
jill replace the
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05 Levels

The Levels agjustment deals with tone, by
displaying a histogram of your image and stoppers
to adjust the tone. You can either focus on overal
tone or use the drop-down menu to alter the Red,
Blue and Green channels of your image.
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08 Threshold

The Threshold adjustment is similar to Posterize,
only it reduces your image to black and white, Use
the slider to toggle the balance of black and white,
and use it either for a novelty effect or as a way to
select the dark or light tones in an image,
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Improve exposure S it
and contrast

often used when talking about
overexposed images. It is when the
bright areas are so light that they
merge together and lose detail, It

No Curves? No problem. Elements has plenty of S e e
1 | I 1+i unfortunately you can't restore
built-in solutions for image editing i el

oth Photoshop and Photoshop Elements

offer a range of tools for improving the

exposure, contrast, colour and tone of your
photographs. A good place to start fixing these
things is usually the Levels command, which works
in the same way in both programs, editing three
points in your image.

However, in Photoshop there is also the Curves
command. This is an incredibly precise tonal
control, giving you 14 points to adjust, making it far
more powerful than Levels. It does have a steeper
learning curve (if you excuse the pun) though, and
it can be intimidating for beginners to get to grips
with how it works,

Photoshop Elements doesn't have Curves,

There is a similar option under Enhance=Adjust
Colors>Adjust Color Curves, which enables you to
improve the colours in your images by selecting
from presets and adjusting sliders to change the
curve. This anly offers three points of adjustment,
however, the same as Levels and targets colour
tone. Also, Levels can be applied as an adjustment
layer, whereas Color Curves can't, soitisa
destructive process (always work on a duplicatel).

Owver these pages, we will look at ways you can
improve exposure and contrast, without the power
of Photoshop's Curves.

Full tonal range
The sky was all midtone in the
original, which made it look
dull. Highlights help make it
more interesting.

More detail
One advantage of improving
exposure and contrast in an
image is that it helps draw out
detail, such as this boat texture.
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USE Elementsf qUiCk ﬁ)(es If your image needs a boost, let Elements do the hard work
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07 Control Exposure

In Quick mode, the first thing that you can try is

the aptly named Exposure fix from the left-hand
mend. It is easy to use, as you simply go through
the thumbnails and pick the one that is best fol

your image. You can fine-tune using the slider.
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02 Work with Lighting

The Lighting option is a great way to play with
the tones of your image without having to use
the Levels dialogue box. You can again pick from
the thumbnails, but you can target the Shadows,
Midtones or Highlights separately.
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03 Use Auto controls

In the Lighting tool box are buttons for Auto Levels
and Auto Contrast, Access these from the Enhance
menu, along with Auto Color, Automated controls
analyse images and edit to improve exposure/
contrast without you having to do more than click.

Fix underexposure

An underexposed image has tones that are too dark. A quick fix for this is to
open the image in Photoshop Elements in Expert mode. Duplicate the layer
(Crnd/Ctrl+J), then set the duplicate’s blending mode to Screen. Adjust the
Opacity to suit.
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Adjust Color Curves

We mentioned the Adjust Color Curves option in our introduction, and while
it's not as good as Levels for exposure and contrast, it is great for improving
colour tane across your image. Pick from the available presets and then fine-
tune with the sliders to achieve the effect you want.

Fix overexposure

Overexposed images are usually too light. You can fix this in the same way that
we fixed the underexposed image, except that you set the blending mode

to Multiply. It's difficult to hide blown highlights, but for mild overexposure, it
works well,

-.umm—:l AT

Smart Fix

We haven't mentioned it yet, but Elements’ Smart Fix is designed to improve
your exposure, tone and colours in one click, which is a great place to start!
Simply select the option fram the Quick edit mode menu and pick a thumbnail
or hit Auto to process your snap.
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QUICK PHOTOSHOP TIPS

Curves window

B This is where the action happens. This
window graphically represents the pixel
information in your image. The curve runs —

from the bottom left, which is where the
dark pixels occur in the image, through

The Curves tool is a powerful feature that e rilinn e e thetigiright whict
! represents the highlights, the light pixels.
vhen properly applied can transform Moving the curve upwards makes the
- image lighter, moving it downwards
contrast, colour and tonal range makes it darker.
Cu
he Curves tool in Photoshop is deceptive. To the Photoshop =
beginner its graph-like appearance can be intimidating, bringing back | e W =
memories of early maths lessons. However, it's a powerful tool that can Channel: | RGB |4
be used to adjust tonal ranges, change colour levels, alter exposure, boost r S =, a
contrast and even create some less conventional photo effects, i o
Although the Curves tool is not as intuitive as some of the other features /
in Photoshop, the basic functions are simple, and dramatic results can be /
easily achieved. We have had a lock at it in the Colour & tone section, but P i (Options... |
this tool really comes into its own when applied as an adjustment layer. In s
the Layers palette, hit Create New Fill Or Adjustment Layer and select Curves. o Frevey
Adjustment layers let you make changes without degrading the original. It /
also means you can continue to edit a Curves adjustments by double-clicking
the adjustment layer. If the changes aren't wanted, you can revert to the .
original by deleting the layer, {;:m""
In this tutorial we will demystify the Curves graph, and in doing so show ——
how you can make practical improvements to your images. We'll look at ‘:'npur
understanding the graph and at exactly what happens as the line changes o I # %[ ShowClipping
shape. We'l reveal tips and tricks to make editing your image quick and easy. '
We will also look at editing the colour channels to recover and boost lost (] Curve Display Options

colour. The Curves tool has many more facets than might at first be obwvious,

" - Show Amount of: E’J Light (0-255) :
and we'll introduce you to as many as we can on these pages. i &

() Pigment/ink %

Show- Eﬂﬁhannel Owerlays !ﬁﬂauline

“The Curves tool has ma ny & Hstogeam 9 intersecion Uine
more facets than might at
first be obvious”
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01 Try in mono 02 Colour channels 03 Using channels

Iry using Curves on black-and-white images, as the Curves allows you to edit separate channels. When Moving the curve upwards increases the red in the
final image corresponds to the info that Curves use:  a channel is selected, the curve artects the density image; moving it down increases the cyan. The
shadows (black), midtones (grey) and highlights (white), of the colour, eg red and its opposite, cyan, Color Balance tool uses the same principle too
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04 Crazy results

[0 avoid the crazy effects make sure there are no
flat spots. These occur when the curve follows a
horizontal line across the graph.
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05 Rule number two

The second way 1o keep images natural, is 1o
make sure that the curve doesn't go beyond the
horizontal to create a downward curve,

r Channel

This drop-down menu allows
you to select which channels
to edit. You can edit the master
(labelled RGB or CMYK etc) or
individual colour channels.
When editing individual
colours, the curve affects

the selected colour and its
opposite colour.

Bezier/Pencil tool
There are two ways of
changing the path of the

curve. The common way is to
use anchor points to create a
smooth Bezier curve; this makes
it easy to get consistent realistic
results. The Pencil tool allows
you to be more creative and
get some interesting effects,
but the results are hard to
reproduce accurately.

| TR Eyedropper tool
; Use the left-hand Eyedropper
tool to set the dark pixel limit,

and the far right Eyedropper tool
to set the highlight limit. The
middle Eyedropper tool can be
used to alter the colour balance.
Experiment with these to find your
optimal settings. The beginner
however, may wish to leave these
and adjust the curve manually.

Preset. | Default

'l - I
—_ Channel: | RGB N ——  \ Cancel )
Input Levels: :'. ﬂil-.liu )
fﬂptl-uni... ':l
‘ FRr
Tttt 1| |

.!||||||| HEHET I '"|| 2 Preview

a | |1.00 |255

Dutput Levels:

[

& )

o | 255 |

06 Quick reset

Hold Opt/Alt and the Cancel button will change to
Reset. Hit this and the curve reverts to its original
settings. This works in most PS dialogue boxes.
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|
Use Black

Using Presets

et There is a list of Presets for every
I adjustment layer available. You can
simply click on any of these to instantly

apply them to your photos. You can also
Get creative with your colour photos see the Presets as a drop-down menu at

the top of each adjustment’s individual

by adding a little monochrome dialogue boxes.
magic — we show you how!

this is due to the fact that it works with almost any kind of image.
Portraits, landscapes and abstracts in particular, take on a whole new
feeling when they are turmed into a monochrome representation. .

Of course, there are always exceptions. Images need to have a good S
contrast between the light and dark tones, as you would otherwise have a =
great expanse of grey that's just not overly appealing. H 7

Using the Black & White adjustment as an adjustment layer gives you
endless control over the conversion of your photos. As well as a whole host
of Presets that give you instant results, you can target each channel that
makes up the image independently. It takes a bit of getting used to when
you're playing with the Reds in a black-and-white image, but each colour
looks different in mong, so it is worth playing with your images to see how
they can be adapted.

As well as using the sliders, there is a little hand icon with a double-ended
arrow underneath. Click on this icon, then click and hold on an area in your
image that you want to adjust. Photoshop will determine which channel is
most prominent in that specific area and as you slide your mouse back and
forth, the relevant slider will go up and down toc. A really convenient and
easy way to ensure that the tonal range of your black-and-white images is
as close to perfect as possible.

Black-and-white photography has always been popular. Perhaps

“Images need to have a good
contrast between the light
and dark tones”

. Evlls L- ¥R

Crente p v Wacic & Whrie sdurmesend Lger

07 Option one 02 Option two 03 Presets

You can click on the black and white circle icon If you have C54, C55, €56, or CC then you can use The Presets are a good place to start, so go

in the Layers palette ta quickly apply the Black & the Adjustments palette instead. The Black & White through all of them and then find the one that
White adjustment layer, adjustment is the half-black, half~white square, best suits your image.
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Perfect mono

There are so many methods
that you can use to turn an
image from colour to mono.
But for the best results, this
adjustment layer gives really
good control.
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Theright kind

of image

Not all images will look good
in black and white and that is
why it is so good when using
adjustment layers. You can see
in a second whether or not the
adjustment looks right, then
you can tweak or delete as you
need, without harming the
original colour photograph.

04 Customise 05 Precise control 06 Check the edit

Now you can start tweaking the sliders to get the [here is a little hand icon here, which you can use Using the little icon shown in the screenshot, you
right balance of ‘colours’ in your image. Trial and to click on a part of the image you want to edit and can click to see the image before its conversion to
error works best here, then slide along your image to adjust compare the result with the ariginal.
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Use the
Channel Mixer

Bring colour to your ni
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iNnstantly dramatic E;‘?!hfi.{.‘u

1t photos for
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shot taken at night is often problematic when printed.

However, as long as there's some sort of light source in the

original scene, you can dramatically improve the photo by
using a few creative editing technigques. By re-creating the look of
infrared photography, we'll use filters and colour channels to turn
an everyday image into something eye-catching.

We'll be using adjustment layers for non-destructive edits,
specifically the Channel Mixer, to adjust how much impact each
individual tone has on the image. We'll also be incduding a few
different layer blend modes to experiment with interesting
effects. However, the results you'll get with this effect depend a
lot on which type of photo you're using.
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07 Duplicate and invert colours

We provide the above image for you to download
and orac tise on, or YOU Caln 5€ lect a persona mage
to experiment with. Hit Crma/Ctri+) to duplicate the
main image

AT LT B

02 Apply blend modes 03 Muve tn the Channel Mixer 04 Balance the cnlnurs

vert the colours of the duplicate layer by hitting Create a New Adjustment Layer and select the Apply Color Balance (Cmd/Ctri+-B) and for Shadows
Cma/Ctri+ and set the blena mode to Color. You { 5::‘?:“"|r"-| Mixer I"| the box, change the Red Output Ise Red: -10, Blue: +10 anag -T:!':'=|-"."|: 0. For Highlights
can preview the complete effect of this inversion _hannel to: Blue: +100; the Blue Channel to Req: set Red: -10, Green: 410 and Blue; +10. For Midtones
by activating and deactivating the eye icon. +100 and the Green Channel to Green: +90, set Red: +10, Green: -10 and Blue: +10,
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“As long as there’s a light source in the original
scene, you can dramatically improve the
photo by using creative editing techniques”

05 Apply Hue/Saturation 06 Boost the vibrancy

Insert 2 Hue/Saturation layer (Crmd/Ctrl+U). Under MNow in order to boost the vibrancy, you need to
the Red channel set Hue: +0, Saturation: +14 and add a Vibrance layer to the image, adjusting the
Lightness: +40. Under Magenta, set Hue: +20, Vibrance slider to -20 and the Saturation slider

Saturation: +30 ang Ligntness: +20. below it to +10.

88 8 4 78 88 w8

07 Duplicate and merge layers 08 Tweak shadows and highlights
Select all your adjustment layers, as well as the For Shadows set Amount: 30%, Tonal Width: 60%,
inverted colour layers, and duplicate therm. Now Radius: BOpx. For Highlignts set Amount: 2096, Tonal

select all these duplicated layvers and merge them Width: 309, Radius: 30px. For Adjustments, adjust

s iy s - e~ . T = 1% e A 1
(Crna/Ciri+E) Color Correction: +20 ana Miatone Contrast: -10.
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09 Add some drama 10 Use the Photo Filter 17 Vector shapes

Duplicate the merged layer, but lock the origina G0 o Adjustment>Photo Filter, then in the dialog Now select the Custom Shape tool, With white and

A = PR e '.-..i"l,.._ | s A | |-. s 5 | | i i B Ll {0 ||‘_. T |“~._..' F B 711 ~re- 1 i SR S e | A C s e
iayer. ApplY a Rign Fass Titer with a 1U-pixel Radius, select vvarming riiter (o) and keep the Lensity #2011, Create various snapes using the presets

then change the layer to Overlay blend mode with by default at 25%. Select Preserve Luminosity and Circle Frame, Circle Thin Frame and Boom 1 & 2.
Tty

100% Opacity. Now merge these two layers. click QK. Feel free to add other shapes as you see fit.
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IAdjustments

SOURCE FILE AVAILABLE

Edit photos with Hue/Saturation

Do more with this dialogue box by using it as an adjustment

layer when editing image colours

hotoshop offers many different ways to control colour and tone
in your images, but one of the absolute best is the Hue/Saturation
command. Found under the Image=Adjustments menu or applied as
an adjustment layer, the Hue/Saturation command allows you to alter the hue,
saturation and brightness.
You can apply the changes over an entire image or target specific colours.
it is this level of control that makes the command so powerful - if you have an
image that's basically okay but one shade is letting it down, you can target the
colour and improve it
You control the edits by either moving sliders or entering numbers. There
are three bars that control the hue, saturation or lightness, and these are in
place whether you alter an entire image or just specific colours. You can also
use the command to create monochrome and duotone effects, opening up

—
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the creative possibilities even more. We're going to look at all the controls
in these pages and show you how they can be used to create perfectly
coloured images.

As we're looking at adjustment layers, make sure that you use this method
to apply your Hue/Saturation command, as you can make as many changes as
you like without harming the original photo at all. You can try this out with any
image to get used to the controls,

“You can apply the changes

over an entire image or target
specific colours”

Mg Mt uratian

Canel

Sarerafian - B | Saturakion:

Saluration

Lig=nrane Light mess

Lightess:

E i bl L

07 Assess the problem 02 Blue sky

Have a look at the image and work out what needs
doing. It might be that using the sliders on the

[ ] g ' ' ]
Master setting will work.

S ot oem

Lighiness

Cobpriges
Ll (=L £°1 165°. a of Prosiew

e

By selecting Blues and moving the Hue slider, you
can improve the colour of the sky. Moving the
Saturation slider right also brightens things up.

—_——
Calarize
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03 Not so mellow yellow
We want striking vellow flowers. This calls for
Yellows 1o be set as the colour range. Moving the

Hue slider left brightens things considerably.

Hues (aburation

Presei: | Cuziom '
Load Preset_..
ellows

Hu#

Saturation

Lsghimexs

Calarips

rsry 1080 M 2 2
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————— e

04 Boost some more
It's time to boost the effect even more. This
nvolves moving the Saturation slider to the right.

VA = Ehtrade ol (55 el X oA oy, L PRy P P (e B
We also moved the | gntness slider to the ngnt.
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05 The final touch

I he other colour that needs attention is green. It
just neads the Hue and Saturation sliders to be

moved to the right for the effect to improve.

»
06 Save for a rainy day
If you have a collection of similar-coloured images,
it's worth saving your settings. Click Save, name

your settings and then save. Use Load to retrieve.



QUICK PHOTOSHOP TIPS

It's a good idea to use a Hue/
Saturation adjustment layer
because then you know the
original is safe and you can go back
and edit it at any time.,

e =

Preserve the original OR

RIGINAL

S,

n: .ﬂ
__—
s: 0o
_____ __ Colorize
135°\165° M ¥ ¥ ™ Preview
e — : ;
Slide edits
Control the Cﬂntrc.; how the Hue/
Saturation dialogue works
Eha ;im?:; EI;Sa by using these three fields.
: You can enter values to
S?fgrazﬂéﬁ'&m; ':: make edits, but the best
E ow far you can tweak way is to move the sliders.
it. By moving these Hue/Saturation
parameters, you can
incorporate more hues et: | Increase Saturation i,
than set by default.
Master -
Hue: |0
Saturation +10
Preset tones g ===
Lightness; 0

In addition to editing the

entire image, you can select
preset tones from this menu
and concentrate just on one

colour. This makes image o — -

editing far easier.
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017 Colour grayscale

If you have a grayscale image, begin by going tc
Image>Mode and pick RGB. Open up the Hue/
Saturation dialogue box and tick the Colorize box.

Lot s

02 Colour images

If your foreground and background colours are
black and white, the image will tint red. If not, it'll
|

~=a e e i s e F e ! =~ s ar
\ave the hue of your foreground colour,

ENHANCED

[ 3
03 Colorize
With a colour image open, hit Colorize. Your image
will take on a duotone look, which can be altered

- T — | ~ =03 —_
by moving the Hue slider,
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Rafine Edge

Yiew Mode
Show Radias [J)

Wiew: S ™

_| Show Original (P

Edge Detectlan
|| Smarn Radius

Radiug: = Jr——

Ad|ust Edge
Smooth: 6 —

Faathar: [

Contrast: = —

o
Ml

Output
[ Decontaminate Colors

Cutput To: | Selaction

|| Remembear Samngs
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If you want to save a selection to
use over again, create a new layer
and hit Mask. Now, it's there to
select again later if you need.
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aking a selection is often the most time-consuming part of a
project. If yau're anything like us at Photoshop Creative, you spend
hours meticulously tracing your edges over and over again to get the
right cutout, before tweaking with Refine Edge, and even touching over the
mask with a brush. It's a case of trial and error, working and re-working your
selection to grab exactly the right pixels.

There are plenty of selection tools that can do the job, though, and with
the latest version of Photoshop Elements, Adobe added another. The Auto
Selection Tool is designed for speed and ease, with intelligent measuring of
the edges just by loosely clicking around the outside your object. It's a good
way to get a really thorough selection without having to spend as much effort
tracing the edge, and it's really easy to use. What's even better is that you can
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use ary kind of

selection tool with

the Auto Selection,

whether you're someone wWho uses

marguees or lassos, this is a tool that can aid anyone.

Selecting is something that pretty much everyone needs to learn at some
point or another in Elements tog; there's barely a project in which you don't
need to isolate an object from a scene. You'll probably use the Auto Selection
as an alternative to Quick Selection; it's still not the most thorough of options
but it's more than capable of providing a decent result.

Let's dive into how to use this tool, and take the effort out of a key part of
your Elerments workflow.




Stl‘aightening I.lp Grab pixels easily with a quick drag

e |
S O0E CoRR:
R Y C
ProtoSin Teol Oolioms  Undo  Ffsdo Mot Layos Crganie
Ul Choose your tool U2 Make the selection
Click on the Auto Selection Tool on the left-hand side of Photoshop Elements. Use your chosen selection tool to make a rough outline around whatever you
You'll see four options: Rectangular Marguee, Elliptical Marguee, Lasso and want to select in your image. We went for the Lasso and were sure not to trace
Polygonal Lasso. Choose one of these to make your selection with. right up to the edges of the car, as to allow for the Auto Selection to work.

i ;
r"-;f_':-'...'_ﬂ'-:-.-.-'._'- P

(4 Refine Edge

(3 Perfect the selection To improve a selection, use Refine Edge to smooth, feather and touch-up

Auto Selection will then do its thing, and select other pixels of similar colours edges. This can help iron out some of the more jagged edges of yvour selection.
near to the selection yvou've just made, Of course, this isn't foolproof; select an The Refine Edge box is located in the bottom bar of Elements when the Auto
ordinary Lasso and select more or less in the selection to get it just right. Select tool is in use,

Other SG'ECtIOI‘! tOOIS Which other features are best for picking pixels?

- O | i
2 .

FOR e
T_L'lr - Ti-E . . [ =
Magic Wand Quick Selection Selection Brush
The Magic Wand doesn't quite work on fairy dust, This is a simple drag-to-grab feature. Its main This works in a similar way to an actual brush: you
but is pretty adept at selecting pixels of a similar advantage is its speed - as the name does suggest draqg it over an area 10 select pixels, and it will not
colour, The Tolerance slider can pull either more - and it's an efficient way to select whole objectsin  select anything that the brush doesn't touch. Alter
or less into its orbit. Check the Contiguous box to Flements before you perfect these selections. Alter the Size and Hardness to be more precise when
select colour across the whole image. the Size for more accuracy. you select,
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I Selections

-

Add a background

" This technique is great for
selecting subjects, ready to place
onto new backgrounds.

What
does it mean?

FEATHER - Feathering an image
simply softens the outside of it. By
choosing a bigger Radius sﬂmng.
you'll have a softer image; the feather
will apply itself to the whole of the
image tog, so you won't have to
edit certain parts of the picture.
The Feather is useful for out-
of-focus selections.

SOURCE FILE AVAILABLE

Master the Quick Selection

Achieve fast precision when you select with this vital tool

If you're editing a photo, selections can determine how good the finished  comes to selecting, it's a tool that relies on the others around it to get the best

picture looks. The better your selection, the more realistic your photo results. Using the Quick Selection alone isn't enough for the cutout. You'll need
appears, but of course selecting takes time and with so many more exciting to employ the Refine Edge feature 1o smooth over your results, and the Lassos
things to be focssing on in your image, why bother with the baring part of are perfect for adding and subtracting from your selections.
cutting images out? The Quick Selection tool is the simplest of the selection tools to use,

That's where the Quick Selection tool comes in. It can shave time off the however, it's not necessarily the easiest to master. Creating a good selection
task of selecting. It works a bit like a brush: use the values and sliders to tailor with it requires a lot more skill and patience than you might realise, Getting
the tool and then drag it across the area you want to select. used to how it works is definitely worth it, though, because it saves you a lot

Although the Quick Selection tool is famously speedy at cutting out of time in the long run. And after all: the better your selection, the better your

subjects in your photos, and though it does have a degree of precision when it final image.
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SE'ECt With Speed Drag over your image and refine your selection

{7 Select the brush size

Choose the Quick Selection option from the left-hand toolbar, or hit A. Choose
Quick Selection from the bottom-left icons and use the main slider to vary the
brush size. A smaller brush can capture more detail, a bigger one is better for
large selections.
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{2 Add more to the selection

The Quick Selection tool is great for dragging over your subject and grabbing
pixels, however, sometimes you might wish to add a little bit more to your
selection. To do this, simply grab the Lasso (L) tool, and select extra pixels if
need be.
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0.2 Tweak the brush
Just as with the regular Brush tool, there are settings that can be altered when
you're using Quick Selection. Hit the Brush Settings option to bring up the
dialog: it will prompt you to edit Hardness, Spacing and Roundness, as well as
Pen Pressure and Angle,
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(4 Refine Edge

Click the Refine Edge option from the bottom bar of Elements. Here, you will
be able to smooth your selection; use the sliders to do this depending on

what your selection needs. Brush over the picture to add/remove pixels to your
selection, too.

Alternative WayS Of SEIGCting Use a host of other tools for selecting in photos
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Brushes

Magic Wand

Digital artists choose Brushes for precision and
ease of use with a tablet, so why nat use them

as selection tools too? Create a new layer, reduce
Opacity, then brush over the object in a bright
colour. When you want to select it, Cmd/Ctrl4+click
the layer preview and select the background layer.

The Magic Wand is one of the lesser-used selection
tools. Though it's primarily used for quick one-

click selections, you can use it to select over an
image by holding the Shift button, and selecting
everything you'd like in your picture. It's a quick
option, and it's relatively accurate, too.

I'I:H'

:pI-'.-r-u N
IR "\i!hlll-"w ¥

E |

*
-

Multiple marquees

The Marguee tool is considered as just being able
to make basic selections of simple shapes. It can
be used, though, for selecting whole swathes of
your image; click on the Add option in the bottom
bar of Elerments and you'll be able to add more to
your selection.
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Wield the
Magic Wand tool
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n the surface, the Magic Wand is one of the most intuitive tools that
Photoshop or Elements can offer; the clue is in the name. We expect
it to just know exactly what we want selected.

The reality is that many find the Magic Wand doesn't offer much flexibility.
Most peaple prefer the Quick Selection or a Lasso, and the Wand gets ignored.
s it too simple for complex selecting jobs?

The trick is to match the tool to the right situation. What the Magic
Wand does perfectly is select a block of colour. It's even quicker than a
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Use the Magic Wand
to pick out blocks

of colour and your
selections will be
quick and effortless.

Quick Selection if you want to locate a certain shade in a picture, and by
understanding how to set the Tolerance, you can learn to select even more or
less than ever before, You'll be surprised at how accurate such a speedy tool
can pe,

'he Magic Wand is often just the beginning of an editing process. It's the
starting point for a big subject selection, or it's a marker to search for similar
colours in a picture. Let's look at the basics of the tool, and find out exactly
what the Magic Wand can conjure up.



&
SQ'ECt by magIC Make or prime the perfect selection with the Magic Wand

16.62%
e Mo :
S 7 i E1 AT | Tolnnce: Or— g5 ] Sample Al Layers
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-i : Eefine Edge | | [ Anti-aliasing
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U7 Select the tool

Select the Magic Wand tool from the icon on the left-hand side of Elements,

or Photoshop if you're using it. Make sure you tick Contiguous and Anti-alias
before you start selecting, Decide on what you want to select; the Magic Wand
works best on block colours.

Magic Wand :
n_'.- ! Add : _ [ Cormiguous
e |__nehneL_:|:|r... i [ Anc-aliasing

& % 9 C OH)rEmm

Photo Bin Tool Options Undo  Reco  Rosse  Layout Organizer

.2 Set the Tolerance

lolerance refers to how your selection reacts to the colours around it, If the
lolerance is low, the Magic Wand will select specific shades of colour; if the
Tolerance is high, it will select similar colours around the selection. Set a low
Tolerance for accuracy.

0= Point and click

Simply click on the object you wish to select in the picture: it really is that easy!
The Magic Wand works best when there's a specific colour that you wish to
select, as opposed to the Quick Selection tool that selects whole objects, but
neither tool is perfect,

04 Add and subtract

Use the Add and Subtract icons found at the bottom of the screen to
perfect the selection you have maae. They are useful for selecting similar
shades so that you can get the shape of an object rather than just the main

colour of it

Lassos Selection Brush

Quick Selection

Use the Magic Wand for the bulk of the selecting,
but there are more accurate tools that can finish a
job. Mavigating the Lassos, for example, all the way
around a shape can be arduous, but by using the
Wand first, you need only touch the edges!

The Selection Brush is just as good at covering the
corners that the Magic Wand missed out. Simply
select the width that you'd like, and use it as you
would any other brush to either add or subtract to
the selection.

I'he Quick Selection tool might be imprecise
when youre in a hurry, but that doesn't mean it
isn't great to improve a selection you've made
with the Magic Wand. Use it the same way; just
drag to add or subtract more to the selection.
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Make sure that you edit in the
cheeks of your new photoaswell ¥
as the mouth.

-

Merge two photos

with Selections
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o photo is perfect: that is, after all, why we edit them. However,

sometimes you might have certain aspects of some photos that you

like and others that you don't. While just picking the one that looks
the nicest overall is one answer, why not use Elements to take the best
bits from all of them? Merging facial features can be somewhat of a tricky
business, though. When you smile, it's not just your mouth that moves but
also your cheeks and sometimes even your eyes, so while it might seem
like a good idea to just composite the mouth into the picture, you don't
want to create a face that doesn't look natural. It's just as important to
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Don't position a smiling mouth
too far away from the nose, as this
will look obviously unnatural.

L
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judge exactly which facial features will look good in other pictures as it is
to learn the skills of how to place them.

Simply placing other facial features into the image sometimes isn't
enough, either. The Photomerge tool can offer some rather quick edits
for projects such as this, but you will have far mare control if you use the
[ransform tool. This one enables you to reshape and resize your selections
to fit the size of the face, rather than just being limited to having to use
a photo that has been shot in a similar way. Follow the tutorial on the
opposite page and experiment with your own photos.




Com bine the b(-'."St featu FeéS seclectand adjust separate photos
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Ul Use the Photo Bin

Start by importing your photos into Elements using File=0Open. To the bottom-
left corner you'll see the Photo Bin icon: click on that and the bottom panel will
display all of your open photos. Pick a feature from one you'd like to impose
over the other,
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(2 Align the faces

Copy your selection ({Cma/Ctri+-C) and paste it (Cmd/Ctri+V) over the other
photo, Set to 50% Opacity, and align roughly so that the two faces match up.
Use other facial features like the nose and cheeks to align the two mouths.
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Faces
Should you wish to combine the best facial
features of two photos automatically, Photomerge
can assist. In a similar way to the Exposure feature,
simply draw over the faces on the left that you
want to replace on the right.

Exposure

It's not just facial features that can be combined
from photos; lighting can, too. Go to the
Photomerge section of the Guided edits, pick
Exposure. Now just draw over the parts of one
image that you want to include in the other.
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)2 Make a broad selection

Grab the Marguee tool (M) and make a selection over the feature youd like

to place over the main photo: in this case, the smile. Make the selection big
enough so that some of the face is included; it's better to have too much to
edit out, than not enough.
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(4 Mask and transform
Hit the Mask icon and brush around the mouth with a black, soft brush. Hit

Transform (Cmd/Ctr4T) and Crnd/Ctri+-drag the corners of the selection to

resize the mouth to fit the new face,

=

USE PhOtomerge Go to the Guided edit for automated results

Panorama

Stitch photos together into one panoramic image
using Photomerge, Set the style of panorama
before selecting the images from the Photo Bin
and clicking Create Panorama to make a final
landscape based on them all,
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Though it may look like it was
hand-drawn, every element of
this piece was created using
selection and shape tools.
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none of these extra purchases are entirely necessary for creating digital art.
This tutorial will show you how to create a lovely illustrative piece using tools
already available to you, and techniques that can be completed using your
regular mouse,

We will be painting a nautical scene here, using Photoshop Elements. Al
of the tools that we will require in this tutorial are under the Expert tab - but
don't let that put you off! All of the menus that we will be using are very

124 PhotoshopforBeginners

oL Can

during step one.

The end result will be an attractive, illustrative image of a lighthouse at
night — an excellent piece to use as a gift, or print off and frame in your
own home. The techniques we will cover can be used for any of your future
projects, and will hopefully improve your skills and confidence when drawing
in Elements.




DEfaLllt tOOlS Create this nautical scene without the aid of a graphics tablet

{2 Prepare for colour
07 Sketch your scene Once your sketch is done, set the blend mode to ()2 Use the Lasso
Under the Expert tab, create a new document and Multiply. Create another layer below that one, and Create another new layer above the blue fill layer,
then a new layer. Select a small hard brush, 100% fill it with a light-blue colour using the Bucket tool. Select the Lasso tool and use it to trace the outline
Opacity and 10px in size, Use the Colour Picker to You should notice that your sketch's lines are now of one of the rock formations. Use the Color Picker
chogse a bright colour, like blue or red, and sketch darker; this will make them easier 1o see as you to choose a dark blue, and use the Bucket tool to
the lighthouse scene. Trace an image if needed. apply colour. fill the selected area. Repeat until all rocks are filled.

(4 Draw the sea foam U5 Create the sea

You can complete the sea foam using the same technigue as the rocks. Create Create another new layer, beneath the rocks and the foam. Select a deep blue
a new layer beneath the rocks layer, use the Colour Picker to choose a light and use the Rectangular Marquee tool to draw a rectangle across your canvas.
grey/blue, and trace over the sea foam areas. Try to make the shapes more This will be the basic colour for the sea, so make sure you keep the rectangle
rounded than the rocks. below the horizon line you drew in your sketch.

What
does it mean?

Jagged lines

Draw sharp, pointed edges LASSO TOOL - This is & useful and
using the Lasso and Square versatite tool for drawing freeform
Marquee tools to give your rock without the aid of a graphics tablet. |t
formations a harder look. enables you to draw any shape using

the mouse, and create a selection.
This selection area can befilled in
using the Bucket tool, moved
using the Move tool, ar
removed with the
Delete key.

|
Reshape your colours
“r—— Taper the foam and rocks by drawing over them

i with the Lasso, and hitting the delete key.

PhotoshopforBeginners 125



4
e S sl

ing ancther slightly darker

06 Darken the sky ) U & Choppy sea
Repeat the last step for the night sky, using a darke j Mﬂki“g waves Repeat the process usir
pDiue. Then select an even Qarker blue, and set your Go back to your sea layer. Select the blue using the blue, Fill in the gaps between your first lot of
prush to a 200px+ Airbrush. Draw around the top Fyedropper tool, then make it slightly darker in the waves, This will give your ocean a sense of depth.
orners of the canvas to create a shadow across Colour Picker. Using the Lasso tool, draw several If you're ever unsatisfied with a shape you've
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the sky. You don't need a graphics tablet for this - rough, snaking lines across the layer, and fill them drawn, draw back over it with the Lasso, and press
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the mouse will work fine! using the Bucket tocl to shade in some waves, delete to taper the shape.
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1) Moon over
the water

I I . e P H b
Lreghle a new laver abDove

your night sky layer. Using
b= o ok B = o ey
(e LIrcie ividarguee oo,
draw a perfect circle

above the higl Hignted

(Y Light in the dark

Lse the aforementioned technigque one more

area of the sea below.

time, using a blue that is lignter than your oceans
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base colour. Be much more sparing with your use

eCt a near-white Diue
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Using the Lasso tool like this

perrect circie creates sharp, striking artwork, It's
To draw a complete circle, hold great for creating illustrative work.
Shift as you draw outward with

the Circle Marquee tool.

r

If you do have accessto a
graphics tablet, use it to
draw in extra details, like
small rocks.

Make sure each colour
stands out. Use the Bucket
tool to adjust them.

126 Photoshop for Beginners



Brlght side uf the moon
As you did with the waves, use the Lasso tool to
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draw details on the moon. Press the Opacity Lock
button from the '.-i'i-i“iE the Layer ~| dneEl 10 prevent
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T
shaaes of dark greys, draw in your squiggly lines

- Shade the scene

Go back to your rock layer, and use a darker -.-?'u:.i-'.:-;:- of
to draw jagged shapes. Fill them in with the Bucket t¢
a darker shade, 1o give the rocks i '-"-1i-"|-‘-.5-;‘-'1 Apply f San
thin the lighthouse shape the top of the lighthouse to the horizon line to create a fading light.

lighthouse; use Opacity Lock to keep the shad
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Gradient maps are great for adjusting the colour of
a final piece. Set your Foreground swatch to a dark
colour and Background swatch to a lighter colour.
Create a gradient map by going to Layer> New
Adjustment Layer>Gradient Map. This will create

a new layer with the colour effects applied. The
darker colours of your piece will be enhanced by
the first colour you selected, and the lighter colours
by the second.

Now experiment with blend modes. Overlay,
Color Dodge and Soft Light are good options.
Lower the Opacity to 70% or lower, so the gradient
Map doesn’t OVerpower your piece.

P 'hl ar 1r1 asso tool

. nghthuuse
Mnnnllght Create > the rock layer, and use

Create a new Y el r above the moon, set it to the Lasso toc '-| [0 :i|¢'1;-'-. i|' the -5!".'|: iuse. Use a light
-.1, Using a near-white colour, select Brush tool white to 1ill in the selection, then select a grey
et to the airbrush you used earlier. Llick around purple to draw in the details. Use the Lasso and
1e moon; this will create perfect soft circles square Marguee tools to draw straight and angulal
und it, which will make it ook like it's glo 1es for the windows

- .
» A light in the darkness
Create a new laver beneath the lighthouse layer, a
raight line from the top of the lighthouse to the horizon line. Select the

e technique to the Gradient wool, and adjust the settings to | oreground to Iransparent. Lrag rrom
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IBrushes
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BRUSHES IN-DEPTH

One of Photoshop’s most essential
tools uncovered
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MAKE YOUR
OWN BRUSHES

When Photoshop's preset brushes

just aren’t what you're looking for -

create your own to suit your style

Nl ADRUSTMENTS
Add sn adjustment

' X L
{ =50 G d
w7 AL

B Levels Presets

I Curves Presens

B Euposure Presets

| | ® Hue/Sardrabes Presets

* Black & While Presels

P Chamnel Mixer Freseis

B Seisctive Color Presets

= [z
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BRUSH EFFECTS
Navigate your way around the
Brushes palette with ease
- b
—_ =
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® & B | s
a
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- Additional settings
Some special brushes in Photoshop C55,
C56 and CC will have additional settings
in the main Options bar to play with.
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Choose from a variety
There are lots of different categories

of brushes to choose from, such as
Calligraphic, Dry Media and Matural.

-
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Grasp the Brush tool

Add brush strokes to your artworks with this handy tool

you apply digital paint strokes, just as if you were using the real thing.
You can do just about everything with your Brush tool that you can with
a real paint brush. Choose from a range of different brush types, change the
size of the brush tip and decide how thick you want your paint to be (think
of the Opacity as being how watered down your paint is so that you can see
more or less through the paint to the canvas underneath),
While there are lots of different settings and you can get quite technical,
it is easy to pick the Brush tool, set a colour and simply start painting. We'll

THE BRUSH TOOL OPTIONS Find your way around the palettes

P hotoshop and Photoshop Elements boast the Brush tool, which lets

01 The Brush tool

[he Brush tool can be chosen from the main
Toolbar in both Photoshop and Elements. There
are settings along the top of the interface.

- —

PhotoshOD
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01 Select the Brush tool

Choaosing the Brush tool (B) will open up the Brush
panel at the bottom of the interface ready for you
to tweak the many options

02 The Brush Presets

[he Brush Presets mir"lt' shows you all available
lips to select and use (in versions C52 and below
these presets are -ﬂr.hm one Brushes palette),
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02 Choose a brush

Select the Brush drop-down menu to view a list of
brushes. You can choose different brush categories
from the drop-down menu to suit your needs.

be running through the key options that you need to know on these pages.
While most Photoshop beginners will use a mouse, once you get a bit more
comfortable with digital painting, you may want to try out a tablet!

“You can do just about everything
with your Brush tool that you can
with a real paint brush”
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03 The Brush palette

'he Brush palette is where you can alter and
customise the look of brushes. Have a play with the
sliders and see haow they affect your strokes.

ARV H L RSV Pick the right brush for your work

PHotoshOD
o fie CI'E

LEARN TO

CORAPDSE o
T 11
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03 si

Size matters

Alter the size of your brush by dragging the Size
slider. Alter the opacity of the brush strokes using

o T S .
the Opacity slider too.
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I Brushes

B@S’t bru Shes Get the most out of Photoshop's brushes

Calligraphic Brushes

he Calligraphic Brushes set contains a number of

brushes tailored to emulate calligraphic nib shapes.

Set the Angle Jitter to Tilt for maximum effect.

Dry Media Brushes
Most of the brushes here make use of many of the
attributes you can alter in the Brushes Palette, such

as adding Texture and Dual Brush functionality

s AARAAAAL

119999099000
s AARAAAAL

Faux Finish Brushes 2

Toy with the settings of the Texture Comb brushes;

with a little experimentation you can create some

very expressive brushwork,

132 Photoshop for Beginners

Drop Shadow Brushes

Crop Shadow Brushes provide brushes of both

round and square varieties with feathered edges 1o

rencler shadows with a soft edge to them.

Dry Media Brushes 2

By looking through the Brushes Palette settings
vou'll get an idea of why these brushes behave the
way they do, which will help you make your own.

Natural Brushes
MNatural Brushes includes Stipple and Spray brushes.

| he Stipple brush works well with Angle Jitter set

to Pen lilt ana Opacity set to Pen Pressure,

L]
Dry Media Brushes
A great set of brushes that emulate traditional
media such as pastels and charcoals. A great place

O start If you want 1o Create cuslom Drusnes,

Faux Finish Brushes
With brushes like Plastic Wrap and 5ea Sponge this
set appears quite limited, but playing around with

the settings makes them a lot more versatile

Natural Brushes
I'he Spray brush works like the Airorush but has a
faint stippling effect so the result is more textured.

Set the Opacity to Pen Pressure for best results,



Natural Brushes 2
Matural Brushes 2 collects brushes that have
textures built into them. Chalk and Pastel effect

brushes are well represented here,

Special Effect Brushes

'he Azalea brush switches Foreground/
Background colours, while the Butterfly brush’s
high Hue Jitter randomises them.

Natural Brushes 2
[0 get a natural build-up effect set Opacity and

Flow to Pen Pressure. Set the Blending Mode to

T."ll"l

Multiply in the Toolbar to enhance it even further,

Square Brushes
Square Brushes is misleading; there is really just one
brush here supplied at a number of different sizes.

Its brush work is surprisingly pleasing, though

-
Special Effect Brushes
Other than Drippy Watercolor, which has some
painting application, the brushes here are fun but

sgntly gimmicky,

Thick Heavy Brushes

he Thick Heavy Brushes set features five bristle
effect brushes that will add a little texture 1o your
brush work.

Wet Media Brushes

Wet Media Brushes includes a superb selection of

assorted brushes, As well as watercolour brushes

there are also ink, oil and dry brushes,

Wet Media Brushes

[here are a number of Brush Tip Shapes employed

o e WAt bl B e T L e gy ELLEt PRty o
in the Wet Media Brushes section, which makes the

s g £ T 4
effects of each one noticeably different to the last.

Wet Media Brushes

[he variety of styles in this category is impressive,
most use Textures and at least one other feature,

| he watercolour brushes use the Wet tages option
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Brushes

Use tools with brushes

A lot of the tools in Photoshop use brushes. Here’s
our quick guide to the most popular ones

nderstanding how Photoshop’s brushes work isn't just important specific, you'll get a different selection of settings when the Eraser is selected
U to people that want to paint digitally, the knowledge will help you than you would if using the Blur Tool.
in photo editing and pretty much any Photoshop-related task. All Common elements in the Toolbar that each tool shares are the display of the
of the tools we lock at here can be used with any Brush Tip Shape you have in Brush Tip shape and size and the brush's Blending Mode. There will also be an
your Brush Library because they all work with Photoshop's Brush Engine. icon to enable your graphics tablet to override controls set in the Brushes panel,
No matter which of the Brush Engine-based tools you use, whether it's the Opacity and Flow are commaon settings to see in the Toolbar when using
Clone Stamp, History Brush or Smudge Tool, you'll be able to alter the options a brush-based tool and are helpful for controlling the strength of a brush's
in two specific areas in your Workspace: the Toolbar and the Brushes Palette. impact if you're using a mouse instead of a pressure-sensitive tablet.
The Brushes Palette can be opened by pressing F5 and contains the same B i
brush-editing options regardless of which tool you are currently using. O pacity an d Flow are hel pfu | for
The Toclbar is positioned directly below the Main Navigation Bar in . § . 1"
Photoshop. Unlike the Brushes Palette, the settings available here are tool CO nt rOI | 18 g a b [ U. S h S ] m paCt
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POpUIar erShes The various brushes and what they do

%

Hard Mix The Clone Stamp History Brush

'he Pencil and Brush are almost identical but the Hit Alt to select an area that will be duplicated [he History Brush lets you fix mistakes and apply
Pencil creates hard-edged Aliased strokes and the when you use the brush elsewhere on the image. Filters; any area you paint on reverts to a previously
Brush makes smoother Anti-Aliased brusl

| strokes, Clone from All Layers or just the current Layer. defined state by using info from the history palette.

Art Histnry Brush Erasers

A customisable special effects brush that gives you Used for both corrections and special effects, [he Blur tool allows you to blur small areas such

d r'-ﬂlf‘udf“ painterly  effect superior to that of using a changing your brush type and Opacity wil -:j] Ve as wrinkles or spots. Use with restraint to avoid an
Filter by dragging your cursor over a photo. you a range of appearances to remove solid pixels. obviously over-blurred image,

Sharpen Smudge Dodge and Burn

'he Sharpen Tool increases the Contrast of any [he Smudge tool smears your paint across the Dodge and Burn lighten or darken any area you
pixels you paint over it with to make the images canvas. The higher the Pressure level, the more of maove the brush over. You can change their Range
appear crisper, the paint will be removed from the canvas. to affect Highlights, Midtones or Shadows.
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I Brushes

SOURCE FILE AVAILABLE

Discover the
power of brushes
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rushes are incredibly adaptable, lending themselves to a wide range

of different projects, from masking in photo manipulations to photo

editing. Because they can be used in 5o many ways, it's important to
understand how to get the most from them.

While it definitely helps to be a talented sketcher or artist, you don't have

to be particularly artistically inclined to have fun with the different brushes
in Elements; custom brushes especially only need you to click them once to
apply a painted effect, and there really is nothing stopping you from inserting
a photo into Elements on a lower layer and drawing over the top of it with one
of your brushes.
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. USEADJUSTMENTS

. Hit the Fill Layer icon and

| add adjustments such as

| Levels and Hue/Saturation to

' enhance colour and tone.

|
|

- - = -
5 5

=S

., N

-I'\:.h §—- i
1 L% 1 )

One of the best things about brushes is how they can be customised.

You can change almost anything about brushes, from the blend mode to
the roundness of the stroke itself, meaning that there is so much potential for
the style you want to create. It's easy to make watercolours with a softer, low-
opacity brush, and it's possible 1o create a pencil effect if you find a thin brush
that has a little fade added to it.

Digital paintings are one of the hardest things to become a master of in
Elements, and learning the basics is useful when expanding upon what you
can create in other projects. Check out our top tips for creating simple digital
paintings, along with the settings you need to take full control of your pictures.



Create digital paintings Build on a blank canvas with different brushes
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Start by outlining
Hit B to select a brush, then click on the example brush stroke icon. The most
basic brushes are the small, hard ones found at the start of the Brush menu.
These ones are fantastic for outlining and making details; these are the brushes
you should create the basic sketch for your picture with.
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03 Apply soft brushes
Alter the hardness via Brush Settings. Soft brushes are good for a whole range
of projects. If you create a new, Soft Light layer above your other brush strokes

though, brushing soft black and white onto your project can be a good way of

adding highlights and shadows to your work,
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02 Move to bigger brushes

Scroll through the brushes to find more on offer. Bigger brushes such as the
Chalk brush are good for shading and colouring in your work. Using these
brushes at a low opacity can be useful so that you can blend your work as
vou go. Use the swatches to choose a colour before applying.

Ry I B
vel r
1 L ¥ ecls

- 1 I "_._:t‘-l EA

et B

.....

e

04 Use custom brushes

You can find custorm .abr brush files online to use in your work. Splatter
brushes are popular, and there's a selection on the FileSilo, as well as a pack
included in the resources. They can help to brighten up your image; just drag a

abr file into Elements to add them.

Fu I‘ther tIpS How can you get more out of brushes from the settings?

el

—- I
Eﬁ'.ﬁf—‘-‘-
3

5 C DA m

Farw el 1l (e

P ]

Brush settings

Blend modes

Click on the blend mode drop-down menu to
change the mode of your brush and how it reacts
to your work when you start using it. Changing

It can either lighten or darken your image as you .
stroke. Alternatively, brush onto different layers and '[

then tweak them for more control over the entire
block of colour that you're brushing,

he brush settings are where you can change
anytning about your brush from size to shape,
There are options for Spacing, Roundness, and
Fade, s it's worth considering these settings
>efore trying to stroke onto images. Remember to
get in the habit of double-checking the settings to
make sure you re using the brush you want to.

Tablet settings

Jsing a graphics tablet can improve the way you
use brushes. If you're a budding digital artist, it's a
good idea to invest in ane. Be sure to use the tablet
settings, which are just below Brush Settings, to set
controls before you begin drawing, because you
can set the tablet to control aspects such as Size,
Opacity, Scatter, Jitter and Roundness.
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Definition _

from emptiness

Even though we've only painted in
the tiger's stripes, a recognisable
image has still been formed.

Create shape with negative space

egative space is any area of your canvas that isn't a subject or an

object. Creating art in this style takes the space arcund an object and

uses that to define the shape, rather than the details or shading of the
positive version, Negative-space artwork often takes the form of silhouette -

simple or monotone colour schemes, which brings the main focus on the form.

Here we are defining the entire tiger using only its stripes, letting your brain fill
in the details that aren't there. This tutorial covers a lot of the tocls and features
found inside Elements to give your negative space even more drama. You'll use

138 PhotoshopforBeginners

the Brush tool to paint contrasting eye detail, filters to neaten your sketching, as
well as clipping masks to overlay an ethereal space image. Another large focus
is the use of custom brushes. You will download some free paint-style brushes
and use them to create quick but dramatic effects. Finally, layers play a big part
in this tutorial. They are crucial to keeping everything editable, and also mean
YOU can change your base drawing whenever you like, so you can continue to
get creative and try out this technique with anything else! You can also change
the overlayed image to add a completely different effect to the same drawing.



Palnt the Space Turn any photograph into a negative-space masterpiece with brushes
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01 Set up your canvas

Enter Expert mode from the top toolbar. File>0Open

(Cd/Ctri+-O) Tigerjpg’ from the FileSilo, Double
click the thumbnail on the right to tum it into a

ayer. Go to Image>Resize>Canvas Size and change

the canvas 1o 230mm x 180mm.
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04 Paint the eyes

Create a new layer and drag it under the stripes layer. Select the Brush (B) and
and change the Foreground colour to #2c3a51.
FPaint inside the eye. Change your brush to black and paint in a soft pupil.

change Hardness to 0%. Selec
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03 Finish the stripes

02 Start painting stripes
Create a new layer above the photo (Cmd/Ctrl+ Continue until you have painted over all the stripes
Snift+N). Select the paint brush (B). On the new in black. Include some of the larger areas or dark
layer, paint aver the tiger's stripes. You don't have fll
to be neat, but keep your shapes blocky and thick.
Ensure your brush is set to 100% Hardness

r around the face and ears as well. Keep smal
details 1o a minimum, and for now don't draw in
the pupils.

Open - -u—q-u-l“
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05 Add eye detail

Make your Brush Size 2px, Opacity around 20%. Using a mix of black and white,
ydd shading to the eyes. Be patient; build up the shading over many passes.
Keep your strokes in a radial pattern to try to imitate the texture of an iris.
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Simple shapes
Don't go into detail with
the stripes; keep shapes
blocky and bold.

|

hat
doesv?t mean?

HUEH HHHI_}NE‘J: — In

Softe

Contrast the crisp, clean
stripes with soft, textured
eyes. Blend them in with the
dark edges.
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06 Fill the background

Create a new layer (Cmd/Ctrl+ShiftM). Fill it white using the Paint Bucket (K)
and drag underneath the stripes layer. Select them both by holding Cmd/
Ctrl and right-clicking>Merge Layers. Use the Eraser to rermove the white that

covers the eyes. This gives us a crisp black/white edge

08 Add the Stamp filter

Click New Layer at the bottom of the filters

window. Go 10 Stamp inside Sketch tilters, Set
Light/Dark balance 32 and Smoothness 7. Hit OK,
If Foreground/Background colours aren't black
and white, cancel, change, and redo steps 7 and 8.

Organisin

your brushes

Custormn brushes are a great
way 1o get cool effects fast,
and there is no limit to the
amaount you can install, Access
different brush sets via the
drop-down at the top of the
brush preview window. You
can change how you view the
brushes. You can also open
the Preset Manager, which is

a useful place to rename and
invaluaole
if you have some favourites or
vant to create your own sets.

organise brushes
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Subtle details

Use the custom brushes
sparingly here, creating
subtle additions to the
larger blocks of paint.

i
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Matching Angles
Make sure you rotate the brush
inside Brush Settings to match
the angles of the stripes.

i

07 Smooth out the stripes

Make sure your colours are set to black for the foreground and white for the
background. To give the hand-drawn stripes a smoother [ook, select the stripes
layer and go to Filter>Filter Gallery. Select Cutout from the Artistic section and

enter; Levels: 2, Edge Simplicity: 4 and Edge Fidelity: 2,

09 Load custom brushes

Under Freebies at blog.spoongraphics.couk,
search and download 12 Free High Res Diry Brush
Stroke Photoshop Brushes'. In Elements, select the

10 Paint in brush strokes

Create a new layer above the stripes. Add some
painted’ texture to your illustration. Inside the Brush
Brush (B) and click the arrow next to brush preview. Settings menu you can rotate the brush to match
Click the icon in the right-hand corner, select Load up with the angles of the stripes. Click once rather

Brushes, then find the .abr file you downloaded. than dragging, to keep all the custom brush detail.
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Layer management
Keeping these additions on a
new layer means that you can
erase them and will never lose
the original stripes.

L

Smooth edges
Filters take away the
shakiness of hand-drawn
brush lines, giving a more
professional feel.
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12 Add a layer mask
11 Fill with brush strokes

Create a new layer above the paint strokes. Now mask with the ‘circle inside a rect:
| e i . TRFF I e P PR | g = i o o Sl Ty e | o o= % Le s a it Byt Y e e sl dar:
fill most of the canvas with big brush strokes. Click Painting black on this mask will hide what's on the

once 1o add f"f.--._'l" orusn 1o |-{t".',‘[:’= Its texture, Leave

some gaps and rough edges for extra effect
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14 Make starry eyes
Duplicate the stars layer with Crnd/Ctrl4+. Drag this new layer above the eyes
Right-click and select Create Clipping Mask. This ensures it only affects the

SR pRTE | s o Py I Rt gl o T |
eves laver and not the Tiger group. Reduce the Opacity to 50%

Layer masks

Get comfortable with
non-destructive editing
Layer masks are simple to use, and extremely
powerful. On a layer mask, black hides what
is below and white shows wnat is below - by
default, layer masks are set to white, 50 when
vou first add one, nothing will change. As you
start painting in black, the layer it's attached
to will start to disappear. Different shades ol
grey add different layers of opacity to the layer
[he advantage is that you never permanently
erase anything — any part of the layer that you
hide can always be brought back by painting
in white. This is called non-destructive editing,

and prevents a lot of costly mistakes.
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attached layer. Use the Dry Brush brushes to paint

plack on the mask to create interesting shapes
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13 Overlay the stars

Select the painted stripe layers and hit Crmd/Ctrl+G
to Group. Drag the eyes layer above the group. Go

to File>Place and add in Stars jpg’ from FileSilo.

Drag the Stars layer below the eyes, Set the blend

T
L

mode from Normal to Screen, and Opacity to 8(
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15 Add contrast

With the top layer selected, hit Cmd/Ctr-Shift+Alt

HE tO make a stamp’ of al
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# Photoshop Elements Editor File Edit Image Enhance Layer Select

View Window Help

Lens Flare =
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What are filters?
_earn what the filters are and how to use the Fil

i i et SATARRL - SRRSO SIAP . ([1 (e it UL - 4% SRR
box to preview, control and apply effects quickly and efficiently
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ilters are built-in actions that you can apply to an image to create see the details of the effect. The centre panel displays all the filters divided
different effects. You can use filters to apply special effects, clean up or by categories and a very helpful thumbnail preview where you can choose
retouch your photos in next to no time. the desired effect.
There are a huge number of instances where you can use the Filters, The third panel provides all the controls over the filters, where you can
ranging from basic image sharpening or fixing a blurry background to complex  change the settings to control the effect however you wish and view the
filter combinations to create the most intricate effects. changes in real-time on the preview window. By clicking on the Add Layer icon
You can find the Filters under the Filter menu in Photoshep. Click on Filter allows you to add two or more filters at the same time to create subtle and
Gallery and a new window will pop up revealing all the filters that are available impressive effects,
in your Photoshop version. The Filters are grouped into categories such as - :
Artistic, Distort, Sketch and so forth. Each effect has a specific function, for Ti’] -~ ﬂ LJ g - {'& N {:]
example under the Distort category you will find the Filters that will create - _ e T
distortions in your image such as waves, ripples and a zigzag. g | "3 U K}f& (j i ﬁ {_Cﬁ alc
The Filter Gallery is divided into three panels. On the left you will find the e L . p— )
preview window with a magnify toocl available to help you preview a filter and !‘&H “E:J l{-, D! bl’i}? Lr Si'{:~ =d

F =
Filter thumbnails Magnify tool Controls

Open the Artistic filters and select the Palette Knife On the bottom-left corner you will find the Each filter has a gifferent sets af controls, you car
<] FERty o e ) | PRl MUER G Sy PR o TR W B P et EPRTR, Lo e s g et L P i o v ks FERqrEE oy | o = P e L
filter. This will have its thumbnail highlighted and magnify tool, which is a very handy tool to preview change the parameters to control the filter and
the result is displayed on the Preview window, a filter and see the details of the effect. preview the results in the preview window
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Layers Change filter Filter menu

Click on the Add Layer icon to add a new effect lo change a filter on a layer just select the layerand  Under the Filter menu you will find very powerfu
layer. This allows you to add two or more filters at choose another filter, You can also delete a layer by filters such as the Lighting Effect filter to create a
the same time, clicking on the Delete Effect Layer icon. dramatic scene or set the ambiance for an image.
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o There are over 100 filters in Photoshop, each sectioned into groups. From
I ers a a ance Avrtistic filters, where you can achieve pastel or pencil effects to Distort filters,

where the filter geometrically distorts an image. Here’s a great selection of our
favourite filter effects to give you some artistic inspiration.

b

Reticulation

Craquelure [ Mosaic tiles Stain glass Texturizer
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You can apply a simple soft focus
to any image and decide on how
powerful it should be by altering
the radius.

iscover the Blur filters

hen people think of the Blur filters in
Photoshop and Elements, they think

of smoothing, adding haziness and
distorting your picture. However, the Blur filters
should be used as a tool to add focus, rather than
remove it, because if you can converge your blur to
a specific area of your picture, you can bring out the
detail in another area.

'he key to the Blur filters is to add them around
subjects that need focus. By duplicating layers and
masking out the excess, you can pinpoint your blur
to a specific area. Most of the time in Photoshop, you
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might anly use one or two of the Blur options in the
Filter menu, but there are others that transform your
images in imaginative or subtle ways.

Blurs can be used in all kinds of projects too, as it's
not just photo editing that requires a shift of focus;
you might need to apply a blur to a digital painting
or add a depth of field to a composition. Blurs can
even be used for illustrations - try the Average Blur
for filling with colour - or for retouching the skin in
portraits. Check out our guide to each of the Blur
filters, what they do and where they can be used in
YOUr pictures.




Add a bit of a blur -.:.

Average

The Average Blur will pick out the average colour
of the area you've selected and fills it with that
particular shade, This is good for smooth spaces
of colour, and you can use it creatively to paint

pictures, rather like a Fill-type tool.

r——— v — A .

Gaussian Blu

'he Gaussian Blur option applies haze to your
pictures, but you can choose the radius of blur you
wish to add. This option is perfect for adding a soft
focus; simply duplicate your layer (Crnd/Ctrl+J), set
1o Screen and aad a Gaussian Blur 1o apply.
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The Radial Blur and the Motion Blur are both
extremnely similar. Where the Motion Blur applies
the effect in a straight line though, the Radial Blur
either applies a blur in a circle or a zoom. Both can
Oe great to add to starry skies, or just to pictures as
novelty effects.

Blur

Blur adds a simple haziness to the selected space. It
works by reducing noise and it is perfect for subtly
blurring the background of your picture - select
the subject, then Ctri/right-click and Select Inverse
— 50 that you can bring out focus in a foreground,

Lens Blui

The best option in the Filter menu for
photographers, Lens Blur enables you to produce
a more accurate blur even set to a specific shape.
You can also add noise to your picture, adjust the

distribution and even tweak the highlights.

The Smart Blur gets us even deeper into the
process of blurring, and enables you to find more
or less pixels to add to the blur. You can set a mode
for the entire selection (Mormal) or for the edges

of colour transitions (Edge Only and Overlay Edge).
[his is great for smoothing.
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Blur More is the same as the original blur, only
it applies a more intense blurring effect. This is
a particularly good option for pictures with a
backdrop much further away, if vou apply the
same principles of blurring the background.
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iViotion Blur

Mation Blur applies a haze in a specific direction,
which you can tweak according to direction and
angle. This is great to add to moving objects;
duplicate a layer, apply to your object and mask
out everything apart from that object to apply.

i i

Surface Blur

The Surface Blur applies a similar blur to a
picture, but it preserves the edges in the shot.
For this reason, it's the perfect filter to use to
smooth a subject’s skin, as it doesn't overly haze
the shot; duplicate your original layer and mask
where you want the skin to be smoothed,
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You'll find that Path Blurs and Spin T b
Blurs are perfect for long-exposure iy S St e

effects, such as starry nights, water
or even light trails.

Masterthe  -_
Blur Gallery filters
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lur and grain seem to be polar opposites: one’s
intended to give roughness to your picture, and o ; - . | _

the other’s intended to give smoothness. But they s e <~ ——t 4 T o F D ol

can actually be used in unison for stunning results. = — - LTSRS W DT L T e

With the 2015 updates to Creative Cloud, Adobe has o : - ' | : | | : A .-

made it possible for you to match the grain in a picture with - e —— = P j . T . B il

Lk Y T T
T L

the blur that you're creating in the Blur Gallery. This may
not sound like a significant update, but it's the tiny details 3 : !
that can really make a picture, At the moment you can add ‘ e - W= ﬂ i _*. s 57 SR _f-_' T j; il : '“:m‘:_
a one-click basic grain to your blurs to complete a retro gaﬁtﬂﬂf...w s, g . i i "'M';T:"-'m;
composition, but there are so many other uses for grain. _ _—— — = L o SR
The new Blur Gallery grain options make it easy to mix ' ' ‘
the rough with the smoaoth in your projects. But how and
when might you use these new options? Check out our
guide to each of the five Blur Gallery filters, and an example

of when you might need grain.

i Erald . Bl s et e G 4 = ek o 5 L e e e ) T T = TR Pl SR i b i E T e R Y
'he Field Blur is similar to a Gaussian Blur, but i Iris Blur is extremely similar to the Field Blur in Adding a Tilt Shift to a cityscape like the ong

can be used to create bokeh effects, such as in that it can create a simple, sparkly bokeh above can give this coal toy-town effect; all you
this example, by dialling up the colour and light effect, but it can also focus its attention on one have to do is align the guides so that the centre
dials. Here, grain can be used to add more texture particular area, such as a subject, using a ring alls within the focused area of the buildings. Then
and in this case, it's great for making text visible that can be resized and set to control the biur YOU Car use a large grain 1o create a smoggy

on the backgrouna, 0N YouUr composition. effect in the sky.
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You can use Field and Iris Blurs for
bokeh; the difference between

the two is in the ability to focus
the blur.
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Lighting

|

Effects filter
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n Photoshop CS6, the Lighting Effects filter saw some major

improvements compared to previous versions. Its interface saw the

biggest change, with a larger and friendlier preview screen. This makes
applying lights much easier than before, giving you more control in the style

of the effect you need.

In fact, the functionality and power of the Lighting Effects filter, when
applied constructively, can provide tremendous results. Couple these with
digital photography, and users are presented with a wonderland of creative
opportunities, Once you've accessed the dialog box, the Presets drop menu
instantly provides you with 17 separate options, counting Default. These

include Soft Omni, Flash

ight, Flood Light and 2 O'clock Spotlight.

Application is effortless and a live preview is ever-present in the Preview
window to monitor treatment. Utilising the control nodes, users can alter
the lighting direction and location. This filter also includes a highly efficient
set of property options that allow users to measure and edit the intensity of
commaon light effects such as exposure, ambience and the amount of
surface reflection. All of these can be deployed to enhance and pinpoint

selected image areas.

The key with this filter is in keeping it subtle. A gentle spotlight can really
lift your image, but go crazy with too many lights and harsh settings, and you
will cheapen your image. Still, a lot of this filter is down to trial and error, and

personal preference.

It's not always easy to remember the
exact settings used if you need to repeat
an effect. Use the Save option under
Presets at the top of the filter to store
your personalised effects for a later date.
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You can use Lighting effects with other
applications to enhance and create
image effects such as moonlight, sunrise
and sunset. Try opening a sunny image
then duplicating the image. Select

the Lighting Effect filter, applying a
Spotlight in the appropriate ‘o’clock’
position. Set this to a yellow tone, set

an Orange Properties tone and apply
the desired settings. Clicking OK, apply
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lse the Lolor and Hotspot sliders to

covers. Click and drag outside this area Fffect will be

the light change the

Photoshop's Render options. Go into the Filter light source

to rotate the angle of light's overall strength.
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Adobe Photoshop CS6

7 Preview Cancel
Lighting Effects

Properties

*. Lighting Effects

= Understanding the
coior. I Intensiry: 2 functions of the properties s
essential. Exposure works by
dhois s increasing (positive values) or
decreasing (negative values)
light across the image. A value
of 0 has no effect.

Exposure

Ambience

Gloss determines how much
the surface of the image
reflects light, from a matte
effect (low reflectance) to a
shiny effect (high reflectance),
much like it does on actual
paper surfaces,

The Metallic slider determines
which is more reflective: the
light itself or the object on
which it's cast.

Ambience acts as a light diffuser in
your image. It combines with the
lighting, so the more negative the
value the more it removes, and the
more positive the more it uses only
the light source.

Select  Filter 3D Wiew ‘Window H

% (Light E¥eci, RGE/RF "

Infinite lighting

An Infinite Light adjusts the entire lighting in an

mage as well as brightness and positioning. Add

this using the options under Lights along the top
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Work with the
Reduce Noise filter

Don't fall foul to low-light maladies; eliminate noise in
your pictures and smooth things out with this fi

Lel

ven the best photographer has images stashed away that suffer from quick fix, but a powerful one, and an edit you can apply to a whole host of

a severe bout of noise. The dreaded grainy effect can be unavoidable photos just to give them a slight patch-up.

in some situations, primarily low-light or night shots, and it can taint an But for optimum results, the Reduce Noise filter works best if you combine
otherwise perfect picture. it with a slight blurring. It's a useful filter on its own, but like so many features

Fortunately though, you don't have to put up with noise in your photos, in Photoshop and Elements, there's no end to the potential of the Reduce

because Elements offers a tool that can remove it. The Reduce Noise filter is Noise filter if you know how to harness it well. By editing non-destructively and
designed for smoothing aver the unsightly, overly-sharp fragments of colour sharpening the picture again with the original layer, you have the perfect noise
that can appear at the edges of overexposed or low-resclution images. It's a removal systermn. Read on to find out how it's done.
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Banish the noise
e o N

Duplicate your layer
To edit non-destructively, it's always a good idea to duplicate your original layer.
In this case though, we're going to make some drastic changes 1o the picture,
s0 we definitely need to save the original layer to bring details back into the

eqitea layer.

Bl Cashsr PR | 000 | 6

By peem [P Brid

Find Reduce Noise
On your duplicate layer, go to Filter>Noise>Reduce Noise, We have gone fol
the highest possible Strength and Reduce Color Noise settings. Don't worry
oo much about preserving details at this stage, as were going to do that with
the or n::'__,‘-ll'“;al |-_-;f'.":'r

Blur leftover noise
The Reduce Naise filter is great at reducing the vast majority of noise in a
picture. Just to finish off your edit though, head to Filter>Blur=Gaussian Blur
and add a blur of 1.5px, just to smocth over any remaining noise in the picture.

Creative noise fixes

Mask back detail

Add a mask to this now blurry, indistinct layer. With a soft, black brush, start
masking the details of the picture that you want to show through. Lights can
be somewhat blurrier, but the buildings in the picture should be clearer now

Blurring a picture is a really great way to hide the Noise often appears in dark areas. By creating

a new laver with a dark colour, and setting it to

grain, as we did in the tutorial, and soft focuses
can soften the whole picture and add a nice glow.
Simply duplicate your layver, add a Gaussian Blur
and set to Screen

were taken Dy a retro camera.

If you can't get rid of noise, why not embrace it?
Go to Filter>Noise>Add Noise and create & classic,
Lighten, you can get rid of the noise in the picture grainy photo that looks like it's stood the test o
and create this cool effect; the picture looks as if it time, It's a nice effect and one that can make use

of your natural noise.
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ICreative projects
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LEVELS

Make final edits by adding Levels
adjustment layers
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Creative projects

What
does it mean?

)arping image

1wough there are a few

ns and settings for the
ilter, the one you'll use

main Warp command

SOURCE FILE AVAILABLE

Create a flying fantasy island

Use layers, masks, filters and brushes for a surreal adventure

very project teaches you something, but there are some projects that uses all the big features of Elements, and

that every Photoshop Elements user just has to try. Whether you're that's why it's such a great project for you to

a photo editor, a photomanipulator or a digital artist, creating a flying try your hand at.
fantasy island is one of those projects that will teach you a ton about the Of course, that doesn't mean it's not a challenging composition to put
Elements software, and it's great fun to do as well. together. You just need to be prepared to spend a bit of time working on the

The possibilities with a project like this are endless. Whether you're going into  intricacies of the piece: take cutting out the island, for example. You could do
science fiction-inspired territory, creating a Gorillaz-style windmill island, or just it fast with the Quick Selection, but it'll look so much better if you brush all

introducing animals to your island like we are in this tutorial, the tools remain around its outside,
the same. Layers to build the scene, masks to blend them together, brushes This is a project that will require a lot of patience, but that doesn't mean the
to add to the image, and filters to create some believability. This is a project technigues behind it are too difficult,
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conStrUCt thE iSIa nd Cut out your elements and blend them together
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01 Blur the background

Eegin by inserting the image of the clouds and go to Filter> Noise> Reduce
Noise, Alter Strength to 10, and leave Preserve Details and Reduce Color Noise
at 10%. This will lightly blur the background; click OK to apply.
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03 Laying the grass

With the main rock finished, the next step is to add the grass. We're going to
select the grass with the Quick Selection and click Mask, before applying that
mask. Move it behind the rock and place it ready to Liguify,
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02 Cut out your island

Add the rock farmation to the image and flip it upside down by using
Transform. To select it as accurately as possible, we're going to hit Mask and use
a small, soft, black brush around the outside of it to mask away the excess.

04 warp the grasss

(a0 to Filter> Distort> Liquify and warp the grass to create bigger bumps on
either side of the image; lower each side of the grass so it fits nicely behind the
rock formation. This is a technigque you can use in Elernents to get any image to
fit perfectly into a composition.
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05 Blend the rock

On the FileSilo is an image of a cliff edge. Add this
o your compaosition, hit Mask and blena it with
the picture using a soft, black brush. Create new
Screen and Color layers; select colours from the
rock and apply them over the image to blend.

06 Add a waterfall

Place one of your waterfall images into the

piece and set to Screen. Use the same blending
technigue to mask it into the image a little better,
then duplicate the layer. Set this cne to Normal,
and again mask in the darker areas of the image.

07 Continue with the waterfall
Add anather of the waterfall images to the top of
the grass, and again mask into the image with the
same techniques. Mask in the darker pixels on the
MNormal layer and the lighter ones on the Screen
layer for a more believable waterfall.
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I Creative projects

EXPERT TIP
Fully adjusting

N N
[}

7 -
o = B
the image &
o
Levels is a useful adjustment in Elemenis, :":.:
but it's by no means the cnly one you L
can apply to make this island pop. Hue/ L
Saturation and Brightness/Contrast can B - —
help to improve the overall colour and T ——
vibrance of an image when added to a » e | A
project. A gradient map can also help 08 Mask the castle in S——
with this, but if you add a black-to-white  Insert the castle, and hit Mask. Using the same 09 Plant a tree
gradient set to Soft Light, it can give a soft brush mask technique, blend it into the Add the image of the cherry blossom tree, Use the Magic Wand
cinematic feel. Remember to add a High image. Duplicate, flip horizontal and then mask ~ with the Contiguous box unchecked - and select all the pink
Pass layer of 5px set to Overlay to sharpen  some of the trees so that the left-hand side has colours from the image. Hit Mask, and with the Brush Tool,
the piece when you've finished it. some of the trees as well as the right mask in some of the darker shades you missed out,

10 Place the animals 12 Reflect the island

Mow to add a few characters to the scene. Place a 11 Make a |EdgE With vour ledge in place, create a new layer and brush
peacock or two, and the giraffes, and use masking Merge all the layers you've created so far for the light blue (#c8e5eb) to make a small pond. Copy your
techniques to blend them all into the picture. Add istand, minus animals, trees and castle. Duplicate island layer, flip vertically and then use Filter> Filter
shadows to them as you see fit on layers below and blend in some of the island to create a small Gallery:> Glass to create a distorted reflection. Set to
with soft, black brushes. ledge, like you can see in the screenshot, Owverlay and clip to the pond (Alt/Opt-click),
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13 Bring in the dolphin
To add a touch maore fun to this little water-filled ledge, blend in a 14 Levels

waterfall as you did earlier in the project and insert the supplied Create a Levels adjustrment using the Fill Layer icon. Tweak the stoppers below the
dolphin from the resources, Mask into the image and then create a histogram to increase the contrast, and with the drop-down menu, change the Red, Blue
subtle reflection as you just did with the island. and Green channels slightly to give a warmer look to the image.
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15 Cinuds filter 16 Liquify some more | 17 Create a lens flare

Create a new layer and set your swatches as black Merge the island layers again. Go to Filter> Create a new layer and fill with black, Go to Filter>
and white. Go to Filter> Render> Clouds and set Distort> Liquify and warp so that there's more of a Render> Lens Flare and cast it across the image. Set
the layer to Screen. Hit Mask and Invert (Crnd/ platform to the top of the island, and to define the to Screen and this will add a touch of brightness;
Cerl+). With a soft, white brush, fade the douds in shape and contour of the island as a whole. This add to it with some white Soft Light brushing in
around the base of the island. will help with the overall look of the piece. the bottom left of the island, if need be.
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18 Highlighting and shading 19 Finish with a rainbow
Merge everything into one layer by hitting Cmd/Ctri4+-Alt/Opt+Shift+E, then Finally, create a new 6000 x 6000px document. Create a new layer and a few
Duplicate (Cmd/Ctri4). Set one layer to Screen, one to Multiply, hit Mask on pixels from the bottom, on a new layer, create a rainbow gradient (G). Go to
poth and Invert (Cmd/CriH). With a white brush, add in some highlights and Filter> Distort> Polar Coordinates and choose Rectangular to Polar. Copy to the
shadows on both masks. island, set to Screen and mask in over the water.

Ha rmoniSi ng a compOSition Bring all the elements together

. e : G~ el " | Cote = Share =

In a fairly sophisticated composition such as a flying g O BT TofoaAL 8-
island, it's natural that as much of your time is going to be g
spent blending images as it is adding them. 5

Remember to use soft brushes on masks wherever -
YOu can, as these are good for blending layers together, f :
Create new layers with Soft Light, Color and Screen blend i
modes, and brush colours aver them to keep the same é:
tonal consistency across different layers. I7s

Finally, create a merged layer by hitting Crmd/Ctrl+-Alt/ 3 I:
Opt+5hift+E and go to Filter Blur> Gaussian Blur. Use a cmom
Radius setting of 20px, and then use Hue/Saturation to a
reduce Saturation to -20 and Lightness to +20. This will
help blend the finished picture together.
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SOURCE FILE AVAILABLE |

|

. ¥ ) 1

Design a retro metal sign

k d
5797,
T

Create distressed artwork with textures, blend modes and masks

hen it comes to home décor, everyone has their particular
tastes and preferences. But there is one thing that most people
can agree on, and that is tea will solve almost any problem! Team
this universal knowledge with the hugely popular style of the retro café sign,
and you can't go wrong. This is the ideal type of image for uploading and
selling online, on any of the many sites available to market your design. Once
you've finished your creation, simply save a copy in a suitable format, such as
ipg or .png, ready to upload for printing or selling.

One of the most important parts of a design like this is achieving an
authentic distressed appearance. It's all about layering textures and combining

160 Photoshop for Beginners

blend modes; one texture alone
just won't cut it. We've used five
texture images in this tutorial
with various blend modes so they
interact with each other and build

up the effect. Adding the simple art of
the teapot and teacup gives it the retro feel,
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does it mean?
PHOTO BIN — Accessed by clicking

the far left icon in the bot

sttom left
toc| bar, the Photo Bin displays

thumbnails of all open files. Clicking

a thumbnail takes you to that file
[his is especially useful when
creating artwork from tex
anad source images, ¢
you to find and

between them,

as well as the Lobster Two font used for the text. All these files can be found
on the FileSilo, so you can open up Elements, load the Photo Editor with the
Expert workspace and get started right away.




Build the background

Begin by layering textures and adding
masks to create the background

Before you get started, gather all the files needed for this tutorial (available
from the File5Silo) and open them in Elemenits. By using the Photo Bin, you

can easily navigate between them. The rust texture image is going to be the
background for our artwork, and we will layer the other textures and images
within this file. This sign will be 12x8 inches, as these are common proportions
for printing purposes, while the high resolution of 300ppi gives you scope for
making large-scale prints of your finished design.

02 Hue/Saturation adjustment

Add another Hue/Saturation adjustment layer. Click the Clip to Layer icon, enter
Hue: 102, Saturation: +52, Lightness: +22. Use the Rectangular Marquee Tool to
select roughly the top two-thirds of the canvas. Fill with black to obscure it on
the layer mask.

Prepared border

By using the crop shape as a basis
for our mask, we have an irregular
~ distressed border to build upon.

AT SIE - ¥e
L | EEREFT X o
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07 Add background textures

Copy ([Cmd/Ctri+A then Cmd/Ctrl+C) 'pix_1914901 _paperjpg’ and paste (Cmd/
Ctrl+V) it into ‘pix_2706118_rustjpg. Click the ‘Create new fill or adjustment
layer' icon at the top of the Layers palette and choose Hue/Saturation. Enter
values of Hue: 130, Saturation: -30, Lightness: 422 and select Clip to Layer.

— -

03 Mask with a shape
Select the Custom Shape Tool, choose the Crop Shape 11 shape. Click and
drag to almost fill the canvas. Cmd/Ctri+left-click the shape’s thumbnail in the
| ayers palette to create a selection, then add a layer mask to the paper layer,
Delete the shape layer.

-

|
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Taking shape

Crop Shape 11 is in the Crop
Shapes category, accessed
via this menu in the Custom
Shape Picker window.
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Binit

Once the

shape layer is
finished with, it
is dragged onto
the binicon to
delete it.

~ Masking adjustments
-~ Adjustment layers can be masked

~ inthe same way as regular layers,
so0 we can easily create this two-
tone background.

-
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Paste in the
imagery

It's time for tea! Add the
teapot and cup to the design

Before the teapot and teacup can be
added, the layer mask created in stage
1 needs some improvement. With the
basic shape of the border in place, a
texture brush helps create a more realistic 01 Edit the mask

weathered appearance. Take your time on  Select the Brush Tool (press B) and choose the
this step, making sure it looks random by Texturel brush (from the Assorted Brushes set). 02 Add scratches

varying the brush size (use [and Jto make  Click Brush Settings and increase Scatter to 10%. Use black to add more rust and white to obscure it, changing
this easier) and switching between black Use it on the paper layer mask to distress the the brush size between 60px to 90px to create variation.

and white (press X to quickly switch back  edges of the mask with a combination of taps Reduce the brush size to 8px and Scatter to 0%, then use it with
and forth), and strokes. black to add thin scratches coming inward from the edges.

03 Adjust the rust colour

Once you have worked your way all the way 04 Teapot and cup 05 Edit the cup

round the edge of the mask, add a Hue/ Copy and paste in the teapot and teacup at the Add a Levels adjustment layer above the teacup,
Saturation adjustment layer directly above the top of the layer stack. Resize and position them so tick the Clip to Layer icon, and move the grey slider
rust background, and then enter values of Hue: +6,  they fit in the middle of the canvas, with the cup to 1.36 and white slider to 209 so that it matches
Saturation: -39, Lightness: -S. aoverlapping the teapot. the tone of the teapot more closely.

Worn paint
Using the texture brush
on the mask to add
extra patches of rust
creates a more worn and
weathered appearance.

06 Some shading

Add a new layer between the teapot and teacup layers, tick 'Use
previous layer to create clipping mask’, set the Opacity to 25%. Use
a Soft Round brush (in Default brushes) with black at 200px brush
size to add shading on the pot beneath the tea cup.
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Complete the
distressed effect

e

i

= " combinations with the texture

Different blends
There are plenty of blend

modes to choose from; try out

A

g

Add the text and paste =
in the final textures -
This is where the distressed Sizing up 1!
appearance really takes shape. As Click on the word Size  *
with many effects, layering the ACaEgngeoriet.

; : : to quickly increaseor  ©
different textures is a case of trial decrease the font size. &
and error. Try out some different e |
combinations and blend modes, or #
adjust Hue/Saturation and Levels to
get a tone and colour scheme you
are happy with. An appropriately

retro font, such as Lobster Two Italic
which we have used here, plays

a key role in setting the tone and
theme of your artwork,

.40l

e W ol il S "

i
01 Add the text

Select the Type Tool (T) and choose the Lobster Two Italic font with a colour of
R:200, G:89, B:71. Type out the text on two layers, the top line in 115pt and the
lower in 90pt, and position them as needed to fit the layout.
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03 Textures and adjustments

Press Crnd/CtrH-L and move the grey to slider to 1.18 and white to 140. Add
the ‘pix_1846847_scratchesjpg’ texture, resize it to fit and set it to Screen
and 30% Opacity.

layers to get different effects.

L

!

EIpgan

i
1|4

Font colour
{ The Type Tool will

use whatever colour
is currently loaded
in your Foreground
colour palette.

02 Paste in texture

Copy and paste ‘pix_2698956_grungejpg’ into your artwork, at the top of the
layer stack. Set the layer's blending mode to Hard Light and its Opacity to 20%,
then resize to fill the canvas.

04 Final texture and Levels edit

Paste in the final texture, ‘pix_1659117_vintage jpg’, set its blending mode to
Color Burn and Opacity to 30%. Add a Levels adjustment layer at the top of the
layer stack and set the black to 46 and grey to 1.15.
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GraphicPen

Create a merged layer at the
top of the stack, and use the
Graphic Pen filter to add more
texture to the image.

SOURCE FILE AVAILABLE

Sketch fur in Elements

Creating animal paintings is fun, but how can you create realistic fur?

ne of the best things about drawing animals is that you can get
detailed and really bring the creature to life through nothing
more than your own brushstrokes. \Whether vou're drawing
freehand or keenly following a reference photo, it doesn't matter all that
much; you can sculpt the image with your own hand, and that's an amazing
thing to experience.

When it comes to drawing animals, you'll no doubt find that you spend most
of the time drawing fur. While it may seem intimidating, fur is an interesting
texture to sketch; it has clear direction, it can vary in colour, often across the
animal itself, and perhaps best of all, it's actually pretty easy to draw. All you

164 Photoshop for Beginners

have to do is flick the brush to create a stroke; do this a few more times and
you've created a whole patch of fur.

In this tutorial, we're going to be creating an expressive fox from tight
brushstrokes across the page. Of course, if you have another start image you'd
like to use — perhaps you want to draw your pet dog or a horse you snapped
out on a walk, you're more than welcome to use that instead. And if you're a
good enough artist that you don't even need a reference photo, even better!

Drawing animals is a fun pursuit, and can really help teach you a lot about
using and controlling brushes in Elements, not to mention styles of artwork
in general.



GEt SkEtChing From the opening stro
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07 Introduce the fox

Start off by creating a new document and adding
the supplied fox image to the document on a new

layer. This is what we're going to trace to create our

sketch, so make sure that you place it in the centre
of the document.

05 Begin with the eyes

Start sketching over the eyes of the fox. Alt/Opt-click to select a colour and
then brush lightly over the eyes of the fox ta fill in the colour. Make sure to

-

draw in the white glint from the eyes over the black. Continue with the nose,

Brush: Default Brushes -
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02 Pick your brush

Go to Brush (B) and select the Rough Round
Bristle option from the palette. Reduce the size of
the brush to 10px by hitting [ and make sure the
opacity is at 100%. This is the brush we're going to
use to create the image,

o Garck Mesdienf Frperd

kes right down to the finishing touches
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03 Have a play

Create a new layer and just sketch a little with the
brush that you've created to test it out before you
start sketching for real. It should look a little rough
around the edges to give it more believability as
a pencil.

06 Hide layers to reveal

Continue sketching on this new layer. If you ever want to see how this picture
is coming along, simply hide the guide layer, and you'll see your artwork on its
own against the white background.
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Hard and soft - Y e
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Hard brushes are good 45 14
for being precise with . — .
. T
drawing, soft brushesare  —— i G
better for blending; we'll . 4
be using a hard brush with  See— —  m—
100 a3
rough edges. .
13 200 a2
- .
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What
does it mean?

DIGITAL SKETCHING - You might

wonder when creating pencil-style

images in Elerments, why we are

using the Brush tool when there's a
Pencil tool. The reason is simple; the
Brush is customisable in terms of
style and size, while the Pendil
isn't. The pencil is better
for basic laying out
of images.

Speed lines

As well as using default brushes for
drawing, other brushes such as leaves and
stars can be useful in certain projects.
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EXPERTTIP

Using
adjustments

Adjustments are used in many projects,
but they're only to enhance what you've
already created, rather than adding
something else to the image. In this case,

we use a Gradient Map adjustment to add b P

new tones to the image, and Brightness/ S = ' e

Contrast to give tone and shape to the 06 Continue with the fur e ::..,,

original sketch. Restrain yourself here, Alt/Opt-click on particular colours within the — -

as it is only done to add to the image, fox's fur to select them, then make short, sharp 07 Sketch to the edge

rather than transform it. Of course, all strokes with your brush to draw the fur over the Sketching up to the edge of fur is easy because the edge of fur
adjustments are relative and if you wish fox, Get used to creating different length strokes looks like the edge of a brushstroke. Flick the brush up to the
1o add others, or not even use the ones for different lengths of fur, and just cover the fox's  edge of where you want the fur to end, but be sure not to then
suggested, that's completely up to you! head with your brushstrokes, drag the brush back down, as this will look unrealistic.

08 Fill out the face 09 Build up the picture 10 Finish off sketching
Keep on with what you're doing. Hide the guide As you continue creating strokes, you'll draw all Once the fox is complete, make sure to sketch over
layer to reveal what the sketch looks like every over the fox. You'll find some strokes are long, any the places you may have missed. Then, Alt/
now and then, and keep patiently sketching the some are short and some fur needs to be drawn Opt-drag the sketch layer above itself to duplicate
brushstrokes over the fox's face to fill out the in a different direction. Just persevere until the fox it. This will thicken out your brushstrokes and make
image a little. starts taking shape a little more, the fox's fur look a little denser.
, Ears
Eyes B e e : ugeos. 8+ Flick the fur from
With a really dark d ' the ears n::uhnfarr.i.l
colour, brush upward following the furin
away from the eyes the real fox's ears,
to almost suggest and don't be afraid
eyeliner on the fox. to overlap strokes, as
this looks natural.
Face
i Follow the direction
of the fur on the fox's
Whiskers face, whether
Draw the whiskers around the eyes,
freehand, just flicking down the nose or
the brush sideways facing outward on
to create the effect, either side.
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17 Increase brightness

Go to the Fill Layer icon and choose the Brightness/
Contrast option. Increase the brightness of the

fox and then hit Mask, before inverting (Cmd/
Ctrl-H). With a big, soft, white brush, mask in the
brightness back over key areas of the image. Clip to

the sketch (Alt/Opt-click).

14 Add texture

Insert the supplied canvas texture and hit Cmd/CtrHShift+U to completely
desaturate it. Set the layer to Multiply and reduce the opacity to 30% to keep
the canvas subtle in the background of the picture.

e |

13 Gradient Map adjustment

12 Recolour slightly Set up a Gradient Map adjustment of #aed0d4
Create a new layer again and clip to the Brightness/  to #{{7838 above the fox and again, clip the
Contrast adjustrment. Fill with #7838 and set to adjustment to the image. Mask, invert, and mask in
Hue, This will ligntly recolour your fox without this colouring over the tail, partially over the legs
being too overwhelming, and it will leave in some and a bit over the back to add cool and warm tone
of the tones from the original sketch. to the image. Set to Soft Light blend mode.

PO e |

~ PO o] W B R - i

15 Adjust contrast
Use Levels in the Fill Layer icon to tweak the contrast of the image a little more,

and drag the stoppers across the histogram. This should boost the blacks and
make your brushstrokes a lot more visible in the image.

FOCUS attention on the fO)( How tone can affect where your eye is drawn

This is a project that involves a lot

of brushing, but as you might have
noticed, the agjustments are just as
important a part of the process as the
creation of the image itself,

As with most art projects, the first
draft - in this case, the constant tracing
of the fox — can always be improved,
and in our case, we're going to use
adjustments to increase contrast, work
on tone, and brighten up certain areas
of the picture, The brightness should
focus more on the face and the blue
tones should appear over by the tail, to
make the face look warmer,

Photashop for Beginners 167




Add clouds

Create a new layer
and go to Filter>
Render> Clouds.

Set this to Screen
and mask in your
clouds over
the mountains.

-
o |

/'

Rotate if

necessary
Use the Transform
options to rotate
your panosphere
until it's in an
optimum position
that looks good.

Create a panosphere

Build a world of your own using Elements’ magical distort ability

hey're sometimes referred to as ‘panoramic planets’ or ‘creative panorama. Just make sure that the edges blend seamlessly together when you
worlds’, but whatever you call them - we're going with apply the Polar Coordinates filter (see later), and you're fine!
‘panosphere’ — they're a great use of the Distort filters. Aside from looking cool, panospheres teach you a lot of useful editing
Panospheres are a cool way to display a panoramic image in a much techniques. There are masking and retouching skills involved in making this, not
smaller space. We're going to get as creative as we possibly can in this image to mention the adjustments that go into blending the whole piece together
by compaositing together a brand-new environment from terrain, lakes and into a unified planet. This is a great project to try out if you're looking to push
landmarks, but it's totally possible to create a panosphere from a single your creativity, and it can help you practice a world of editing technigues!
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BUiId the WOI‘|d Create a skyline before looping it into a sphere with filters

01 Split your picture 02 Bring in the mountains

Start off by importing your image of a horizon. Select a portion of it, Ctrl/right Repeat the previous step with the mountains. Repair the split down the centre
click and choose Layer Via Cut. Move the two parts of the image to opposite of the image by using the Clone Stamp Tool and start to make the landscape
sides so that when they join again, the two sides match up together, look like a continuous panorama rather than a comped-together set of photos.

-I.1|-.-'|-hil-u'l_-_ T

04 Blend the scene together
03 Mask in some water Insert more images such as grassy ridges to link the water to the land and

Add in the water image and move it to wherever youd like it in the scene. Hit using the same masking techniques, blend the image as a whole together. You
Mask and then Invert (Crnd/Ctrl-H). With a soft, white brush of around 209 can make whatever edits you see fit to the terrain; just study images of real
Opacity, fade in the water across the area you've placed it, places to see what needs to be edited.
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; oy does it mean?

"+ L : 5 CLONE STAMP TOOL - One of the
Lo 5 . most trusty tools when it comes to
. | o retouching, as it can duplicate parts
s 23 R, * = of your image across to other places.
i 5 Simply Alt/Opt-click where you
2 - want to copy the pixels from,
. & - before drawing over another
= part of the image. Use it with

Background - . : e low Opacity and build
Tumn the brightness and . 4 | $ 2 ) . up the strokes,
saturation down on the - : L

mountains and other

background elements

slightly to give the . . '

effect of distance. . - - e Furegrnund
s - e v Add trees, fields and landmarks to the
fridiit: S I ety | O foreground of the image to populate it, and

SR e e | keep these elements bright and saturated.
- = = ¥ x & -w—T=
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05 Add some elements 06 Insert monuments

As you build up your image, you can insert any elements you like into the A skyline wouldn't be the same without a couple of landmarks, and we're
piece, such as this waterfall or the rocks that are blended into the final piece going ta use a few famous ones - the Eiffel Tower, Statue of Liberty and

Feel free to build over elements that you've already blended into the project Syaney Opera House - to make our piece look more recognisable. Blend them
so far. in with the same technigues.
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07 Recolour the scene
Create a new layer. Work on harmonising the tones 08 Tieit together 09 Adjust

af your piece by selecting new colours and with a Make little changes here and there to ensure that With the skyline complete, let's adjust it. Use the
soft, low Opacity brush, touching over the scene vour whole scene is blended together effectively. Levels command (under the Fill Layer icon above
to give it new shades. The water, the grass and These might include masking in a beach between the Layers panel) to tweak the tone and contrast of
some of the rocks may benefit from new colours the sea and the land, and adding some smoke the piece, and add a white to black gradient, set to
n particular, aver the water using Filter> Render> Clouds. Soft Light, to the image as a whole.

e e T . S— D Levels
Photo Filter Bl S S Use the Levels to
Addawarm Photo Filterso | g adjust the tone
that the image stands out : : of your image,

against the blue of the sky. bt‘.'f twea |'i'L'f'E'EI the
stoppers along

the histogram.

Gradient

Add a light to dark
gradient, set to Soft
Light, to make the
bottom of the image
darker; this improves
the perspective when
the landscape is
tumed into a sphere. B2 B -~ - m e o

Gradient Map
Using Gradient Maps on
new layers, set to Soft Light,
can help make your image
look a little rmore cohesive.
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11 Soften and sharpen 12 Resize
10 Harmonise colours Hit Crd/Ctri+-Alt/Opt+Shift+E and duplicate (Cmd/ Merge all yvour layers together and go to Images
Apply a Gradient Map. Grab colours from the Ctrl+]). With the first layer, go to Filter> Noise> Resize> Image Size, Uncheck the Constrain
compaosition to form a gradient that goes from Reduce Noise and choose Strength: 10, with other Properties box and reduce the Width setting so
darker colours to lighter colours, and then set values at 0. With the second layer, go to Filter> that it's the same size as the height of your image,
to Soft Light, 30% Opacity. This will give a more Other> High Pass; choose 5px, hit OK and set the to make it a square. Hit OK, Use Transtorrm (Cmd/
cohesive overall tone to the image. layer to Overlay., Crl+T) to flip it vertically.

] C

(®) Rectanguiar to Pokar :

L Palar 10 Rectangular [ ]

1§

13 Distort 14 Blue sky
Go to Filter> Distort> Polar Coordinates to loop the skyline around into a Create a new document and paste your panasphere onto the canvas. Create 3
sphere. Lse the Rectangular to Polar setting and then hit OK. Again, retouch new layer just below it and using a big, soft, light blue brush, touch around the
what you have so far using the Clone Starmip to get it looking perfect. edges of the document to create a sky around the world.

MaSking |andmal‘k5 Cut out your monuments with precision

X - e - L i L] ﬂ Cradte - B

There are plenty of ways to mask in Elements, and T a8 B R o i 5 e et i JCoecag |

when it comes to cutting out buildings to put into your g Bl B
panosphere, there are some methods that are better
than others. i
. ¥ B . . ' f L
The Magic Wand option is one that's surprisingly ‘"
good in this case. By selecting all of the blue in the £ e
image with Contiguous unchecked, you can erase s
T S5

large parts of the sky quickly by simply clicking and -

masking. Use the Refine Edge Tool once you've got 2 i

vour selection to edit it slightly. ﬁ
There are lots of other ways to make selections and

mask objects in and out of your project. One way is 1o

use the Brush Toal to draw straight onto your mask as

in most cases, this will give you the best control over 5 0 (L] 8T e e L
TR i s ; BRw i ™ i | mrewcom | iy
what is visible and what isn't in your image., i ;
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I Creative projects

What
does it mean?

AUTO SELECTION - One of the
L o |8 j 1|1 ons T Fl["|' VT S

s __..+.|.-.|.4.I.I'.“.E.

Mask over one side

Masking the city image out from
one side of the portrait means that
you can still focus on the subject’s
face and the city.

more precision

s .I.'I e

FANEEN 1 SNEa.
.J_._J:_I..:l -~

Textures
Add a texture such as Noise
or Canvas to the finished
image to add a little more
interest to the background
than just white space.

T

T

Create double exposures

Blend two images with Screen, layers, masks and adjustments ORIGINALS

ouble exposures were originally a mistake of traditional freely admit that it's not the easiest path to creating one, but it is the best
photography, and now they’re one of the most striking effects way to ensure that you have complete creative control. The Guided Edits
seen in digital art all over the internet. They rely on overlaying one or  are great for speed and ease, but the Expert mode enables you to delve a
more images over an existing portrait and blending them together to suggest little deeper.
that they're somehow connected. They're somewhat straightforward to create, Double exposures are particularly great because there really aren’t any rules
and so popular in fact, that Photoshop Elements includes a Guided Edit of how  about what does or doesn't look good: it's all in the experimentation. You may
to make a double exposure in the 2018 version of the software. find yourself searching for more stock photos to add, or adjusting your images
Well, in this tutorial, we're going to be focusing on how to make a differently to how we suggest; sometimes the most amazing work is created by
double exposure the long way, using the Expert mode in Elerments. We will experimentation or mistake, after all.
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A Ilttle e)(posu @ start blending to create a photographic masterpiece
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01 Tweak the portrait

Start off by dropping the supplied portrait image into Elements and use

the Levels to adjust the contrast of the subject. Slide the stoppers along the
bottom of the histogram until you have clear shade as well as light in the face,

S PR ki " ooy Ut | - SR | R N | R . A I I

03 Add the beach

Drag in the beach image, set to Screen and hit Mask, Cmd/Ctrl-click on the
layer mask preview on the Levels layer; touch over the face and right-hand side
of the subject to lessen the double-exposure effect on that side.

07 Crop and cut

Go to the Guided tab, click on Fun Edits and select
Double Exposure, From there, the first thing to do
will be to crop the image and select the subject
using either Auto or Quick Selection, This helps to
frame your image.

overiays

02 Choose an overlay

Pick between the three options for picture

Forest, City or Cloud = or import your
own image, You can change the intensity Dy using
the corresponding slider and you can use the
Maove Tool to adjust the positioning.

02 Adjust further

Continue with the adjustments; grab the Auto Selection Tool and make an
outline around your subject before setting it as the mask. Open the Brightness/
Contrast adjustment and increase, then reduce Saturation in the image as a
whole with Hue/Saturation.

B A O o i gl 355 g 0 3] W TEERED

04 Finish with more adjustments

Create a black to white Gradient Map and set to Soft Light; continue with
another Levels adjustment, this time focusing on the red, blue and green
channels. Use Brightness/Contrast to finish up the image, group these layers,

and set the group to 30% opacity.

i
b
.f
i

p |

AT A [
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03 Effects

Use the Effects panel to choose a colour style to
blend into the image; again, use the Intensity slider
to tone down the effect you're applying to the
compaosition for a subtler finishing touch. This step
is, of course, completely optional.

Photashop for Beginners 173



Glossary

Glossary of key terms

Iriptove contrast and exposureanpage 104

Adjustment layers

"Werk with Brush Presets on '[:.'I-:| ge

Camera Raw

These are non-destructive layers that
enable you to make changes to your image,
without affecting your original. You can also
go back to adjustment layers and change
the settings at a later date.

Artifact

We use this term when images are saved

as JPEGs or shot in low light with noise,
Artifacts are unwanted elements that
appear when heavy compression or editing
has ocourred,

Background layer

This is the original layer that you openin
Photoshop. By default this layer is locked to
protect it from changes, double-click on the
layer 1o turn it into a reqular, editable layer.

Blending mode

The blending mode options in the Layers
palette determine how the pixels in the layer
interact with the pixels in the layers below it.

Brush Preset

Photoshop comes with Presets for brushes
meaning that different combinations of size
and thickness, have been stored for you

to use. Create your own if you find a brush
setup that works for vou. (Fig 2).
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This is Photoshop's built-in BAW-processing
plug-in, which enables you to open
photographs that have been shot in the RAW
format, rather than JPEG.

Clipboard

This is where file elements are stored if

you cut or copy from one image to another.
If the Clipboard gets too full, then you
might find that it starts to slow processing,.

Clone

The technigue of taking a clean area from a
photograph and applying it over a flawed
area of an image. This is done with the Clone
Stamp tool. Click on the clean area while
pressing Opt/Alt to ‘source’ the sample, then
paint over the flaw,

CMYK

This stands for Cyan, Magenta, Yellow

and Black, which is a common Image
Maode for printing. Photoshop Elements
does not support CMYK images. Most
printers will convert RGB images into CMYK
for printing, but if you have Photoshop

you miay want ta work in CMYK so you can
see how the final image will look more
accurately. Some hlters and adjustments
only work in RGB.

Sharpen images on page 90

Colour cast
When an unwanted colour is ‘cast’ over your
phatograph. The Coler Balance command
can fix this.

Contrast

I'he difference between light and dark areas
in any given image, can be altered using
Levels and Curves, as well as the Brightness/
Contrast command.

Crop

This is the act of trimming an image,
discarding unwanted pixels from the
final composition. (Fig 1).

DPI
This stands far Dots Per Inch and itis a
measure of printer resolution. Use higher DPI
settings for better prints. We recommend
working at 300dpi where possible.

Duotone
This is the term for a grayscale image that
uses two colour inks to tint photos. Not
available in Elements.

Exposure

The amount of light in which a photograph is
taken. Fix both underexposure (too dark) and
overexposure (too light) in Photoshop.



Feathering

When you make selections, the Feather

command softens the edge so that it blends

more naturally into the background.

Filters

Preset controls that give special effects
to yvour photos. There are loads built into
Photoshop and Photoshop Elements.

Flatten

Flatten individual layers into one, keeping
file sizes down. Bear in mind that you will
lose all separate layers so you won't be able
to go back and change things later on,

Gaussian Blur

brightest pixels (0-255), whereas the vertical
axis shows how many pixels are at each
level. Aim for an even distribution of tones.

History

Your commangds are saved as History States,
50 that you can use the History palette to
backtrack if something goes wrong

Image Mode

This is the name given to image modes,
such as RGB, CMYEK, etc. This can be
changed by geing to Image>Mode.

JPEG

This is the most common file format used by

digital cameras and it does compress image
information to keep file sizes down.

Layer

Overlay different images or elements over
one another. (Fig 4)

Laver group

Collect layers into groups when working
with multiple layers to stay organised. Group
all layers that relate to the same thing.

Layer masks

Layer masks let you control how much of
one layer shows through to the one below
it. You paint directly on to the mask in white
or black in order to reveal or hide.

Levels

This is a feature that helps you cantrol the
colour and tone in your images.

Midtone

Cne of the Blur filters in Photoshop. This

is one of the most cormnmon blurs and it
softens through a ‘bell-shaped’ distribution
of colour and tone,

Gradient

A smooth transition effect from cne colour
to anather,

Grayscale

This is the term for the area of tones that fall
petween the brightest and darkest pixels.

Noise

This is an artifact that shows up as

grain on your photos. Most common when
images have been compressed, or shot in
low light. [t can be removed easily.

Opacity

This rernoves all colour from an image,

using just black, white and grey on one
channel. There are several ways to transform
an image to black and white,

Highlights

This is the control used in the Layers
palette or in the top options bar for most
tools, which determines how ‘visible' or
‘transparent’ an effect is,

Pixel

This refers to the brightest elements of any
given image.

Histogram

These are the tiny, rectangular points of
“olour that a digital image is composed of

PPI

PSD

This is Photoshop's very own file format and
it can be used 1o save multiple layers.

Quick Mask

This — as the name suggests —is an
extremely quick way of masking areas in an
iImage in order to form a selection.

Red-eye

This is a very common flaw found in digital
portrait photographs, which is caused by
the use of camera flash.

Resolution

This is a measure of clarity and sharpness
in an image. The higher the resolution, the
better-quality the image, and print size,

RGB

This is the Red, Green, Blue image makeup
that is used by computer screens

Saturation

This is the strength of a colour and it can be
altered in the Hue/ Saturation options.

Selection

A Selection, as it suggests, is the name
given when you isolate a certain part of
any image.

Shadows

The darkest elements in an image.

Sharpening

This is the process of enhancing details in an
image. Be very careful when sharpening, as
too much of it can lead to noise. (Fig 3).

Swatches

This is a selection of preset colours that you
are able to pick from within Photoshop. You
are also able to create or download more if
vou need to.

TIFF

This is a file format that is often used for
printing. It is compressed in such a manner
that it does not affect the image quality, be
aware that it can lead to bigger file sizes.

Transform

I'his is the set of controls that enables you to
distort, skew, scale, and so on, an image, as
you wish,

Unsharp Mask

A graph that shows how the pixels are
distributed in an image. The horizontal
axis shows the ‘levels’ from the darkest to

This stands for Pixels Per Inch, which is
a measure of image resolution used by
cameras and computers.

A popular filter in Photoshop that is used for
sharpening, because it increases the detai
in images.
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Phoboshop for Beginnars

NEED HELPWITH ==
THETUTORIALS? | o

Having trouble with any of the techniques in this edition's tutorials? Don't know how to make the best
use of your free resources? Want to have your work cntiqued by those in the know? Then why not
visit the Bookazines or Photoshop Creative Facebook page for all your questions, concerns and
gualms. There is a fnendly community of Photoshop experts to help you out, as well as regular posts

and updates from the bookazine team. Like us today and start chatting!
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